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Product introduction
Figure 1-1  HP LaserJet M9059 MFP

The HP LaserJet M9059 MFP comes standard with the following items:

● 100-sheet multipurpose input tray (tray 1)

● Two 500-sheet input trays

● One 2,000-sheet input tray

● Automatic document feeder (ADF)

● HP Jetdirect embedded print server for connecting to a 10/100/1000Base-TX network (Gigabit
support)

● 384 megabytes (MB) of random access memory (RAM)

● Duplexer

● Hard drive
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Product features
The HP LaserJet M9059 MFP is designed to be shared by a workgroup. The MFP is a standalone copier
that does not require connection to a computer. With the exception of network printing, you can select
all functions at the MFP control panel.

Functions

● Two-sided copying and printing

● Image modification

● Color digital sending

● Black-and-white printing and copying

● Wide-format printing

● Document finishing

Speed and throughput

● 50 images per minute (ipm) when scanning and printing on letter-size or International Standards
Organization (ISO) A4-size paper

● 25% to 400% scalability when using the scanner glass

● 25% to 200% scalability when using the automatic document feeder (ADF)

● Transmit Once, Raster Image Processing (RIP) ONCE technology

● Eight-seconds to first page

● Duty cycle of up to 300,000 images per month

● 533 megahertz (MHz) microprocessor

Resolution

● 600 dots per inch (dpi) with Resolution Enhancement technology (REt)

● FastRes 1200 provides 1200 dpi quality at full speed

● Up to 220 levels of gray

Memory

● 384 megabytes (MB) of random-access memory (RAM), expandable to 512 MB by using industry
standard 100-pin double data rate dual inline memory modules (DDR DIMMs)

● Memory Enhancement technology (MEt) that automatically compresses data to use RAM more
efficiently

User interface

● Graphical display on control panel

● Embedded Web server to gain access to support (for network-connected products)

● HP Toolbox software to provide MFP status and alerts and print internal information pages
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Language and fonts 

● HP Printer Command Language (PCL) 6

● HP PCL 5e for compatibility

● Printer Management Language

● 80 scalable TrueType typefaces

● HP postscript 3 emulation

Copying and sending

● Modes for text, graphics, and mixed text and graphics formats

● A job-interrupt feature (at copy boundaries)

● Multiple pages per sheet

● Operator attendance animations (for example, jam recovery)

● The ability to copy books

● E-mail compatibility

● A sleep feature that saves energy

● One-pass duplex scanning

Print cartridge

● No-shake cartridge design

● Authentic HP print cartridge detection

● Automatic seal tab removal

Paper-handling 

● Input

◦ Tray 1 (multipurpose tray): A multipurpose tray for paper, transparencies, labels, and
envelopes. Holds up to 100 sheets of paper or 10 envelopes.

◦ Trays 2 and 3: Two 500-sheet trays. These trays automatically detect standard paper sizes
up to 11 x 17/A3 and allow printing on custom-size paper.

◦ Tray 4 (2000-sheet input tray): This tray automatically detects standard paper sizes up to
11 x 17/A3 and allows printing on custom-size paper.

◦ Automatic Document Feeder (ADF): Holds up to 100 sheets of Letter- or A4-size paper or 50
sheets of 11 x 17- or A3-size paper.

◦ Duplex printing: Provides two-sided printing (printing both sides of the paper).

● Output
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The MFP has the following optional output choices:

◦ 3000-sheet stacker: Stacks up to 3,000 sheets of paper.

Upper bin (face-up): Holds up to 100 sheets of paper.

Lower bin (face-down): Holds up to 3,000 sheets of paper. The output bins are part of the
output device.

◦ 3000-sheet stapler/stacker: Provides multiposition stapling for up to 50 sheets of paper per
job, or a maximum job height of 5 mm (0.2 inch).

Upper bin (face-up): Holds up to 100 sheets of paper.

Lower bin (face-down): Holds up to 3,000 sheets of paper. The output bins are part of the
output device.

◦ Multifunction finisher: Provides 1,000 sheets of stacking capacity, stapling for as many as
50 sheets of paper per document, plus folding and saddle stitching of booklets that contain
up to 10 sheets of paper.

Upper bin (face-up and face-down): Holds up to 1,000 sheets of paper.

Lower booklet bin: Holds up to 50 booklets.

◦ 8-bin mailbox: A stacker, collator, or job separator that also provides eight mailbox bins that
can be assigned to individual users or workgroups for easy identification and retrieval. The 8-
bin mailbox can stack up to 2,000 sheets of A4- or letter-size paper in all the bins.

Upper bin (face-up): Holds up to 125 sheets of paper

Bins 1 through 8 (face-down): Each holds up to 250 sheets of paper

Connectivity

● Hi-Speed USB 2.0 connection

● HP JetDirect 635n IPv6/IPSec Print Server. Local area network (LAN)-connector (RJ-45) for the
embedded print server

● Optional analog fax card

● Optional HP Jetdirect EIO print server cards

◦ HP JetDirect 625n gigabit Ethernet internal print server

◦ IPV6/IPSec
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Environmental features

● Firmware updates provide the ability to upgrade the MFP firmware. To download the latest
firmware, go to www.hp.com/go/ljm9059mfp_firmware and follow the onscreen instructions. To
easily send firmware updates to multiple products, use the HP Web Jetadmin software (go to
www.hp.com/go/webjetadmin).

NOTE: HP Web Jetadmin 10.0 or later is required for full support of this product.

● Internal hard disk can be used to store selected print jobs. It can support RIP ONCE technology,
and can permanently store downloaded fonts and forms in the MFP. Unlike standard product
memory, many items on the hard disk remain in the MFP even when the MFP is turned off. Fonts
that are downloaded to the hard disk are available to all users of the MFP.

● Optional EIO hard disk accessory provides additional capacity for storing fonts and forms. The MFP
does not use the EIO hard disk accessory for tasks such as RIP ONCE and stored jobs. The MFP
uses the internal hard disk for these tasks. Both disks can be write-protected through software for
additional security.

Security features

● Secure Disk Erase

● Security lock

● Job retention

● Front-panel authentication
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Product walkaround
Figure 1-2  Product walkaround

1 Document-feeder cover

2 Document feeder (ADF)

3 Control panel with touchscreen graphical display

4 Tray 1

5 Right door

6 Vertical transfer door

7 Tray 4

8 Tray 3

9 Tray 2

10 Left door (behind output device)

11 Output device

12 Front door

13 Duplex printing accessory (inside the MFP)

14 ADF output bin

15 Left door

16 Printer power cable

17 Tray 4 power cable

18 EIO slot 1

19 Copy processor EIO card
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Output devices
This MFP comes with a 3000-sheet stacker, a 3000-sheet stapler/stacker, a multifunction finisher, or
an 8-bin mailbox.

3,000-sheet stacker
● Stacks up to 3,000 sheets of A4- or letter-size paper

● Stacks up to 1,500 sheets of A3- or ledger-size paper

● Can offset jobs, or offset the first page of jobs

The lower bin (face-down bin) is the default bin for all output jobs.

3,000-sheet stapler/stacker

Paper handling features
● Stacks up to 3,000 sheets A4- or letter-size paper

● Stacks up to 1,500 sheets of A3- or ledger-size paper

● Can offset jobs, or offset the first page of jobs

The upper bin (face-up bin) is the default bin for all output jobs.

Stapling information
The 3,000-sheet stapler/stacker can staple documents that contain between two pages and 50 pages
of 75 g/m2 (20 lb) paper, or equivalent 5 mm (0.2 inches). The pages must be 64 to 199 g/m2 (17 to 53
lb) of all sizes that the MFP supports.

● Heavier media might have a stapling limit of fewer than 50 pages.

● Stapling will not be performed on less than two sheets or more than 50 though the MFP will copy
or print the job.

Stapling is usually selected in your software program or printer driver. See Change printer-driver settings
for more information. Where and how you make selections depends on your program or driver.

If the stapler cannot be selected in the program or printer driver, it can be selected through the MFP
control panel. See Staple documents on page 100 for instructions.

Multifunction finisher

Paper handling features
● Stacks up to 1,000 sheets of A4- and letter-size paper or up to 500 sheets of A3- and 11 x 17-size

paper

● Stacks up to 40 booklets of 5 sheets of A3- and ledger-size paper

● Can offset jobs

● Staples up to 50 sheets of paper per document of A4- and letter-size paper
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● Staples up to 25 sheets of paper per document A3- and ledger-size paper

● Folds single pages

● Saddle-stitches and folds up to 40 booklets of 5 sheets stacked, or 20 booklets of 10 sheets
stacked.

Stapling information
The finisher can staple documents that contain between two pages and 50 pages of 75 g/m2 (20 lb)
A-4-or letter-size paper or 25 pages of A3- 11 x 17-size paper or equivalent to 5.5 mm (0.22 inches).
The pages must be 64 to 199 g/m2 (17 to 53 lb) of all sizes supported by the MFP.

Consider these additional points:

● The upper bin (stacker bin) can hold up to 1,000 sheets stacked (not stapled). The multifunction
finisher can deliver jobs face up or face down to the upper bin.

● Heavier media might have a stapling limit of fewer than 50 pages.

If the job that you want stapled contains only one sheet, or if it contains more than 50 sheets, the
multifunction finisher delivers the job without staples.

You can usually select the stapler in your software program or printer driver, although some options
might be available only in the printer driver. See Change printer-driver settings for Windows
on page 53 for more information. Where and how you make selections depends on your program or
driver.

If the stapler cannot be selected in the program or printer driver, it can be selected through the MFP
control panel. See Staple documents on page 100 for instructions.

Booklets
You can gain access to the booklet feature in some software programs, such as desktop publishing
programs. See the user guide that came with your program for information about making booklets.

If you are using a program that does not support booklet making, you can create booklets by using the
HP printer driver.

NOTE: HP recommends that you use your program to prepare and preview your document for printing,
and then use the HP printer driver to print and saddle stitch your booklet.

Use the following steps to create a booklet by using the printer driver:

● Prepare your booklet: Arrange the pages on a sheet (called booklet imposition) to create a booklet.
You can impose your booklet in your software program, or you can use the booklet-printing feature
in printer driver.

● Add a cover: Add a cover to your booklet by selecting a different first page with a different paper
type. You can also add a cover of the same paper type as your booklet. Booklet covers must be
the same size as the rest of the sheets in the booklet. However, the cover can be a different weight
from the rest of the booklet.

● Use saddle stitching: Paper must be fed into the MFP short edge first. The MFP prompts you for
rotated paper. The multifunction finisher staples the center of your booklet (called saddle stitching).
If your booklet contains only one sheet of paper, the multifunction finisher folds the sheet, but does
not staple it. If the booklet contains more than one sheet of paper, the multifunction finisher staples
the sheets, and then folds up to 10 sheets per booklet.
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The booklet-printing feature of the multifunction finisher supports the saddle stitch and fold feature for
the following paper sizes:

● A3

● A4-Rotated (A4-R)*

● Letter-Rotated (Letter-R)*

● Legal

● Ledger

See the HP Multifunction Finisher User Guide at www.hp.com/support/ljm9059mfp for more information
about making booklets.

* A4-R and Letter-R are A4- and letter-size paper that is rotated 90˚ in the source tray.

8-bin mailbox
● Handles high-capacity output that increases the MFP output capacity to 2,000 sheets of standard

media

● Uses the upper bin to provide 125 sheets of face-up stacking capacity

● Delivers printed jobs face-down to the eight face-down bins, and each bin provides 250 sheets of
stacking capacity

● Offers stacking options in different operational modes: mailbox, stacker, job separator, and sorter/
collator

For more information about the 8-bin mailbox, see the use guide that came with the 8-bin mailbox.
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2 Control panel

● Use the control panel

● Use the Administration menu
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Use the control panel
The control panel has a VGA touchscreen that provides access to all device functions. Use the buttons
and numeric keypad to control jobs and the device status. The LEDs indicate overall device status.

Control-panel layout
The control panel includes a touchscreen graphical display, job-control buttons, a numeric keypad, and
three light-emitting diode (LED) status lights. 

Figure 2-1  Control panel

1 Attention light The Attention light indicates that the device has a condition that requires
intervention. Examples include an empty paper tray or an error message
on the touchscreen.

2 Data light The Data light indicates that the device is receiving data.

3 Ready light The Ready light indicates that the device is ready to begin processing any
job.

4 Brightness-adjustment dial Roll the dial to control the brightness of the touchscreen.

5 Touchscreen graphical display Use the touchscreen to open and set up all device functions.

6 Numeric keypad Allows you to type numeric values for number of copies required and other
numeric values.

7 Sleep button If the device is inactive for a long period of time, it automatically enters a
sleep mode. To place the device into sleep mode or to reactivate the device,
press the Sleep button.

8 Reset button Resets the job settings to factory or user-defined default values.

9 Stop button Stops the active job. While stopped, the control panel shows the options for
the stopped job (for example, if you press the Stop button while the device
is processing a print job, the control panel message prompts you to cancel
or resume the print job).

10 Start button Begins a copy job, starts digital sending, or continues a job that has been
interrupted.
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Home screen
The home screen provides access to the device features, and it indicates the current status of the device.

NOTE: Depending on how the system administrator has configured the device, the features that
appear on the home screen can vary.

Figure 2-2  Home screen

1 Features Depending on how the system administrator has configured the device, the features that appear
in this area can include any of the following items:

● Copy

● Fax (Optional)

● E-mail

● Secondary E-mail

● Network Folder

● Job Storage

● Workflow

● Supplies Status

● Administration

2 Device status line The status line provides information about the overall device status. Various buttons appear in
this area, depending on the current status. For a description of each button that can appear in
the status line, see Buttons on the touchscreen on page 14.

3 Copy count The copy count box indicates the number of copies that the device is set to make.

4 Help button Touch the Help button to open the embedded help system.

5 Scroll bar Touch the up or down arrows on the scroll bar to see the complete list of available features.

6 Sign Out Touch Sign Out to sign out of the device if you have signed in for access to restricted features.
After you sign out, the device restores all options to the default settings.

7 Network Address Touch Network Address to find information about the network connection.

8 Date and time The current date and time appear here. The system administrator can select the format that
the device uses to show the date and time, for example 12-hour format or 24-hour format.
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Buttons on the touchscreen
The status line on the touchscreen provides information about the status of the device. Various buttons
can appear in this area. The following table describes each button.

Home button. Touch the home button to go to the Home screen from any other screen.

Start button. Touch the Start button to begin the action for the feature that you are using. 

NOTE: The name of this button changes for each feature. For example, in the Copy feature, the button
is named Start Copy.

Error button. The error button appears whenever the device has an error that requires attention before
it can continue. Touch the error button to see a message that describes the error. The message also has
instructions for solving the problem.

Warning button. The warning button appears when the device has a problem but can continue
functioning. Touch the warning button to see a message that describes the problem. The message also
has instructions for solving the problem.

Help button. Touch the help button to open the built-in online Help system. For more information, see
Control-panel help system on page 14.

Control-panel help system
The device has a built-in Help system that explains how to use each screen. To open the Help system,
touch the Help button ( ) in the upper-right corner of the screen.

For some screens, the Help opens to a global menu where you can search for specific topics. You can
browse through the menu structure by touching the buttons in the menu.

For screens that contain settings for individual jobs, the Help opens to a topic that explains the options
for that screen.

If the device alerts you of an error or warning, touch the error ( ) or warning ( ) button to open a
message that describes the problem. The message also contains instructions to help solve the problem.
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Use the Administration menu
Use the administration menu to set up default device behavior and other global settings, such as the
language and the format for date and time.

NOTE: Menus can be locked by the administrator. Contact the administrator if a menu or menu item
is not available.

Navigate the Administration menu
From the Home screen, touch Administration to open the menu structure. You might need to scroll to
the bottom of the Home screen to see this feature.

The Administration menu has several sub-menus, which are listed on the left side of the screen. Touch
the name of a menu to expand the structure. A plus sign (+) next to a menu name means that it contains
sub-menus. Continue opening the structure until you reach the option that you want to configure. To
return to the previous level, touch Back.

To exit the Administration menu, touch the Home button ( ) in the upper-left corner of the screen.

The device has built-in Help that explains each of the features that are available through the menus.
Help is available for many menus on the right-hand side of the touchscreen. Or, to open the global Help
system, touch the Help button ( ) in the upper-right corner of the screen.

The tables in the sections that follow indicate the overall structure of each menu.
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Information menu
Administration > Information

Use this menu to print information pages and reports that are stored internally on the device.

Table 2-1  Information menu

Menu item Sub-menu item Sub-menu item Values Description

Configuration Page Administration Menu
Map

 Print Shows the basic structure of the
Administration menu and current
administration settings.

Configuration Page  Print A set of configuration pages that show the
current device settings.

Supplies Status
Page

 Print Shows the status of supplies such as
cartridges, maintenance kit, and staples.

Usage Page  Print Shows information about the number of
pages that have been printed on each paper
type and size.

File Directory  Print A directory page that contains information for
any mass-storage devices, such as flash
drives, memory cards, or hard disks, that are
installed in this device.

Fax Reports (only
available if the
HP LaserJet Analog
Fax Accessory 300 is
installed)

Fax Activity Log  Print Contains a list of the faxes that have been
sent from or received by this device.

Fax Call Report Fax Call Report Print A detailed report of the last fax operation,
either sent or received.

 Thumbnail on Report Yes

No (default)

Choose whether or not to include a thumbnail
of the first page of the fax on the report.

 When to Print Report Never auto print

Print after any fax job

Print after fax send jobs

Print after any fax error (default)

Print after send errors only

Print after receive errors only

Billing Codes Report  Print A list of billing codes that have been used for
outgoing faxes. This report shows how many
sent faxes were billed to each code.

Blocked Fax List  Print A list of phone numbers that are blocked from
sending faxes to this device.

Speed Dial List  Print Shows the speed dials that have been set up
for this device.

Sample Pages/Fonts PCL Font List  Print A list of printer control language (PCL) fonts
that are currently available on the device.

PS Font List  Print A list of postscript fonts that are currently
available on the device.
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Default Job Options menu
Administration > Default Job Options

Use this menu to define the default job options for each function. If the user does not specify the job
options when creating the job, the default options are used.

The Default Job Options menu contains the following sub-menus:

● Default Options for Originals

● Default Copy Options

● Default Fax Options

● Default E-mail Options

● Default Send To Folder Options

● Default Print Options

Default Options for Originals
Administration > Default Job Options > Default Options for Originals

NOTE: Values shown with “(default)” are the factory-default values. Some menu items have no default.

Table 2-2  Default Options for Originals menu

Menu item Values Description

Paper Size Select a paper size from the list. Select the paper size that is most often used for copy or scan
originals.

Number of Sides 1 (default) Select whether copy or scan originals are most often single-sided or
double-sided.

2

Orientation Portrait (default) Select the orientation that is most often used for copy or scan
originals. Select Portrait if the short edge is at the top or select
Landscape if the long edge is at the top.Landscape

Optimize Text/Picture Manually Adjust (default) Use this setting to optimize the output for a particular type of original.
You can optimize the output for text, pictures, or a mixture.

If you select Manually Adjust, you can specify the mix of text and
pictures that will most often be used.

Text

Printed Picture

Image Adjustment Darkness Use this setting to optimize the output for darker or lighter originals
that you scan or copy.

Background Cleanup Increase the Background Cleanup setting to remove faint images
from the background or to remove a light background color.

Sharpness Adjust the Sharpness setting to clarify or soften the image.

Heavy Originals Normal

Heavy Paper

This setting is important for jobs that use the ADF. Changing this
setting adjusts the tension on heavy paper as it moves through the
scanning area. It can affect output quality for papers that weigh more
than 100 g/m2.
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Default Copy Options
Administration > Default Job Options > Default Copy Options

NOTE: Values shown with “(default)” are the factory-default values. Some menu items have no default.

Table 2-3  Default Copy Options menu

Menu item Sub-menu item Values Description

Number of Copies  Type the number of
copies. The factory
default setting is 1.

Set the default number of copies for a copy job.

Number of Sides  1 (default)

2

Set the default number of sides for copies.

Staple/Collate Staple None (default)

Staple options

Set up options for stapling and collating sets of copies.
When you make multiple copies of a document,
collating places the pages in the correct order, one set
at a time, rather than placing all copies of each page
next to each other.Collate Off

On (default)

Output Bin  Bin numbers/name Select the default output bin, if applicable, for copies.

Edge-To-Edge  Normal (recommended)
(default)

Edge-To-Edge Output

If the original document is printed close to the edges,
use the Edge-To-Edge feature to avoid shadows that
can appear along the edges. Combine this feature with
the Reduce/Enlarge feature to ensure that the entire
page is printed on the copies.

Auto Include Margins  Off (default)

On

Select this feature to ensure that the entire image
appears on the copy, including any content that is close
to the edges. If necessary, the device shrinks the image
slightly, depending on the size of the printable area on
the paper.
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Default Fax Options
Administration > Default Job Options > Default Fax Options

NOTE: This menu is only available if the HP LaserJet Analog Fax Accessory 300 is installed.

Table 2-4  Fax Send menu

Menu item Sub-menu item Values Description

Resolution  Standard (100x200dpi)
(default)

Fine (200x200dpi)

Superfine (300x300dpi)

Set the resolution for sent documents. Higher
resolution images have more dots per inch (dpi), so
they show more detail. Lower resolution images have
fewer dots per inch and show less detail, but the file
size is smaller.

Fax Header  Prepend (default)

Overlay

Select the position of the fax header on the page.

Select Prepend to print the fax header above the fax
content and move the fax content down on the page.
Select Overlay to print the fax header over the top of
the fax contents without moving the contents down.
Using Overlay could prevent a single-page fax from
flowing onto another page.

Table 2-5  Fax Receive menu

Menu item Values Description

Fax Forwarding Fax Forwarding

Change PIN

To forward received faxes to another fax device, select Fax
Forwarding and Custom. Then type the number of the other fax
device into the Forward to Number field. When you select this menu
item for the first time, you are prompted to set up a PIN. Type that
PIN every time you use this menu. This is the same PIN that is used
to access the Fax Printing menu. This PIN is exactly four digits.

Stamp Received Faxes Enabled

Disabled (default)

Add the date, time, senders phone number, and page number to each
page of the faxes that this device receives.

Fit to Page Enabled (default)

Disabled

Shrink faxes that are larger than Letter-size or A4-size so that they
can fit onto a Letter-size or A4-size page. If it this feature set to
Disabled, faxes larger than Letter or A4 will flow across multiple
pages.

Fax Paper Tray Select Automatic or a specific
tray.

Select the tray that holds the size and type of paper that you want to
use for incoming faxes.

Output Bin <Binname> Select the default output bin, if applicable, to use for faxes.
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Default E-mail Options
Administration > Default Job Options > Default E-mail Options

Use this menu to set default options for e-mails that are sent from the device.

NOTE: Values shown with “(default)” are the factory-default values. Some menu items have no default.

Menu item Values Description

Document File Type PDF (default)

JPEG

TIFF

M-TIFF

Choose the file format for the e-mail.

Output Quality High (large file)

Medium (default)

Low (small file)

Choosing higher quality for output increases the size of the
output file.

Resolution 300 DPI

200 DPI

150 DPI (default)

75 DPI

Use this feature to select the resolution. Use a lower setting to
create smaller files.

Color/Black Color scan (default)

Black/white scan

Specify whether the e-mail will be in black or in color.

TIFF Version TIFF 6.0 (default)

TIFF (Post 6.0)

Use this feature to specify the TIFF version to use when saving
scanned files.
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Default Send to Folder Options
Administration > Default Job Options > Default Send to Folder Options

Use this menu to set default options for scan jobs sent to the computer.

NOTE: Values shown with “(default)” are the factory-default values. Some menu items have no default.

Menu item Values Description

Color/Black Color scan

Black/white scan (default)

Specify whether the file will be in black or in color.

Document File Type PDF (default)

M-TIFF

TIFF

JPEG

Choose the file format for the file.

TIFF Version TIFF 6.0 (default)

TIFF (post 6.0)

Use this feature to specify the TIFF version to use when saving
scanned files.

Output Quality High (large file)

Medium (default)

Low (small file)

Choosing higher quality for output increases the size of the
output file.

Resolution 75 DPI

150 DPI (default)

200 DPI

300 DPI

400 DPI

600 DPI

Use this feature to select the resolution. Use a lower setting to
create smaller files.
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Default Print Options
Administration > Default Job Options > Default Print Options

Use this menu to set default options for jobs that are sent from a computer.

NOTE: Values shown with “(default)” are the factory-default values. Some menu items have no default.

Table 2-6  Default Print Options menu

Menu item Sub-menu item Values Description

Copies Per Job  Type a value. Use this feature to set the default
number of copies for print jobs.

Default Paper Size  (List of supported sizes.) Choose a paper size.

Default Custom Paper
Size

Unit of measure Millimeters

Inches

Configure the default paper size that is
used when the user selects Custom as
the paper size for a print job.

X Dimension  Configure the width measurement for
the Default Custom Paper Size.

Y Dimension  Configure the height measurement for
the Default Custom Paper Size.

Output Bin  <Binname> Select the default output bin for print
jobs.

Print Sides  1-sided (default)

2-sided

Use this feature to select whether print
jobs should be single-sided or double-
sided by default.

2-Sided Format  Long edge

Short edge

Use this feature to configure the default
style for 2-sided print jobs. If Long edge
is selected, the back side of the page is
printed the right way up. This option is for
print jobs that are bound along the left
edge. If Short edge is selected, the back
side of the page is printed upside-down.
This option is for print jobs that are
bound along the top edge.
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Time/Scheduling menu
Administration > Time/Scheduling

Use this menu to set options for setting the time and for setting the device to enter and exit sleep mode.

NOTE: Values shown with "(default)" are the factory-default values. Some menu items have no default.

Table 2-7  Time/Scheduling menu

Menu item Sub-menu item Sub-menu item Values Description

Date/Time Date Format  YYYY/MMM/DD
(default)

MMM/DD/YYYY

DD/MMM/YYYY

Use this feature to set the current date and
time, and to set the date format and time
format that are used to time-stamp outgoing
faxes.

Date Month

Day

Year

 

Time Format  12 hour (AM/PM)
(default)

24 hour

Time Hour

Minute

AM

PM

 

Time Zone    Use this feature to set the time zone for your
location and to select whether the device
should automatically adjust for daylight-
saving time.

Sleep Delay   1 Minute

20 minutes

30 minutes

45 minutes (default)

1 hour (60 minutes)

90 minutes

2 hours

4 hours

Use this feature to select the time interval that
the device should remain inactive before
entering Sleep Mode.
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Menu item Sub-menu item Sub-menu item Values Description

Wake Time Monday

Tuesday

Wednesday

Thursday

Friday

Saturday

Sunday

 Off (default)

Custom

Select Custom to set a wake time for each
day of the week. The device exits sleep mode
according to this schedule. Using a sleep
schedule helps conserve energy and
prepares the device for use so that users do
not have to wait for it to warm up. 

Sleep Time Monday

Tuesday

Wednesday

Thursday

Friday

Saturday

Sunday

 Off (default)

Custom

Select Custom to set a sleep time for each
day of the week. The device is put in sleep
mode according to this schedule. Using a
sleep schedule helps conserve energy.

Fax Printing (only
available if the
HP LaserJet Analog
Fax Accessory 300 is
installed)

Fax Printing Mode  Store all received
faxes

Print all received
faxes (default)

Use Fax Printing
Schedule

If you have concerns about the security of
private faxes, use this feature to store faxes
rather than having them automatically print by
creating a printing schedule.

For the fax printing schedule, the control
panel prompts you to select days and times
to print faxes.

Select Change PIN to change the PIN
number that users must provide to access the
Fax Printing menu and the Fax Forwarding
menu. This PIN is exactly four digits.

Change PIN   

Table 2-7  Time/Scheduling menu (continued)
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Management menu
Administration > Management

Use this menu to set up global device-management options.

NOTE: Values shown with "(default)" are the factory-default values. Some menu items have no default.

Table 2-8  Management menu

Menu item Sub-menu item Values Description

Network Address Button  Display (default)

Hide

Select this option to display the Network Address
button on the control-panel home screen.

Stored Job Management Quick Copy Job Storage
Limit

Select the maximum
number of jobs to store

Use this menu to view and manage any jobs that are
stored on the device.

Quick Copy Job Held
Timeout

Off (default)

1 Hour

4 hours

1 Day

1 Week

Sleep mode  Disable

Use Sleep Delay (default)

Use this feature to customize the sleep mode settings
for this device.

Select Use Sleep Delay to set the device to enter sleep
mode after the delay that is specified in the Time/
Scheduling menu.

Manage Supplies Replace black cartridge Stop at low

Stop at out

Override at out (default)

Use this menu to carry out administrative supply
management tasks such as changing the threshold
when supplies should be ordered.

Supply Low/Order
Threshold

Select a value in the
range.
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Initial Setup menu
Administration > Initial Setup

The Initial Setup menu contains the sub-menus shown:

● Networking and I/O menu

● Fax Setup menu

● E-mail Setup menu

NOTE: Values shown with "(default)" are the factory-default values. Some menu items have no default.

Networking and I/O
Administration > Initial Setup > Networking and I/O

Table 2-9  Networking and I/O

Menu item Sub-menu item Values Description

I/O Timeout  Select a value in the
range. The factory default
setting is 15 seconds.

I/O timeout refers to the elapsed time before a print job
fails. If the stream of data that the device receives for
a print job gets interrupted, this setting indicates how
long the device will wait before it reports that the job
has failed.

Embedded Jetdirect See Table 2-10 Jetdirect menus on page 26 for the list of options.

EIO <X> Jetdirect

Table 2-10  Jetdirect menus

Menu item Sub-menu item Sub-menu item Values and Description

TCP/IP Enable  Off: Disable the TCP/IP protocol.

On (default): Enable the TCP/IP protocol.

Host Name  An alphanumeric string, up to 32 characters, used to
identify the device. This name is listed on the
HP Jetdirect configuration page. The default host name
is NPIxxxxxx, where xxxxxx is the last six digits of the
LAN hardware (MAC) address.
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Menu item Sub-menu item Sub-menu item Values and Description

 IPV4 Settings Config Method Specifies the method by which TCP/IPv4 parameters
for the HP Jetdirect print server will be configured.

Bootp: Use BootP (Bootstrap Protocol) for automatic
configuration from a BootP server.

DHCP (Default): Use DHCP (Dynamic Host
Configuration Protocol) for automatic configuration
from a DHCPv4 server. If selected and a DHCP lease
exists, DHCP Release and DHCP Renew menus are
available to set DHCP lease options.

Auto IP: Use automatic link-local IPv4 addressing. An
address in the form 169.254.x.x is assigned
automatically.

Manual: Use the Manual Settings menu to configure
TCP/IPv4 parameters.

  DHCP Release This menu appears if Config Method was set to
DHCP and a DHCP lease for the print server exists.

No (default): The current DHCP lease is saved.

Yes: Release the current IP address. Note that the
printer will lose network connectivity until it reboots at
which point it may have a new address.

  DHCP Renew This menu appears if Config Method was set to
DHCP and a DHCP lease for the print server exists.

No (default): The print server does not request to renew
the DHCP lease.

Yes: The print server renews the lease on it's IP
address.

  Manual Settings (Available only if Config Method is set to Manual)
Configure parameters directly from the printer control
panel:

IP Address: The unique IP address of the printer
(n.n.n.n), where n is a value from 0 to 255.

Subnet Mask: The subnet mask for the printer
(m.m.m.m), where m is a value from 0 to 255.

Syslog Server: The IP address of the syslog server
used to receive and log syslog messages.

Default Gateway: The IP address of the gateway or
router used for communications with other networks.

Idle Timeout: The time period, in seconds, after which
an idle TCP print data connection is closed (default is
270 seconds, 0 disables the timeout).

Table 2-10  Jetdirect menus (continued)
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Menu item Sub-menu item Sub-menu item Values and Description

  Default IP Specify the IP address to default to when the print
server is unable to obtain an IP address from the
network during a forced TCP/IP reconfiguration (for
example, when manually configured to use BootP or
DHCP).

Auto IP: A link-local IP address 169.254.x.x is set.

Legacy: The address 192.0.0.192 is set, consistent
with older HP Jetdirect devices.

  Primary DNS Specify the IP address (n.n.n.n) of a Primary DNS
Server.

  Secondary DNS Specify the IP address (n.n.n.n) of a Secondary
Domain Name System (DNS) Server.

 IPV6 Settings Enable Use this item to enable or disable IPv6 operation on the
print server.

Off (default): IPv6 is disabled.

On: IPv6 is enabled.

  Address Use this item to manually configure an IPv6 address.

Manual Settings: Use the Manual Settings menu to
enable and manually configure a TCP/ IPv6 address.

  DHCPV6 Policy Router Specified (Default): The stateful auto-
configuration method to be used by the print server is
determined by a router. The router specifies whether
the print server obtains its address, its configuration
information, or both from a DHCPv6 server.

Router Unavailable: If a router is not available, the print
server should attempt to obtain its stateful
configuration from a DHCPv6 server.

Always: Whether or not a router is available, the print
server always attempts to obtain its stateful
configuration from a DHCPv6 server.

  Primary DNS Use this item to specify an IPv6 address for a primary
DNS server that the print server should use.

  Manual Settings Use this item to manually set IPv6 addresses on the
print server.

Enable: Select this item and choose On to enable
manual configuration, or Off to disable manual
configuration.

Address: Use this item to type a 32 hexadecimal digit
IPv6 node address that uses the colon hexadecimal
syntax.

Table 2-10  Jetdirect menus (continued)
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Menu item Sub-menu item Sub-menu item Values and Description

 Proxy Server  Specifies the proxy server to be used by embedded
applications in the device. A proxy server is typically
used by network clients for Internet access. It caches
Web pages, and provides a degree of Internet security,
for those clients.

To specify a proxy server, enter its IPv4 address or
fully-qualified domain name. The name can be up to
255 octets.

For some networks, you may need to contact your
Independent Service Provider (ISP) for the proxy
server address.

Proxy Port  Type the port number used by the proxy server for
client support. The port number identifies the port
reserved for proxy activity on your network, and can be
a value from 0 to 65535.

IPX/SPX Enable  Off: Disable the IPX/SPX protocol.

On (default): Enable the IPX/SPX protocol.

Frame Type  Selects the frame-type setting for your network.

Auto (Default): Automatically sets and limits the frame
type to the first one detected.

EN_8023, EN_II, EN_8022, and EN_SNAP: Frame-
type selections for Ethernet networks.

A Talk Enable  Off : Disable the AppleTalk protocol.

On (default): Enable the AppleTalk protocol.

DLC/LLC Enable  Off : Disable the DLC/LLC protocol.

On (default): Enable the DLC/LLC protocol.

Table 2-10  Jetdirect menus (continued)
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Menu item Sub-menu item Sub-menu item Values and Description

Security Print Sec Page  Yes: Prints a page that contains the current security
settings on the HP Jetdirect print server.

No (default): A security settings page is not printed.

Secure Web  For configuration management, specify whether the
embedded Web server will accept communications
using HTTPS (Secure HTTP) only, or both HTTP and
HTTPS.

HTTPS Required (Default): For secure, encrypted
communications, only HTTPS access is accepted. The
print server will appear as a secure site.

HTTP/HTTPS optional: Access using either HTTP or
HTTPS is permitted.

IPsec or Firewall  Specify the IPsec or Firewall status on the print server.

Keep: IPsec/Firewall status remains the same as
currently configured.

Disable (Default): IPsec/Firewall operation on the print
server is disabled.

Reset Security  Specify whether the current security settings on the
print server will be saved or reset to factory defaults.

No (default): The current security settings are
maintained.

Yes: Security settings are reset to factory defaults.

Diagnostics Embedded Test  This menu provides tests to help diagnose network
hardware or TCP/IP network connection problems.

Embedded tests help to identify whether a network fault
is internal or external to the device. Use an embedded
test to check hardware and communication paths on
the print server. After you select and enable a test and
set the execution time, you must select Execute to
initiate the test.

Depending on the execution time, a selected test runs
continuously until either the device is turned off, or an
error occurs and a diagnostic page is printed.

  LAN HW Test CAUTION: Running this embedded test will erase
your TCP/IP configuration.

This test performs an internal loopback test. An internal
loopback test will send and receive packets only on the
internal network hardware. There are no external
transmissions on your network.

Select Yes to choose this test, or No to not choose it.

  HTTP Test This test checks operation of HTTP by retrieving
predefined pages from the device, and tests the
embedded Web server.

Select Yes to choose this test, or No to not choose it.

Table 2-10  Jetdirect menus (continued)
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Menu item Sub-menu item Sub-menu item Values and Description

  SNMP Test This test checks operation of SNMP communications
by accessing predefined SNMP objects on the device.

Select Yes to choose this test, or No to not choose it.

  Select All Tests Use this item to select all available embedded tests.

Select Yes to choose all tests. Select No to select
individual tests.

  Data Path Test This test helps to identify data path and corruption
problems on an HP postscript level 3 emulation device.
It sends a predefined PS file to the device, However,
the test is paperless; the file will not print.

Select Yes to choose this test, or No to not choose it.

  Execution Time [H] Use this item to specify the length of time (in hours) that
an embedded test will be run. You can select a value
from 1 to 60 hours. If you select zero (0), the test runs
indefinitely until an error occurs or device is turned off.

Data gathered from the HTTP, SNMP, and Data Path
tests is printed after the tests have completed.

  Execute No*: Do not initiate the selected tests.

Yes: Initiate the selected tests.

 Ping Test  This test is used to check network communications.
This test sends link-level packets to a remote network
host, then waits for an appropriate response. To run a
ping test, set the following items:

Dest Type Specify whether the target device is an IPv4 or IPv6
node.

Dest IP IPV4: Type the IPv4 address.

IPV6: Type the IPv6 address.

Packet Size Specify the size of each packet, in bytes, to be sent to
the remote host. The minimum is 64 (default) and the
maximum is 2048.

Timeout Specify the length of time, in seconds, to wait for a
response from the remote host. The default is 1 and
the maximum is 100.

Count Specify the number of ping test packets to send for this
test. Select a value from 1 to 100. To configure the test
to run continuously, select 0.

Print Results If the ping test was not set for continuous operation,
you can choose to print the test results. Select Yes to
print results. If you select No (default), results are not
printed.

Execute Specify whether to initiate the ping test. Select Yes to
initiate the test, or No to not run the test.

Table 2-10  Jetdirect menus (continued)
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Menu item Sub-menu item Sub-menu item Values and Description

 Ping Results  Use this item to view the ping test status and results
using the control panel display. You can select the
following items:

Packets Sent Shows the number of packets (0 - 65535) sent to the
remote host since the most recent test was initiated or
completed.

Packets Received Shows the number of packets (0 - 65535) received from
the remote host since the most recent test was initiated
or completed.

Percent Lost Shows the percent of ping test packets that were sent
with no response from the remote host since the most
recent test was initiated or completed.

RTT Min Shows the minimum detected roundtrip- time (RTT),
from 0 to 4096 milliseconds, for packet transmission
and response.

RTT Max Shows the maximum detected roundtrip- time (RTT),
from 0 to 4096 milliseconds, for packet transmission
and response.

RTT Average Shows the average round-trip-time (RTT), from 0 to
4096 milliseconds, for packet transmission and
response.

Ping In Progress Shows whether a ping test is in progress. Yes indicates
a test in progress, and No indicates that a test
completed or was not run.

Refresh When viewing the ping test results, this item updates
the ping test data with current results. Select Yes to
update the data, or No to maintain the existing data.
However, a refresh automatically occurs when the
menu times out or you manually return to the main
menu.

Table 2-10  Jetdirect menus (continued)
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Menu item Sub-menu item Sub-menu item Values and Description

Link Speed   The link speed and communication mode of the print
server must match the network. The available settings
depend on the device and installed print server. Select
one of the following link configuration settings:

CAUTION: If you change the link setting, network
communications with the print server and network
device might be lost.

Auto (default): The print server uses auto-negotiation
to configure itself with the highest link speed and
communication mode allowed. If auto-negotiation fails,
either 100TX HALF or 10TX HALF is set depending on
the detected link speed of the hub/switch port. (A
1000T half-duplex selection is not supported.)

10T Half: 10 Mbps, half-duplex operation.

10T Full: 10 Mbps, Full-duplex operation.

100TX Half: 100 Mbps, half-duplex operation.

100TX Full: 100 Mbps, full-duplex operation.

100TX Auto: Limits auto-negotiation to a maximum link
speed of 100 Mbps.

1000TX Full: 1000 Mbps, full-duplex operation.

Print Protocols   Use this item to print a page that lists the configuration
of the following protocols: IPX/SPX, Novell NetWare,
AppleTalk, DLC/LLC.

Table 2-10  Jetdirect menus (continued)
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Fax Setup
Administration > Initial Setup > Fax Setup

NOTE: This menu is only available if the HP LaserJet Analog Fax Accessory 300 is installed.

Table 2-11  Fax Setup menu

Menu item Sub-menu item Sub-menu item Values Description

Required Settings Country/Region  (Countries/regions
listed)

Configure the settings that are legally
required for outgoing faxes.

Date/Time   

Fax Header
Information

Phone Number

Company Name

 

PC Fax Send   Disabled

Enabled (default)

Use this feature to enable or disable PC Fax
Send. PC Fax Send enables users to send
faxes through the device from their
computers if they have the Send Fax driver
installed.
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Menu item Sub-menu item Sub-menu item Values Description

Fax Send Settings Fax Dial Volume  Off

Low (default)

High

Use this feature to set the volume of the tones
that you hear while the device dials the fax
number.

Error Correction
Mode

 Enabled (default)

Disabled

When Error Correction Mode is enabled and
an error occurs during fax transmission, the
device sends or receives the error portion
again.

JBIG Compression  Enabled (default)

Disabled

JBIG compression reduces fax-transmission
time, which can result in lower phone
charges. However, using JBIG compression
sometimes causes compatibility problems
with older fax machines. If this occurs, turn off
JBIG compression.

Maximum Baud Rate  Select a value from
the list. The default is
33.6K.

Use this feature to set the maximum baud
rate for receiving faxes. This can be used as
a diagnostic tool for troubleshooting fax
problems.

TCF T.30 Delay
Timer

 Default (default)

Custom

This setting should be left at the default value
and only changed when directed by an HP
technical support agent. Adjustment
procedures associated with this setting are
beyond the scope of this guide.

TCF Extend  Default (default)

Custom

This setting should be left at the default value
and only changed when directed by an HP
technical support agent. Adjustment
procedures associated with this setting are
beyond the scope of this guide.

Dialing Mode  Tone (default)

Pulse

Select whether the device should use tone or
pulse dialing.

Redial On Busy  The range is between
0 and 9. The factory
default is 3 times.

Type the number of times the device should
attempt to redial if the line is busy.

Redial On No Answer  Never (default)

Once

Twice

Use this feature to specify the number of
times the device should attempt to dial if the
recipient fax number does not answer.

NOTE: Twice is available in locations other
than the United States and Canada.

Table 2-11  Fax Setup menu (continued)
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Menu item Sub-menu item Sub-menu item Values Description

 Redial Interval  The range is between
1 and 5 minutes. The
factory default is 5
minutes.

Use this feature to specify the number of
minutes between dialing attempts if the
recipient number is busy or not answering.

Detect Dial Tone  Enabled

Disabled (default)

Use this feature to specify whether the device
should check for a dial tone before sending a
fax.

Dialing Prefix  Off (default)

Custom

Use this feature to specify a prefix number
that must be dialed when sending faxes from
the device.

Billing Codes  Off (default)

Custom

When billing codes are enabled, a prompt
appears that asks the user to enter the billing
code for an outgoing fax.

The range is between 1 and 16 digits. The
default is 1 digit.

Fax Receive Settings Rings To Answer  The range varies by
location. The factory
default is 2 rings.

Use this feature to specify the number of rings
that must occur before the fax modem
answers.

Ring Interval  Default (default)

Custom

This setting is used to adjust for some PBX
ring signals. Change this setting only when
directed by an HP technical support agent.

Ring Frequency  Default (default)

Custom

This setting should be left at the default value
and only changed when directed by an HP
technical support agent. Adjustment
procedures associated with this setting are
beyond the scope of this guide.

Ringer Volume  Off

Low (default)

High

Set the volume for the fax ring-tone.

Blocked Fax
Numbers

Add Blocked
Numbers

Type the fax number
to add.

Use this feature to add or delete numbers
from the blocked fax list. The blocked fax list
can contain up to 30 numbers. When the
device receives a call from one of the blocked
fax numbers, it deletes the incoming fax. It
also logs the blocked fax in the activity log
along with job-accounting information.

Remove Blocked
Numbers

Select a fax number
to remove.

Clear All Blocked
Numbers

No (default)

Yes

Table 2-11  Fax Setup menu (continued)
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E-mail Setup
Administration > Initial Setup > E-mail Setup

Use this menu to enable the e-mail feature and to configure basic e-mail settings.

NOTE: To configure advanced e-mail settings, use the embedded Web server. For more information,
see Embedded Web server on page 148.

Table 2-12  E-mail Setup menu

Menu item Values Description

Address Validation On (default)

Off

This option enables the device to check e-mail syntax when you type
an e-mail address. Valid e-mail addresses require the "@" sign and
a ".".

Find Send Gateways  Search the network for SMTP gateways that the device can use to
send e-mail.

SMTP Gateway Enter a value. Specify the IP address of the SMTP gateway that is used to send e-
mail from the device.

Test Send Gateway  Test the configured SMTP gateway to see if it is functional.

Send Setup menu
Administration > Initial Setup > Send Setup

Table 2-13  Send Setup menu

Menu item Values Description

Replicate MFP Enter a value (IP Address). Copy the local Send settings from one device to another.

Allow Transfer to New DSS Off

On (default)

Use this feature to allow the transfer of the device from one HP Digital
Sending Software (DSS) server to another.

HP DSS is a software package that handles digital sending tasks such
as faxing, e-mail, and sending a scanned document to a network
folder.

Allow Use of Digital Send Service Off

On (default)

This feature allows you to configure the device for use with an
HP Digital Sending Software (DSS) server.

Fax Number Confirmation Disable (default)

Enable

Enable fax number confirmation for fax numbers that are entered at
the device control panel. When fax number confirmation is enabled,
the fax number must be entered twice to ensure that it was entered
correctly.

Fax Number Speed Dial
Matching

Disable (default)

Enable

If this feature is enabled, the MFP tries to match any fax number
entered with existing entries in the speed dial list. If a match is found,
you can confirm the match and have the MFP complete the faxing
action automatically.
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Device Behavior menu
Administration > Device Behavior

NOTE: Values shown with "(default)" are the factory-default values. Some menu items have no default.

Table 2-14  Device Behavior menu

Menu item Sub-menu item Sub-menu item Values Description

Language   Select the language
from the list.

Use this feature to select a different language
for control-panel messages. When you select
a new language, the keyboard layout might
also change.

Key Press Sound   On (default)

Off

Use this feature to specify whether you hear
a sound when you touch the screen or press
buttons on the control panel.

Inactivity Timeout   Type a value
between 10 and 300
seconds. The factory
default is 60
seconds.

Use this feature to specify the amount of time
that elapses between any activity on the
control panel and the device resetting to the
default settings.

Warning/Error
Behavior

Clearable Warnings  On

Job (default)

Use this feature to set the amount of time that
a clearable warning appears on the control
panel.

Continuable Events  Auto continue (10
seconds) (default)

Press OK to continue

Use this option to configure the device
behavior when the device encounters certain
errors.

Jam Recovery  Auto (default)

On

Off

Use this feature to configure how the device
handles pages that are lost during a jam.

Tray Behavior Use Requested Tray  Exclusively (default)

First

Use this feature to control how the device
handles jobs that have specified a specific
input tray.

Manually Feed
Prompt

 Always (default)

Unless Loaded

Use this feature to indicate whether a prompt
should appear when the type or size for a job
does not match the specified tray and the
device pulls from the multipurpose tray
instead.

PS Defer Media  Enabled (default)

Disabled

Use this feature to choose either the
postscript (PS) or HP paper-handling model.

Use Another Tray  Enabled (default)

Disabled

Use this feature to turn on or off the control-
panel prompt to select another tray when the
specified tray is empty.

Size/Type Prompt  Display

Do not display
(default)

Use this feature to control whether the tray
configuration message appears whenever a
tray is opened or closed.

Duplex Blank Pages  Auto (default)

Yes

Use this feature to control how the device
handles two-sided jobs (duplexing).
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Menu item Sub-menu item Sub-menu item Values Description

[output device menu]

NOTE: This menu
varies depending on
the output device
installed.

   Use this menu to set the finishing options for
the installed output device.

General Copy
Behavior

Hold Off Print Job  On

Off

Prevents print jobs from beginning to print
while a walk-up user is setting up a job.

Hold Off Time   Prevents non-copy print jobs from starting for
a specified time after a copy job is completely
printed.

Scan Ahead  Enabled (default)

Disabled

Use this feature to turn on no-wait scanning.
With Scan Ahead enabled, the pages in the
original document are scanned to disk and
held until the device becomes available.

 Auto Print Interrupt  Enabled

Disabled (Default)

When this feature is enabled, copy jobs can
interrupt print jobs that are set to print multiple
copies.

The copy job is inserted into the print queue
at the end of one copy of the print job. After
the copy job is complete, the device
continues printing the remaining copies of the
print job.

 Copy Interrupt  Enabled

Disabled (Default)

When this feature is enabled, a copy job that
is currently printing can be interrupted when
a new copy job is started. You are prompted
to confirm that you want to interrupt the
current job.

 Alternative
Letterhead Mode

 Off (default)

On

Enable this feature to load letterhead or
preprinted paper into the tray the same way
for all copy jobs, whether you are copying to
one side of the sheet or to both sides of the
sheet. When this option is selected, load the
paper as you would for printing on both sides.
The device speed slows to the speed
required for printing on both sides.

Table 2-14  Device Behavior menu (continued)
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Menu item Sub-menu item Sub-menu item Values Description

General Printing
Behavior

Override A4/Letter  No

Yes (default)

Use this feature to print on letter-size paper
when an A4 job is sent but no A4-size paper
is loaded in the device (or to print on A4 paper
when a letter-size job is sent but no letter-size
paper is loaded). This option will also override
A3 with ledger-size paper and ledger with A3-
size paper.

Manual Feed  Enabled

Disabled (default)

When this feature is enabled, the user can
select manual feed from the control panel as
the paper source for a job.

Edge-To-Edge
Override

 Enabled

Disabled (default)

Use the feature to turn the edge-to-edge
mode on or off for all print jobs. This mode
can be overridden inside a print job by an
edge-to-edge PJL variable.

Courier Font  Regular (default)

Dark

Use this feature to select which version of the
Courier font you want to use.

Wide A4  Enabled

Disabled (default)

Use this feature to change the printable area
of A4-size paper. If you enable this option,
eighty 10-pitch characters can be printed on
a single line of A4 paper.

Print PS Errors  Enabled

Disabled (default)

Use this feature to select whether a postscript
(PS) error page is printed when the device
encounters a PS error.

Print PDF Errors  Enabled (default)

Disabled

Use this feature to select whether a PDF error
page is printed when the device encounters
a PDF error.

Personality  Auto (default)

PCL

PDF

PS

Select the printer language that the device
should use.

Normally you should not change the
language. If you change the setting to a
specific language, the device does not
automatically switch from one language to
another unless specific software commands
are sent to the device.

Table 2-14  Device Behavior menu (continued)
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Menu item Sub-menu item Sub-menu item Values Description

 PCL Form Length Type a value
between 5 and 128
lines. The factory
default is 60 lines.

PCL is a set of printer commands that
Hewlett-Packard developed to provide
access to printer features.

Orientation Portrait (default)

Landscape

Select the orientation that is most often used
print jobs. Select Portrait if the short edge is
at the top or select Landscape if the long edge
is at the top.

Font Source Select the source
from the list.

Use this feature to select the font source for
the user-defined soft default font.

Font Number Type the font
number. The range is
between 0 and 999.
The factory default is
0.

Use this feature to specify the font number for
the user-soft default font using the source that
is specified in the Font Source menu item.
The device assigns a number to each font
and lists it on the PCL font list (available from
the Administration menu).

Font Pitch Type a value
between 0.44 and
99.99. The factory
default is 10.00.

If Font Source and Font Number indicate a
contour font, then use this feature to select a
default pitch (for a fixed-spaced font).

Font Point Size Type a value
between 4.00 and
999.75. The factory
default is 12.00.

If Font Source and Font Number indicate a
contour font, then use this feature to select a
default point size (for a proportional-spaced
font).

Symbol Set PC-8 (default)

(50 additional symbol
sets from which to
choose)

Use this feature to select any one of several
available symbol sets from the control panel.
A symbol set is a unique grouping of all the
characters in a font.

Append CR to LF No (default)

Yes

Use this feature to configure whether a
carriage return (CR) is appended to each line
feed (LF) encountered in backwards-
compatible PCL jobs (pure text, no job
control).

Suppress Blank
Pages

No (default)

Yes

This option is for users who are generating
their own PCL, which could include extra form
feeds that would cause blank pages to be
printed. When Yes is selected, form feeds are
ignored if the page is blank.

Media Source
Mapping

Standard (default)

Classic

Use this feature to select and maintain input
trays by number when you are not using the
device driver, or when the software program
has no option for tray selection.

Table 2-14  Device Behavior menu (continued)
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Print Quality menu
Administration > Print Quality

NOTE: Values shown with "(default)" are the factory-default values. Some menu items have no default.

Table 2-15  Print Quality menu

Menu item Sub-menu item Values Description

Set Registration Test Page Print (button) Print a test page for setting the registration. Follow the
instructions that are printed on the page to adjust each
tray.

Source All trays

Tray <X>: <contents>
Tray <X>: <contents>
(choose a tray)

Use Set Registration to shift the margin alignment to
center the image on the page from top to bottom and
from left to right. You can also align the image on the
front with the image printed on the back.

Select the source input tray for printing the Set
Registration page.

Adjust Tray <X> Shift from -20 to 20 along
the X or Y axes. 0 is the
default.

Perform the alignment procedure for each tray.

When it creates an image, the device scans across the
page from side to side as the sheet feeds from top to
bottom into the device.

Fuser Modes Standby Fuser Mode 125° Celsius

Off

Set the temperature of the fuser when the MFP is in
standby mode.

<Paper Type>  Configure the fuser mode associated with each media
type.

Restore Modes Restore (button) Restore the fuser modes to the default settings.

Resolution  300

600

FastRes 1200 (default)

ProRes 1200

Use this feature to select the print resolution.

REt  Off

Light

Medium (default)

Dark

Enable Resolution Enhancement technology (REt),
which produces print output with smooth angles,
curves, and edges. All print resolutions, including
FastRes 1200, benefit from REt.

Economode  Enabled

Disabled (default)

When Economode is enabled, the device prints with a
reduced amount of toner per page; however, the print
quality of the page is reduced.

Toner Density  Choose from a range of 1
to 5. 3 is the default.

Lighten or darken the print on the page. 1 is the lightest
and 5 is the darkest.

Small Paper Mode  Normal (default)

Slow

Choose Slow to adjust the MFP for printing narrow
media.
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Menu item Sub-menu item Values Description

Calibration/Cleaning Create Cleaning Page Create (button) Generate a page for cleaning excess toner off the
pressure roller in the fuser. The page has instructions
that guide you through the cleaning process.

Process Cleaning Page Process (button) Process the cleaning page that was created by using
the Create Cleaning Page menu item. The process
takes up to 2.5 minutes.

Table 2-15  Print Quality menu (continued)
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Troubleshooting menu
Administration > Troubleshooting

NOTE: Many of the menu items under the Troubleshooting menu are for advanced troubleshooting
purposes.

Table 2-16  Troubleshooting menu

Menu item Sub-menu item Sub-menu item Values Description

Event Log   Print This shows the event codes and their
corresponding engine cycles on the control-
panel display.

Fax T.30 Trace (only
available if the
HP LaserJet Analog
Fax Accessory 300 is
installed)

Print T.30 Report   Print or configure the fax T.30 trace report. T.
30 is the standard that specifies
handshaking, protocols, and error correction
between fax machines.

When to Print Report  Never auto print
(default)

Print after any fax job

Print after fax send
jobs

Print after any fax
error

Print after send
errors only

Print after receive
errors only

Fax Transmit Signal
Loss (only available if
the HP LaserJet
Analog Fax
Accessory 300 is
installed)

  A value between 0
and 30. The default is
0.

Set loss levels to compensate for phone-line
signal loss. Do not modify this setting unless
requested to do so by an HP service
representative because it could cause the fax
to stop functioning.

Fax V.34 (only
available if the
HP LaserJet Analog
Fax Accessory 300 is
installed)

  Normal (default)

Off

Disable V.34 modulations if several fax
failures have occurred or if phone line
conditions require it.

Fax Speaker Mode
(only available if the
HP LaserJet Analog
Fax Accessory 300 is
installed)

  Normal (default)

Diagnostic

Use this feature to evaluate and diagnose fax
issues by listening to the sounds of fax
modulations.
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Menu item Sub-menu item Sub-menu item Values Description

Paper Path Test Print Test Page  Print Generate a test page for testing the paper-
handling features. Define the path for the test
in order to test specific paper paths.

Source  All trays

Tray 1

Tray 2

(Additional trays are
shown, if applicable.)

Specify whether the test page is printed from
all trays or from a specific tray.

Destination  All bins

Stacker Bin

Standard Output Bin

Select the output option for the test page.
Send the test page to all output bins or only
to a specific bin.

Duplex  Off (default)

On

Select whether the duplexer should be
included in the test.

Copies  1,10,50,100,500

Default=1

Select how many pages should be sent from
the specified source as part of the test.

Service Test   Follow the on-screen
instructions.

Provides a series of prompts that the user can
follow to discover if the printer is functioning
properly. It also makes sure that paper is not
in the paper path.

Print/Stop Test   Continuous value
from 0 to 60,000
milliseconds.
Default: 0

Isolate faults by stopping the device during
the print cycle and observing where in the
process the image degrades. To run the test,
specify a stop time. The next job that is sent
to the device stops at the specified time in the
process.

Scanner Tests    A service technician can use this menu item
to diagnose potential problems with the
device scanner.

Control Panel LEDs   Verify that the components of the control
panel are functioning correctly.

Display   

Buttons   

Touchscreen   

Table 2-16  Troubleshooting menu (continued)
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Resets menu
Administration > Resets

Table 2-17  Resets menu

Menu item Values Description

Clear Local Address Book Clear (button) Use this feature to clear all addresses from the address books that
are stored on the device.

Clear Fax Activity Log Yes

No (default)

Use this feature to clear all events from the Fax Activity Log.

Restore Factory Telecom Setting Restore (button) Use this option to restore the telephone-related settings that are in
the Initial Setup menu to factory default values.

Restore Factory Settings Restore (button) Use this feature to restore all device settings to their factory defaults.

Clear Maintenance Message Clear (button) Clear the Order maintenance kit and Replace maintenance kit
warning messages.

Reset Supplies New Maintenance Kit (Yes/No) Notify the device that a new maintenance kit has been installed.

Lock Carriage Lock (button) Use the feature to lock the carriage. To unlock the carriage, turn the
MFP off and then on.

Service menu
Administration > Service

The Service menu is locked and requires a PIN for access. This menu is intended for use by authorized
service personnel.
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3 Software for Windows

● Supported operating systems for Windows

● Supported printer drivers for Windows

● HP Universal Print Driver (UPD)

● Select the correct printer driver for Windows

● Priority for print settings

● Change printer-driver settings for Windows

● Supported utilities

● Software for other operating systems
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Supported operating systems for Windows
The product supports the following Windows operating systems:

● Windows XP (32-bit and 64-bit)

● Windows Server 2003 (32-bit and 64-bit)

● Windows Server 2008 (32-bit and 64-bit)

● Windows 2000

● Windows Vista
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Supported printer drivers for Windows
HP provides the following drivers for downloading:

● HP Universal Print Driver (UPD): Postscript, PCL 6, PCL 5

● Mac Driver

● Linux

● SAP

● UNIX Model Script

A product-specific driver is not available for the HP LaserJet M9059 MFP. Drivers for this product are
available at www.hp.com/go/ljm9059mfp_software or your country/region alternative.

The printer drivers include online Help that has instructions for common printing tasks and also describes
the buttons, checkboxes, and drop-down lists that are in the printer driver.
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HP Universal Print Driver (UPD)
The HP Universal Print Driver (UPD) for Windows is a single driver that gives you instant access to
virtually any HP LaserJet product, from any location, without downloading separate drivers. It is built on
proven HP print driver technology and has been tested thoroughly and used with many software
programs. It is a powerful solution that performs consistently over time.

The HP UPD communicates directly with each HP product, gathers configuration information, and then
customizes the user interface to show the product’s unique, available features. It automatically enables
features that are available for the product, such as two-sided printing and stapling, so you do not need
to enable them manually.

For more information, go to www.hp.com/go/upd.

UPD installation modes

Traditional mode ● Use this mode if you are installing the driver for a single computer.

● When installed with this mode, UPD operates like traditional printer drivers.

● If you use this mode, you must install UPD separately for each computer.

Dynamic mode ● Use this mode if you are installing the driver for a mobile computer, so you can
discover and print to HP products in any location.

● Use this mode if you are installing UPD for a workgroup.

● To use this mode, download UPD from the Internet. See www.hp.com/go/
upd.
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Select the correct printer driver for Windows
Printer drivers provide access to the product features and allow the computer to communicate with the
product (using a printer language). Check the installation notes and readme files for additional software
and languages.

HP PCL 6 driver description

● Recommended for printing in all Windows environments

● Provides the overall best speed, print quality, and product-feature support for most users

● Developed to align with the Windows Graphic Device Interface (GDI) for the best speed in Windows
environments

● Might not be fully compatible with third-party and custom software programs that are based on
PCL 5

HP postscript emulation description

● Recommended for printing with Adobe® software programs or with other highly graphics-intensive
software programs

● Provides support for printing from postscript level 3 emulation needs, or for postscript flash font
support

● Performs slightly faster than the PCL 6 driver when using Adobe software programs

HP PCL 5 description

● Recommended for general office printing in Windows environments

● Compatible with previous PCL versions and older HP LaserJet products

● The best choice for printing from third-party or custom software programs

● The best choice when operating with mixed environments, which require the product to be set to
PCL 5 (UNIX, Linux, mainframe)

● Designed for use in corporate Windows environments to provide a single driver for use with multiple
printer models

● Preferred when printing to multiple printer models from a mobile Windows computer
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Priority for print settings
Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software program.

● Page Setup dialog box: Click Page Setup or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed here override settings changed
anywhere else.

● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed in the Print dialog box have a lower
priority and do not override changes made in the Page Setup dialog box.

● Printer Properties dialog box (printer driver): Click Properties in the Print dialog box to open
the printer driver. Settings changed in the Printer Properties dialog box do not override settings
anywhere else in the printing software.

● Default printer driver settings: The default printer driver settings determine the settings used in
all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties dialog
boxes.

● Printer control panel settings: Settings changed at the printer control panel have a lower priority
than changes made anywhere else.

52 Chapter 3   Software for Windows ENWW



Change printer-driver settings for Windows
Change the settings for all print jobs
until the software program is closed

Change the default settings for all
print jobs

Change the product configuration
settings

1. On the File menu in the software
program, click Print.

2. Select the driver, and then click
Properties or Preferences.

The steps can vary; this procedure is
most common.

1. Windows XP, Windows Server
2003, and Windows Server 2008
(using the default Start menu
view): Click Start, and then click
Printers and Faxes.

-or-

Windows 2000, Windows XP,
Windows Server 2003, and
Windows Server 2008 (using the
Classic Start menu view): Click
Start, click Settings, and then click
Printers.

-or-

Windows Vista: Click Start, click
Control Panel, and then in the
category for Hardware and
Sound click Printer.

2. Right-click the driver icon, and then
select Printing Preferences.

1. Windows XP, Windows Server
2003, and Windows Server 2008
(using the default Start menu
view): Click Start, and then click
Printers and Faxes.

-or-

Windows 2000, Windows XP,
Windows Server 2003, and
Windows Server 2008 (using the
Classic Start menu view): Click
Start, click Settings, and then click
Printers.

-or-

Windows Vista: Click Start, click
Control Panel, and then in the
category for Hardware and
Sound click Printer.

2. Right-click the driver icon, and then
select Properties.

3. Click the Device Settings tab.

ENWW Change printer-driver settings for Windows 53



Supported utilities
This MFP is equipped with several utilities that make it easy to monitor and manage the MFP on a
network.

HP Web Jetadmin
HP Web Jetadmin is a browser-based management tool for HP Jetdirect-connected printers within your
intranet, and it should be be installed only on the network administrator’s computer.

NOTE: HP Web Jetadmin 10.0 or later is required for full support of this product.

To download a current version of HP Web Jetadmin and for the latest list of supported host systems,
visit www.hp.com/go/webjetadmin.

When installed on a host server, any client can gain access to HP Web Jetadmin by using a supported
Web browser (such as Microsoft® Internet Explorer 4.x or Netscape Navigator 4.x or later) by navigating
to the HP Web Jetadmin host.

Embedded Web server
The device is equipped with an embedded Web server, which provides access to information about
device and network activities. This information appears in a Web browser, such as Microsoft Internet
Explorer, Netscape Navigator, Apple Safari, or Firefox.

The embedded Web server resides on the device. It is not loaded on a network server.

The embedded Web server provides an interface to the device that anyone who has a network-
connected computer and a standard Web browser can use. No special software is installed or
configured, but you must have a supported Web browser on your computer. To gain access to the
embedded Web server, type the IP address for the device in the address line of the browser. (To find
the IP address, print a configuration page. For more information about printing a configuration page,
see Information pages on page 146.)

For a complete explanation of the features and functionality of the embedded Web server, see
Embedded Web server on page 148.
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Software for other operating systems
OS Software

UNIX For HP-UX and Solaris networks, go to www.hp.com/support/net_printing to download the
HP Jetdirect printer installer for UNIX.

Linux For information, go to www.hp.com/go/linuxprinting.
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4 Use the product with Macintosh

● Software for Macintosh

● Use features in the Macintosh printer driver
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Software for Macintosh
Supported operating systems for Macintosh

The device supports the following Macintosh operating systems:

● Mac OS X V10.3, V10.4, V10.5 and later

NOTE: For Mac OS X V10.4 and later, PPC and Intel Core Processor Macs are supported.

Supported printer drivers for Macintosh
The HP installer provides PostScript® Printer Description (PPD) files, Printer Dialog Extensions (PDEs),
and the HP Printer Utility for use with Macintosh computers.

The PPDs, in combination with the Apple PostScript printer drivers, provide access to device features.
Use the Apple PostScript printer driver that comes with the computer.

Software installation types for Macintosh

Install Macintosh software for direct connections (USB)

Mac OS X V10.3 and later

1. Make sure the product is turned on.

2. Download the driver from www.hp.com/go/ljm9059mfp_software or obtain it from your dealer.

3. Double-click the Installer icon in the HP LaserJet Installer folder.

4. Follow the instructions on the computer screen.

5. Connect a USB cable between the product USB port and the computer USB port. Use a standard
2-meter (6.56-foot) USB cable.

NOTE: USB printer queues are created automatically when the product is attached to the
computer. However, the queue will use a generic PPD if the installer has not been run before the
USB cable is connected.

6. From the Apple menu, click System Preferences and then Print & Fax.

7. If the product name appears in the Printer list, setup is complete. If the product name does not
appear in the printer list, continue with the next step.

8. Click Add or +, and then select Default Browser or Default. Select the product name from the
Printer Browser.

9. Click Add. The Installable Options dialog box appears. Select the product options that you are
using.

10. Print a test page from any software program to make sure that the software is correctly installed.

If installation fails, reinstall the software. If this fails, see the installation notes or late-breaking
readme files for help.
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Install Macintosh software for networks

Mac OS X V10.3 and later

1. Connect the network cable between the HP Jetdirect print server and a network port.

2. Download the driver from www.hp.com/go/ljm9059mfp_software or obtain it from your dealer.

3. Double-click the Installer icon in the HP LaserJet Installer folder.

4. Follow the instructions on the computer screen.

5. From the Apple menu, click System Preferences and then Print & Fax.

6. Click Add or +.

7. Select the connection type.

Default Browser

a. Select the product from the list.

b. From the Print Using drop-down list, select the printer model if one is not already selected.

IP Printer

a. From the Protocol drop-down list, select HP Jetdirect Socket.

b. Enter the IP address for the product.

c. From the Print Using drop-down list, select the printer model if one is not already selected.

8. Click Add. The Installable Options dialog box appears. Select the product options that you are
using.

9. Print a test page from any software program to make sure that the software is correctly installed.

If installation fails, reinstall the software. If this fails, see the installation notes or late-breaking
readme files for help.

Software for Macintosh computers

HP Printer Utility
Use the HP Printer Utility to set up product features that are not available in the printer driver.

You can use the HP Printer Utility when the product uses a universal serial bus (USB) cable or is
connected to a TCP/IP-based network.

Open the HP Printer Utility

Open the HP Printer Utility in Mac OS X V10.3 and V10.4

1. Open the Finder, click Applications, click Utilities, and then double-click Printer Setup Utility.

2. Select the product that you want to configure, and then click Utility.

Open the HP Printer Utility in Mac OS X V10.5

� From the Printer menu, click Printer Utility.
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-or-

From the Print Queue, click the Utility icon.

HP Printer Utility features

The HP Printer Utility consists of pages that you open by clicking in the Configuration Settings list.
The following table describes the tasks that you can perform from these pages.

Item Description

Configuration Page Prints a configuration page.

Supplies Status Shows the device supplies status.

File Upload Transfers files from the computer to the device.

Upload Fonts Transfers font files from the computer to the device.

Firmware Update Transfers updated firmware files from the computer to the device.

Duplex Mode Turns on the automatic two-sided printing mode.

Economode & Toner Density Turns on the Economode setting to conserve toner, or adjusts toner density.

Resolution Changes the resolution settings, including the REt setting.

Lock Resources Locks or unlocks storage products, such as a hard disk.

Stored Jobs Manages print jobs that are stored on the device hard disk.

Trays Configuration Changes the default tray settings.

IP Settings Changes the device network settings and provides access to the embedded Web server.

Bonjour Settings Provides the ability to turn on or off Bonjour support or change the device service name
that is listed on a network.

Additional Settings Provides access to the embedded Web server.

E-mail Alerts Configures the device to send e-mail notices for certain events.

Priority for print settings for Macintosh
Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software program.

● Page Setup dialog box: Click Page Setup or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed here might override settings changed
anywhere else.

● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed in the Print dialog box have a lower
priority and do not override changes made in the Page Setup dialog box.

● Default printer driver settings: The default printer driver settings determine the settings used in
all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties dialog
boxes.

● Printer control panel settings: Settings changed at the printer control panel have a lower priority
than changes made anywhere else.
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Change printer-driver settings for Macintosh

Change the settings for all print jobs
until the software program is closed

Change the default settings for all
print jobs

Change the product configuration
settings

1. On the File menu, click Print.

2. Change the settings that you want
on the various menus.

1. On the File menu, click Print.

2. Change the settings that you want
on the various menus.

3. On the Presets menu, click Save
as and type a name for the preset.

These settings are saved in the
Presets menu. To use the new settings,
you must select the saved preset option
every time you open a program and print.

Mac OS X V10.3 or Mac OS X V10.4

1. From the Apple menu, click System
Preferences and then Print &
Fax.

2. Click Printer Setup.

3. Click the Installable Options
menu.

Mac OS X V10.5

1. From the Apple menu, click System
Preferences and then Print &
Fax.

2. Click Options & Supplies.

3. Click the Driver menu.

4. Select the driver from the list, and
configure the installed options.

Remove software from Macintosh operating systems
To remove the software from a Macintosh computer, drag the PPD files to the trash can.

Supported utilities for Macintosh

Embedded Web server
The device is equipped with an embedded Web server, which provides access to information about
device and network activities. This information appears in a Web browser, such as Microsoft Internet
Explorer, Netscape Navigator, Apple Safari, or Firefox.

The embedded Web server resides on the device. It is not loaded on a network server.

The embedded Web server provides an interface to the device that anyone who has a network-
connected computer and a standard Web browser can use. No special software is installed or
configured, but you must have a supported Web browser on your computer. To gain access to the
embedded Web server, type the IP address for the device in the address line of the browser. (To find
the IP address, print a configuration page. For more information about printing a configuration page,
see Information pages on page 146.)

For a complete explanation of the features and functionality of the embedded Web server, see
Embedded Web server on page 148.
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Use features in the Macintosh printer driver
Create and use printing presets in Macintosh

Use printing presets to save the current printer driver settings for reuse.

Create a printing preset

1. On the File menu, click Print.

2. Select the driver.

3. Select the print settings.

4. In the Presets box, click Save As..., and type a name for the preset.

5. Click OK.

Use printing presets

1. On the File menu, click Print.

2. Select the driver.

3. In the Presets box, select the printing preset that you want to use.

NOTE: To use printer-driver default settings, select Standard.

Resize documents or print on a custom paper size
You can scale a document to fit on a different size of paper.

1. On the File menu, click Print.

2. Open the Paper Handling menu.

3. In the area for Destination Paper Size, select Scale to fit paper size, and then select the size
from the drop-down list.

4. If you want to use only paper that is smaller than the document, select Scale down only.

Print a cover page
You can print a separate cover page for your document that includes a message (such as “Confidential”).

1. On the File menu, click Print.

2. Select the driver.

3. Open the Cover Page menu, and then select whether to print the cover page Before Document
or After Document.

4. In the Cover Page Type menu, select the message that you want to print on the cover page.

NOTE: To print a blank cover page, select Standard as the Cover Page Type.
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Use watermarks
A watermark is a notice, such as “Confidential,” that is printed in the background of each page of a
document.

1. On the File menu, click Print.

2. Open the Watermarks menu.

3. Next to Mode, select the type of watermark to use. Select Watermark to print a semi-transparent
message. Select Overlay to print a message that is not transparent.

4. Next to Pages, select whether to print the watermark on all pages or on the first page only.

5. Next to Text, select one of the standard messages, or select Custom and type a new message in
the box.

6. Select options for the remaining settings.

Print multiple pages on one sheet of paper in Macintosh
You can print more than one page on a single sheet of paper. This feature provides a cost-effective way
to print draft pages.

1. On the File menu, click Print.

2. Select the driver.

3. Open the Layout menu.

4. Next to Pages per Sheet, select the number of pages that you want to print on each sheet (1, 2,
4, 6, 9, or 16).

5. Next to Layout Direction, select the order and placement of the pages on the sheet.

6. Next to Borders, select the type of border to print around each page on the sheet.
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Print on both sides of the page (duplex printing)

Use automatic duplex printing

1. Insert enough paper into one of the trays to accommodate the print job. If you are loading special
paper such as letterhead, load it in one of the following ways:

● For tray 1, load the letterhead paper face-up with the bottom edge feeding into the printer first.

● For all other trays, load the letterhead paper face-down with the top edge at the back of the
tray.

2. On the File menu, click Print.

3. Open the Layout menu.

4. Next to Two-Sided, select either Long-Edge Binding or Short-Edge Binding.

5. Click Print.

Print on both sides manually

1. Insert enough paper into one of the trays to accommodate the print job. If you are loading special
paper such as letterhead, load it in one of the following ways:

● For tray 1, load the letterhead paper face-up with the bottom edge feeding into the printer first.

● For all other trays, load the letterhead paper face-down with the top edge at the back of the
tray.

CAUTION: To avoid jams, do not load paper that is heavier than 105 g/m2 (28-lb bond).

2. On the File menu, click Print.

3. On the Finishing menu, select Manually Print on 2nd Side.

4. Click Print. Follow the instructions in the pop-up window that appears on the computer screen
before replacing the output stack in tray 1 for printing the second half.

5. Go to the printer, and remove any blank paper that is in tray 1.

6. Insert the printed stack face-up with the bottom edge feeding into the printer first in tray 1. You
must print the second side from tray 1.

7. If prompted, press the appropriate control-panel button to continue.

Set the stapling options
If a finishing device that has a stapler is installed, you can staple documents.

1. On the File menu, click Print.

2. Open the Finishing menu.

3. In the Stapling Options drop-down list, select the stapling option that you want to use.
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Store jobs
You can store jobs on the product so you can print them at any time. You can share stored jobs with
other users, or you can make them private.

1. On the File menu, click Print.

2. Open the Job Storage menu.

3. In the Job Storage: drop-down list, select the type of stored job.

4. For the Stored Job, Private Job, and Private Stored Job types of stored jobs, enter a name for
the stored job in the box next to Job Name:.

Select which option to use if another stored job already has that name.

● Use Job Name + (1 - 99) appends a unique number to the end of the job name.

● Replace Existing File overwrites the existing stored job with the new one.

5. If you selected Stored Job or Private Job in step 3, type a 4-digit number in the box next to PIN
To Print (0000 - 9999). When other people attempt to print this job, the product prompts them to
enter this PIN number.

Use the Services menu
If the product is connected to a network, use the Services menu to obtain product and supply-status
information.

1. On the File menu, click Print.

2. Open the Services menu.

3. To open the embedded Web server and perform a maintenance task, do the following:

a. Select Device Maintenance.

b. Select a task from the drop-down list.

c. Click Launch.

4. To go to various support Web sites for this device, do the following:

a. Select Services on the Web.

b. Select Internet Services, and select an option from the drop-down list.

c. Click Go!.
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5 Connectivity

● USB connection

● Auxiliary connection

● Network configuration
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USB connection
This MFP supports a Type B Hi-speed USB 2.0 connection for printing.

Figure 5-1  USB connection
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Auxiliary connection
This MFP supports an auxiliary connection for paper handling output devices. The port is located on the
back of the MFP.

Figure 5-2  Auxiliary connection

1 Auxiliary connection port (Jetlink)
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Network configuration
You might need to configure certain network parameters on the device. You can configure these
parameters in the following locations:

● Installation software

● Device control panel

● Embedded Web server

● Management software (HP Web Jetadmin or HP LaserJet Utility for Macintosh)

NOTE: For more information about using the embedded Web server, see Embedded Web server
on page 148

For more information on supported networks and network configuration tools, see the HP Jetdirect Print
Server Administrator’s Guide. The guide comes with printers in which an HP Jetdirect print server is
installed.

This section contains the following information about configuring network parameters:

● Configure TCP/IPv4 parameters

● Configure TCP/IPv6 parameters

● Disable network protocols (optional)

● HP Jetdirect EIO print servers

Configure TCP/IPv4 parameters
If your network doesn't provide automatic IP addressing through DHCP, BOOTP, RARP, or another
method, you might need to enter the following parameters manually before you can print over the
network:

● IP address (4 bytes)

● Subnet mask (4 bytes)

● Default gateway (4 bytes)

Change the IP address
You can view the current IP address of the device from the control-panel Home screen by touching
Network Address.

Use the following procedure to change the IP address manually.

1. Scroll to and touch Administration.

2. Scroll to and touch Initial Setup.

3. Touch Networking and I/O.

4. Touch Embedded Jetdirect.

5. Touch TCP/IP.
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6. Touch IPV4 Settings.

7. Touch Config Method.

8. Touch Manual.

9. Touch Save.

10. Touch Manual Settings.

11. Touch IP Address.

12. Touch the IP Address text box.

13. Use the touchscreen keypad to type the IP address.

14. Touch OK.

15. Touch Save.

Set the subnet mask
1. Scroll to and touch Administration.

2. Scroll to and touch Initial Setup.

3. Touch Networking and I/O.

4. Touch Embedded Jetdirect.

5. Touch TCP/IP.

6. Touch IPV4 Settings.

7. Touch Config Method.

8. Touch Manual.

9. Touch Save.

10. Touch Manual Settings.

11. Touch Subnet Mask.

12. Touch the Subnet Mask text box.

13. Use the touchscreen keypad to type the subnet mask.

14. Touch OK.

15. Touch Save.

Set the default gateway
1. Scroll to and touch Administration.

2. Scroll to and touch Initial Setup.

3. Touch Networking and I/O.

4. Touch Embedded Jetdirect.
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5. Touch TCP/IP.

6. Touch IPV4 Settings.

7. Touch Config Method.

8. Touch Manual.

9. Touch Save.

10. Touch Manual Settings.

11. Touch Default Gateway.

12. Touch the Default Gateway text box.

13. Use the touchscreen keyboard to type the default gateway.

14. Touch OK.

15. Touch Save.

Configure TCP/IPv6 parameters
For information about configuring the device for a TCP/IPv6 network, see the HP Jetdirect Print Server
Administrator's Guide.

Disable network protocols (optional)
By factory default, all supported network protocols are enabled. Disabling unused protocols has the
following benefits:

● It decreases device-generated network traffic.

● It prevents unauthorized users from printing to the device.

● It provides only pertinent information on the configuration page.

● It allows the device control panel to display protocol-specific error and warning messages.

Disable IPX/SPX
NOTE: Do not disable this protocol in Windows-based systems that print to the printer through IPX/
SPX.

1. Scroll to and touch Administration.

2. Scroll to and touch Initial Setup.

3. Touch Networking and I/O.

4. Touch Embedded Jetdirect.

5. Touch IPX/SPX.

6. Touch Enable.

7. Touch Off.

8. Touch Save.
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Disable AppleTalk
1. Scroll to and touch Administration.

2. Scroll to and touch Initial Setup.

3. Touch Networking and I/O.

4. Touch Embedded Jetdirect.

5. Touch AppleTalk.

6. Touch Enable.

7. Touch Off.

8. Touch Save.

Disable DLC/LLC
1. Scroll to and touch Administration.

2. Scroll to and touch Initial Setup.

3. Touch Networking and I/O.

4. Touch Embedded Jetdirect.

5. Touch DLC/LLC.

6. Touch Enable.

7. Touch Off.

8. Touch Save.

HP Jetdirect EIO print servers
HP Jetdirect print servers (network cards) can be installed in the EIO slot. Supported networking features
depend on the print server model. For available HP Jetdirect EIO print server models, go to
http://www.hp.com/go/jetdirect.

NOTE: Configure the card through the control panel, the printer installation software, or HP Web
Jetadmin. Refer to the HP Jetdirect print server documentation for more information.
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6 Paper and print media

● Understand paper and print media use

● Supported paper and print media sizes

● Custom paper sizes

● Special paper or print media guidelines

● Load paper and print media

● Configure trays

● Select the output bin
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Understand paper and print media use
This product supports a variety of paper and other print media in accordance with the guidelines in this
user guide. Paper or print media that does not meet these guidelines might cause the following problems:

● Poor print quality

● Increased jams

● Premature wear on the product, requiring repair

For best results, use only HP-brand paper and print media designed for laserjets or multiuse. Do not
use paper or print media made for inkjet printers. Hewlett-Packard Company cannot recommend the
use of other brands of media because HP cannot control their quality.

It is possible for paper to meet all of the guidelines in this user guide and still not produce satisfactory
results. This might be the result of improper handling, unacceptable temperature and/or humidity levels,
or other variables over which Hewlett-Packard has no control.

CAUTION: Using paper or print media that does not meet Hewlett-Packard's specifications might
cause problems for the product, requiring repair. This repair is not covered by the Hewlett-Packard
warranty or service agreements.
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Supported paper and print media sizes
This product supports a number of paper sizes, and it adapts to various media.

NOTE: To obtain best print results, select the appropriate paper size and type in your print driver before
printing.

Table 6-1  Supported paper and print media sizes

Size Dimensions Tray 1, Letter
R, A4

Trays 2 and 3,
Letter R, A4

Tray 4, Letter
R, A4

Stapler /
Stacker lower
bin

Letter 216 x 279 mm (8.5 x 11 in.)

Legal 216 x 356 mm (8.5 x 14 in.)

A4 210 x 297 mm (8.27 x 11.69 in.)

Executive 184 x 267 mm (7.24 x 10.51 in.)

Executive
(JIS)

216 x 330 mm (8.5 x 13 in.)     

A3 297 x 420 mm (11.69 x 16.54 in.)  

A5 148 x 210 mm (5.83 x 8.27 in.)  

A6 105 x 148 mm (4.13 x 5.83 in.)     

Statement 140 x 216 mm (5.5 x 8.5 in.)     

11 x 17 279 x 432 mm (11 x 17 in.)

12 x 18 305 x 457 mm (12 x 18 in.)     

B4 (JIS) 257 x 364 mm (10.12 x 14.33 in.)

RA3 305 x 430 mm (12.01 x 16.93 in.)     

B5 (JIS) 182 x 257 mm (7.17 x 10.12 in.)

8k 270 x390 mm (10.63 x 15.35 in.)    

16k 197 x 273 mm (7.75 x 10.75 in.)    

Table 6-2  Supported envelopes and postcards

Size Dimensions Tray 1, mailbox,
stacker

Trays 2, 3, 4 Stapler

Envelope #10 105 x 241 mm (4.13 x 9.49 in.)   

Envelope DL 110 x 220 mm (4.33 x 8.66 in.)   

Envelope C5 162 x 229 mm (6.93 x 9.84 in.)   

Envelope B5 176 x 250 mm (6.7 x 9.8 in.)   

Envelope
Monarch

98 x 191 mm (3.9 x 7.5 in.)   

Post Card 100 x 148 mm (3.94 x 5.83 in.)   
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Size Dimensions Tray 1, mailbox,
stacker

Trays 2, 3, 4 Stapler

Double Post
Card

148 x 200 mm (5.83 x 7.87 in.)   

Postcard (US) 88.9 x 139.7 mm (3.5 x 5.5 in.)   

Postcard
(European)

105 x 148 mm (4.13 x 5.83 in.)   

Table 6-2  Supported envelopes and postcards (continued)
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Custom paper sizes
This product supports a variety of custom paper sizes. Supported custom sizes are sizes that are within
the minimum- and maximum-size guidelines for the product but are not listed in the supported paper
sizes table. When using a supported custom size, specify the custom size in the print driver, and load
the paper in a tray that supports custom sizes.
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Special paper or print media guidelines
This product supports printing on special media. Use the following guidelines to obtain satisfactory
results. When using special paper or print media, be sure to set the type and size in your print driver to
obtain the best print results.

CAUTION: HP LaserJet printers use fusers to bond dry toner particles to the paper in very precise
dots. HP laser paper is designed to withstand this extreme heat. Using inkjet paper not designed for this
technology could damage your printer.

Media type Do Do not

Envelopes ● Store envelopes flat.

● Use envelopes where the seam
extends all the way to the corner of
the envelope.

● Use peel-off adhesive strips that
are approved for use in laser
printers.

● Do not use envelopes that are
wrinkled, nicked, stuck together, or
otherwise damaged.

● Do not use envelopes that have
clasps, snaps, windows, or coated
linings.

● Do not use self-stick adhesives or
other synthetic materials.

Labels ● Use only labels that have no
exposed backing between them.

● Use Labels that lie flat.

● Use only full sheets of labels.

● Do not use labels that have wrinkles
or bubbles, or are damaged.

● Do not print partial sheets of labels.

Transparencies ● Use only transparencies that are
approved for use in laser printers.

● Place transparencies on a flat
surface after removing them from
the product.

● Do not use transparent print media
not approved for laser printers.

Letterhead or preprinted forms ● Use only letterhead or forms
approved for use in laser printers.

● Do not use raised or metallic
letterhead.

Heavy paper ● Use only heavy paper that is
approved for use in laser printers
and meets the weight specifications
for this product.

● Do not use paper that is heavier
than the recommended media
specification for this product unless
it is HP paper that has been
approved for use in this product.

Glossy or coated paper ● Use only glossy or coated paper
that is approved for use in laser
printers.

● Do not use glossy or coated paper
designed for use in inkjet products.
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Load paper and print media
This section contains information about loading standard- and custom-size media into the four input
trays.

CAUTION: To avoid a jam, never add or remove paper from tray 1 or open tray 2, tray 3, or tray 4
while printing or copying from that tray. To avoid damaging the MFP, print labels, envelopes, and
transparencies from tray 1 only. Send labels, envelopes, and transparencies to the upper bin. Print on
only one side of labels, envelopes, and transparencies.

Load tray 1
Tray 1 holds up to 100 sheets of paper or 10 envelopes. For more information about supported media,
see Supported paper and print media sizes on page 77.

1. Open tray 1.

Figure 6-1  Load tray 1 (1 of 3)

2. Load paper according to size and finishing options.

Figure 6-2  Load tray 1 (2 of 3)

CAUTION: To avoid jams, print sheets of labels one sheet at a time.

3. Adjust the paper guides so they lightly touch the paper stack, but do not bend the paper.

Figure 6-3  Load tray 1 (3 of 3)

4. Make sure the paper fits under the tabs on the guides and not above the load level indicators.
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NOTE: If printing on A3- or 11 x 17-size paper, or other long media, also pull out the tray extension
until it stops.

Load trays 2, 3, and 4
Trays 2 and 3 hold up to 500 sheets of standard media. Tray 4 holds up to 2,000 sheets of standard
media. For information about paper specifications, see Supported paper and print media sizes
on page 77.

Load detectable standard-size paper in trays 2, 3, and 4

Follow this procedure to load detectable standard-size paper in the tray. The following are the detectable
sizes, which are marked inside the tray:

● A4

● Letter

● A3

● Legal

● Executive

● 11 x 17

● B4 (JIS)

● B5 (JIS)

● A4-Rotated

● Letter-Rotated

CAUTION: To avoid a jam, never add or remove paper from a tray while printing from that tray.

1. Open the tray until it stops.

Figure 6-4  Load trays 2, 3, and 4 (1 of 6)
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2. Adjust the left (Y) paper guide by pressing the tab on the guide and set the guide to the correct
paper size.

Figure 6-5  Load trays 2, 3, and 4 (2 of 6)

3. Adjust the front (X) paper guide by pressing the tab on the guide and set the guide to the correct
paper size.

Figure 6-6  Load trays 2, 3, and 4 (3 of 6)

4. Load (orient) the paper according to size.

Figure 6-7  Load trays 2, 3, and 4 (4 of 6)

5. Set the Custom/Standard switch to Standard.

Figure 6-8  Load trays 2, 3, and 4 (5 of 6)
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6. Close the tray. The MFP control panel might show the tray media type and size. If the configuration
is not correct, touch Modify on the control panel. If the configuration is correct, touch OK.

Figure 6-9  Load trays 2, 3, and 4 (6 of 6)

Load undetectable standard-size paper in trays 2, 3, and 4

Follow this procedure to load undetectable standard-size paper in the tray. The following are the
undetectable sizes:

● 8K

● 16K

● Statement

● JIS Executive

● 8.5 x 13 (216 x 330 mm).

CAUTION: To avoid a jam, never add or remove paper from a tray while printing from that tray.

1. Open the tray until it stops.

Figure 6-10  Load undetectable standard-size paper in trays 2, 3, and 4 (1 of 6)

2. Press the tab on the front paper guide and slide the guide all the way out.

3. Press the tab on the left paper guide and slide the guide all the way out.

4. Load (orient) the paper according to size.

Figure 6-11  Load undetectable standard-size paper in trays 2, 3, and 4 (2 of 6)
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5. Adjust the left paper guide by pressing the tab on the guide and slide the guide until it gently touches
the paper

Figure 6-12  Load undetectable standard-size paper in trays 2, 3, and 4 (3 of 6)

6. Adjust the front paper guide by pressing the tab on the guide and slide the guide until it gently
touches the paper.

Figure 6-13  Load undetectable standard-size paper in trays 2, 3, and 4 (4 of 6)

NOTE: When loading tray 4, make sure that the paper guide lock is in the up position.

7. Set the Custom/Standard switch to Custom.

Figure 6-14  Load undetectable standard-size paper in trays 2, 3, and 4 (5 of 6)

8. Close the tray. The MFP control panel might show the tray media type and size. If the configuration
is not correct, touch Modify on the control panel. If the configuration is correct, touch OK.

Figure 6-15  Load undetectable standard-size paper in trays 2, 3, and 4 (6 of 6)

Load custom media in trays 2, 3, and 4 

Use the following procedure to load custom-size paper in the tray.
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CAUTION: To avoid a jam, never add or remove paper from a tray while printing from that tray.

1. Open the tray until it stops.

Figure 6-16  Load custom media in trays 2, 3, and 4 (1 of 6)

2. Press the tab on the front (X) paper guide and slide the guide all the way out.

3. Press the tab on the left (Y) paper guide and slide the guide all the way out.

4. Load (orient) the paper according to size.

Figure 6-17  Load custom media in trays 2, 3, and 4 (2 of 6)

5. Set the Custom/Standard switch to Custom.

Figure 6-18  Load custom media in trays 2, 3, and 4 (3 of 6)

6. Adjust the left (Y) paper guide by pressing the tab on the guide and slide the guide until it gently
touches the paper

Figure 6-19  Load custom media in trays 2, 3, and 4 (4 of 6)
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7. Adjust the front (X) paper guide by pressing the tab on the guide and slide the guide until it gently
touches the paper.

Figure 6-20  Load custom media in trays 2, 3, and 4 (5 of 6)

8. Note the orientation of the paper, as well as the value of the X dimension and the Y dimension.
The X and Y dimensions are marked in the tray. You will need this information for a later step.

NOTE: When loading tray 4, make sure that the paper guide lock is in the up position.

9. Close the tray. The MFP control panel might show the tray media type and size. If the configuration
is not correct, touch Modify on the control panel. If the configuration is correct, touch OK.

Figure 6-21  Load custom media in trays 2, 3, and 4 (6 of 6)
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Configure trays
The MFP might automatically prompt you to configure a tray for type and size when you load media into
the tray.

The following message appears on the control panel: Tray <X> [type] [size] To change size or type,
touch “Modify”. To accept, touch “OK”..

NOTE: The prompt does not appear if you are printing from tray 1 and tray 1 is configured for Any
Size and Any Type.

NOTE: If you have used other HP LaserJet printer models, you might be accustomed to configuring
tray 1 to First mode or Cassette mode. On the HP LaserJet M9059 MFP, setting tray 1 size and type
to Any Size is equivalent to First mode. Setting size or type for tray 1 to a setting other than Any
Size is equivalent to Cassette mode.

Configure a tray when loading media
1. Load media in the tray. Close the tray if you are using tray 2, 3, or 4.

2. If the tray configuration message appears, touch OK to accept the detected size, or touch Modify
to choose a different paper size.

3. If modifying the tray configuration, select the size.

NOTE: The MFP automatically detects most media sizes in trays 2, 3, and 4.

4. If modifying the tray configuration, select the paper type.

5. Touch Exit.

Configure a tray by using the Supplies Status button on the touchscreen
You can also configure the trays for type and size without a prompt from the MFP.

1. Scroll to and touch Supplies Status.

2. Touch the desired tray.

3. Touch Modify.

4. Select the size and type. If you select a custom type, use the numeric keypad to set the X dimension
and the Y dimension, and then touch OK.

5. Touch OK.

6. Touch OK again.

Select the media by source, type, or size
In the Microsoft Windows operating system, three settings affect how the printer driver tries to pull media
when you send a print job. Source, Type, and Size settings appear in the Page Setup, Print, or Print
Properties dialog boxes in most software programs. Unless you change these settings, the MFP
automatically selects a tray using the default settings.
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Source
To print by Source select a specific tray from MFP to pull from. The MFP tries to print from this tray, no
matter what type or size is loaded. If you select a tray that is configured for a type or size that does not
match your print job, the MFP does not print automatically. Instead, it waits for you to load the tray with
the type or size of print media for your print job. If you load the tray, the MFP begins printing.

Type and Size
Printing by Type or Size means that you want the MFP to pull from the tray that is loaded with the correct
type and size of media. Selecting media by type rather than source is similar to locking out trays and
helps protect special media from accidental use. For example, if a tray is configured for letterhead and
you select plain paper, the MFP will not pull the letterhead from that tray. Instead, it will pull from a tray
that has plain paper loaded and is configured for plain paper on the MFP control panel. Selecting media
by Type and Size results in significantly better print quality for heavy paper, glossy paper, and
transparencies. Using the wrong setting might result in unsatisfactory print quality. Always print by Type
for special print media, such as labels or transparencies. Print by Size for envelopes, if possible.

● To print by Type or Size, select the Type or Size from the Page Setup dialog box, the Print dialog
box, or the Print Properties dialog box, depending on the software program.

● If you often print on a certain type or size of media, configure a tray for that type or size. Then,
when you select that type or size as you print a job, the MFP pulls media from the tray that is
configured for that type or size.
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Select the output bin
The MFP has at least two output bin locations: the ADF output bin (1) and an output bin on the output
device.

Figure 6-22  Output bins

It is recommended that you select an output location through the software program or printer driver.

Stacker or stapler/stacker output bins

If you choose the 3,000-sheet stacker or 3,000-sheet stapler/stacker, the output bins are the upper bin
(2) (face up) and the lower bin (3) (face down).

The upper bin (face-up) (2) is the top bin on the stacker or stapler/stacker. This bin holds up to 100
sheets of paper in face-up order as they exit the MFP. A sensor causes the product to stop when the
bin is full. Product operation continues when you empty or reduce the amount of paper in the bin.

The lower bin (face-down) (3) is the lower bin on the stacker or stapler/stacker. This bin holds up to
3,000 sheets of paper and allows you to stack or staple jobs. This bin is the default output bin.

8-bin mailbox output bins

If you choose the 8-bin mailbox, the output bins are the upper bin and the eight face-down bins.

The upper bin (4) holds up to 125 sheets of paper.

The network administrator can assign the eight bins (5) to individual users or workgroups. Each bin can
stack up to 250 sheets of paper.

Multifunction finisher output bins

If you choose the multifunction finisher, the output bins are the upper bin ( 6) and the lower booklet bin
(7).

The upper bin (6) is the top bin on the multifunction finisher. This bin provides 1,000 sheets of stacking
capacity and can offset each job as it is stacked, delivering unstapled jobs face up or face down. This
bin also provides stapling for up to 50 sheets of paper per document. The upper bin is the default output
bin when the multifunction finisher is attached.

The lower booklet bin (7) is the lower bin on the multifunction finisher. This bin provides folding and
saddle stitching of booklets for up to 10 sheets of paper.
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Select an output location

Printing
It is recommended that you select an output location (bin) through your program or driver. Where and
how you make selections depends on your program or driver, set the default output location from the
MFP control panel.

1. Scroll to and touch Administration.

2. Touch Default Job Options.

3. Touch Default Print Options.

4. Touch Output Bin.

5. Touch the desired output bin.

Copying
You can set and override the current default output location (bin) from the MFP control panel for copy
jobs:

1. Scroll to and touch Copy.

2. Touch More Options.

3. Touch Output Bin.

4. Touch the desired output bin.

To set the default output bin for copy jobs:

1. Scroll to and touch Administration.

2. Touch Default Job Options.

3. Touch Default Copy Options.

4. Touch Output Bin.

5. Touch the desired output bin.
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7 Print tasks

● Media type and tray loading

● Use features in the Windows printer driver

● Staple documents

● Cancel a print job

● Print on envelopes

● Job storage features for print
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Media type and tray loading
Minimum media dimensions are 98 x 191 mm (3.8 x 7.5 inches).

Maximum media dimensions are 312 x 470 mm (12.3 x 18.5 inches).

Table 7-1  Tray 1 media information

Media type Media specifications Media quantity Driver settings Paper orientation

Paper and cardstock,
standard sizes

64 g/m2 (17 lb) bond to
216 g/m2 (58 lb) bond

Two-sided printing: 64
g/m2 (17 lb) bond to 199
g/m2 (53 lb) bond

Maximum stack height:
10 mm (0.6 inch)

Equivalent to 100
sheets of 75 g/m2 (20
lb) bond.

Plain or unspecified N/A

Envelopes 64 g/m2 (17 lb) bond to
216 g/m2 (58 lb) bond

Up to 10 envelopes Envelope Short edge leading,
flap on right side facing
up

Labels 64 g/m2 (17 lb) bond to
216 g/m2 (58 lb) bond

Maximum stack height:
10 mm (0.6 inch)

Labels Side to be printed on
facing up

Transparencies 64 g/m2 (17 lb) bond to
216 g/m2 (58 lb) bond

Maximum stack height:
10 mm (0.6 inch)

Transparencies Side to be printed on
facing up

Heavy 64 g/m2 (17 lb) bond to
216 g/m2 (58 lb) bond

Two-sided printing: 64
g/m2 (17 lb) bond to 199
g/m2 (53 lb) bond

Maximum stack height:
10 mm (0.6 in.)

Light glossy, glossy, or
heavy glossy

Side to be printed on
facing up

Glossy 64 g/m2 (17 lb) bond to
216 g/m2 (58 lb) bond

Two-sided printing: 64
g/m2 (17 lb) bond to 199
g/m2 (53 lb) bond

Maximum stack height:
10 mm (0.6 in.)

Light glossy, glossy, or
heavy glossy

Side to be printed on
facing up

Table 7-2  Tray 2 and 3 media information

Media type Media specifications Media quantity Driver settings Paper orientation

Paper and cardstock 64 g/m2 (17 lb) bond to
199 g/m2 (53 lb) bond

Up to 500 sheets Plain or unspecified

Light glossy, glossy, or
heavy glossy

N/A

Heavy 64 g/m2 (17 lb) bond to
199 g/m2 (53 lb) bond

Up to 500 sheets Light glossy, glossy, or
heavy glossy

Side to be printed on
facing up

Glossy 64 g/m2 (17 lb) bond to
199 g/m2 (53 lb) bond

Up to 500 sheets Light glossy, glossy, or
heavy glossy

Side to be printed on
facing up

Table 7-3  Tray 4 media information

Media type Media specifications Media quantity Driver settings Paper orientation

Paper and cardstock 64 g/m2 (17 lb) bond to
199 g/m2 (53 lb) bond

Up to 2000 sheets Plain or unspecified N/A
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Media type Media specifications Media quantity Driver settings Paper orientation

Heavy 64 g/m2 (17 lb) bond to
199 g/m2 (53 lb) bond

Up to 2000 sheets Light glossy, glossy, or
heavy glossy

Side to be printed on
facing up

Glossy 64 g/m2 (17 lb) bond to
199 g/m2 (53 lb) bond

Up to 2000 sheets Light glossy, glossy, or
heavy glossy

Side to be printed on
facing up

Table 7-3  Tray 4 media information (continued)
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Use features in the Windows printer driver
Open the printer driver

How do I Steps to perform

Open the printer driver On the File menu in the software program, click Print. Select
the printer, and then click Properties or Preferences.

Get help for any printing option Click the ? symbol in the upper-right corner of the printer driver,
and then click any item in the printer driver. A pop-up message
displays that provides information about the item. Or, click
Help to open the online Help.

Use printing shortcuts
To perform the following tasks, open the printer driver and click the Printing Shortcuts tab.

NOTE: In previous HP printer drivers, this feature was called Quick Sets.

How do I Steps to perform

Use a printing shortcut Select one of the shortcuts, and then click OK to print the job
with the predefined settings.

Create a custom printing shortcut a) Select an existing shortcut as a base. b) Select the print
options for the new shortcut. c) Click Save As, type a name for
the shortcut, and click OK.

Set paper and quality options
To perform the following tasks, open the printer driver and click the Paper/Quality tab.

How do I Steps to perform

Select a page size Select a size from the Paper size drop-down list.

Select a custom page size a) Click Custom. The Custom Paper Size dialog box opens.
b) Type a name for the custom size, specify the dimensions,
and click OK.

Select a paper source Select a tray from the Paper source drop-down list.

Select a paper type Select a type from the Paper type drop-down list.

Print covers on different paper

Print the first or last page on different paper

a) In the Special pages area, click Covers or Print pages on
different paper, and then click Settings. b) Select an option
to print a blank or preprinted front cover, back cover, or both.
Or, select an option to print the first or last page on different
paper. c) Select options from the Paper source and Paper
type drop-down lists, and then click Add. d) Click OK.

Adjust the resolution of printed images In the Print Quality area, select an option from the first drop
down list. See the printer-driver online Help for information
about each of the available options.

Select draft-quality printing In the Print Quality area, click EconoMode.
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Set document effects
To perform the following tasks, open the printer driver and click the Effects tab.

How do I Steps to perform

Scale a page to fit on a selected paper size Click Print document on, and then select a size from the drop-
down list.

Scale a page to be a percent of the actual size Click % of actual size, and then type the percent or adjust the
slider bar.

Print a watermark a) Select a watermark from the Watermarks drop-down list.
b) To print the watermark on the first page only, click First page
only. Otherwise, the watermark is printed on each page.

Add or edit watermarks

NOTE: The printer driver must be stored on your computer
for this to work.

a) In the Watermarks area, click Edit. The Watermark
Details dialog box opens. b) Specify the settings for the
watermark, and then click OK.

Set document finishing options
To perform the following tasks, open the printer driver and click the Finishing tab.

How do I Steps to perform

Print on both sides (Duplex) Click Print on both sides. If you will bind the document along
the top edge, click Flip pages up.

Print a booklet a) Click Print on both sides. b) In the Booklet layout drop-
down list, click Left binding or Right binding. The Pages per
sheet option automatically changes to 2 pages per sheet.

Print multiple pages per sheet a) Select the number of pages per sheet from the Pages per
sheet drop-down list. b) Select the correct options for Print
page borders, Page order, and Orientation.

Select page orientation a) In the Orientation area, click Portrait or Landscape. b) To
print the page image upside down, click Rotate by 180
degrees.

Set product output options
To perform the following tasks, open the printer driver and click the Output tab.

NOTE: The options that are available on this tab depend on the finishing device that you are using.

How do I Steps to perform

Select staple options Select a stapling option from the Staple drop-down list.

Print a separator page between copies a) Click Job Separator. The Separator Page Details dialog
box opens. b) In the Separator Page Details drop-down list,
click Separator page, and then select a paper source and a
paper type. c) To print job-related data on the separator page,
click any or all of the check boxes. Click OK.

Select an output bin Select an output bin from the Bin drop-down list.
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Set job storage options
To perform the following tasks, open the printer driver and click the Job Storage tab.

How do I Steps to perform

Print one copy for proof before printing all the copies In the Job Storage Mode area, click Proof and Hold. The
product prints the first copy only. A message appears on the
product control panel that prompts you to print the rest of the
copies.

Temporarily store a private job on the product and print it later a) In the Job Storage Mode area, click Personal Job. b) In
the Make Job Private area, enter a 4-digit personal
identification number (PIN).

Temporarily store a job on the product

NOTE: These jobs are deleted if the product is turned off.

In the Job Storage Mode area, click Quick Copy. One copy
of the job is printed immediately, but you can print more copies
from the product control panel.

Permanently store a job on the product In the Job Storage Mode area, click Stored Job.

Make a permanently stored job private so that anyone who
tries to print it must provide a PIN

a) In the Job Storage Mode area, click Stored Job. b) In the
Make Job Private area, click PIN to print, and then enter a 4-
digit personal identification number (PIN).

Receive notification when someone prints a stored job In the Job Notification Options area, click Display Job ID
when printing.

Set the user name for a stored job In the User Name area, click User name to use the Windows
default user name. To provide a different user name, click
Custom and type the name.

Specify a name for the stored job a) In the Job Name area, click Automatic to use the default
job name. To specify a job name, click Custom and type the
name. b) Select an option from the If job name exists drop-
down list. Select Use Job Name + (1-99) to add a number to
the end of the existing name, or select Replace Existing
File to overwrite a job that already has that name.

Obtain support and product-status information
To perform the following tasks, open the printer driver and click the Services tab.

How do I Steps to perform

Obtain support information for the product In the Internet Services drop-down list, select a support
option, and click Go!

Check the status of the product, including the level of supplies Click the Device and Supplies Status icon. The Device
Status page of the HP embedded Web server opens.

Set advanced printing options
To perform the following tasks, open the printer driver and click the Advanced tab.

How do I Steps to perform

Select advanced printing options In any of the sections, click a current setting to activate a drop-
down list so you can change the setting.
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How do I Steps to perform

Change the number of copies that are printed

NOTE: If the software program that you are using does not
provide a way to print a particular number of copies, you can
change the number of copies in the driver.

Changing this setting affects the number of copies for all print
jobs. After your job has printed, restore this setting to the
original value.

Open the Paper/Output section, and then enter the number of
copies to print. If you select 2 or more copies, you can select
the option to collate the pages.

Print colored text as black rather than as shades of gray a) Open the Document Options section, and then open the
Printer Features section. b) In the Print All Text as Black
drop-down list, select Enabled.

Load letterhead or preprinted paper the same way for every
job, whether printing on one or both sides of the page

a) Open the Document Options section, and then open the
Printer Features section. b) In the Alternative Letterhead
Mode drop-down list, select On. c) At the product, load the
paper the same way you would for printing on both sides.

Change the order in which pages are printed a) Open the Document Options section, and then open the
Layout Options section. b) In the Page Order drop-down list,
select Front to Back to print the pages in the same order as
they are in the document, or select Back to Front to print the
pages in the reverse order.
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Staple documents
NOTE: Stapling features are only available if the stapler/stacker or multifunction finisher are attached
to the MFP.

Set the stapler at the control panel for printed jobs
You can usually select the stapler in your software program or printer driver, although some options
might be available only in the printer driver. See Change printer-driver settings for Windows
on page 53 for more information. Where and how you make selections depends on your program or
driver. If the stapler cannot be selected in the program or printer driver, it can be selected using the MFP
control panel.

1. Scroll to and touch Administration.

2. Scroll to and touch Device Behavior.

3. Scroll to and touch Stapler/Stacker or Multifunct. Finisher.

4. Touch Staple.

5. Touch the staple option you want to use.

NOTE: Selecting the stapler at the printer control panel changes the default setting to Staple. It is
possible that all print jobs will be stapled. However, settings that are changed in the printer driver override
settings that are changed at the control panel.

Set the stapler at the control panel for all copy jobs
NOTE: The following procedure changes the default setting for all copy jobs.

1. Scroll to and touch Administration.

2. Touch Default Job Options.

3. Touch Default Copy Options.

4. Touch Staple/Collate.

5. Touch Staple.

6. Touch the staple option you want to use.

Set the stapler at the control panel for a single copy job
NOTE: The following procedure sets the stapling option for only the current copy job.

1. Touch Copy.

2. Touch Staple/Collate.

3. Touch the staple option you want to use.
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Configure the device to stop or continue when the staple cartridge is empty
You can specify whether the MFP stops printing when the staple cartridge is empty or if it continues
printing but does not staple the jobs.

1. Scroll to and touch Administration.

2. Scroll to and touch Device Behavior.

3. Scroll to and touch Stapler/Stacker or Multifunct. Finisher.

4. Touch Staples Out.

5. Touch the option that you want to use:

● Select Stop to stop all printing until the staple cartridge is replaced.

● Select Continue to continue printing jobs without stapling them.

Load staples
Load staples if the MFP control-panel display prompts you with a Stapler Low On Staples or Order
staple cartridge message (the stapler has fewer than 20 usable staples left), or when it prompts you
with a Replace Stapler Cartridge or STAPLER OUT OF STAPLES message (the stapler is empty, or
the remaining staples cannot be used).

The stapler accepts print jobs if it is out of staples, but it does not staple the pages. The printer driver
can be configured to disable the staple option when the stapler cartridge is empty.

Load staples in the stapler/stacker

1. Move the stapler/stacker away from the MFP.

Figure 7-1  Load staples in the stapler/stacker (1 of 5)

2. Open the stapler unit door.

Figure 7-2  Load staples in the stapler/stacker (2 of 5)
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3. On the empty staple cartridge, pull up on the green tab, and then pull the empty cartridge out.

Figure 7-3  Load staples in the stapler/stacker (3 of 5)

4. Insert the new staple cartridge, and push down on the green tab so that the cartridge locks into
place.

Figure 7-4  Load staples in the stapler/stacker (4 of 5)

5. Close the stapler unit door and push the stapler/stacker back into place.

Figure 7-5  Load staples in the stapler/stacker (5 of 5)

Load staples in the multifunction finisher

1. Open the stapler unit door.

Figure 7-6  Load staples in the multifunction finisher (1 of 8)
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2. Slide the stapler unit toward you.

Figure 7-7  Load staples in the multifunction finisher (2 of 8)

3. Turn the large green knob until the blue dot appears in the window of the stapler unit.

Figure 7-8  Load staples in the multifunction finisher (3 of 8)

4. Turn the small green knob at the top of the stapler unit clockwise until the staple cartridge moves
to the left of the stapler unit.

Figure 7-9  Load staples in the multifunction finisher (4 of 8)

CAUTION: The blue dot must appear in the window of the stapler unit before you remove the
staple cartridge. If you try to remove the staple cartridge before the blue dot appears in the window,
you could damage the finisher.

5. On the empty staple cartridge, squeeze the tabs together and pull the empty cartridge out.

Figure 7-10  Load staples in the multifunction finisher (5 of 8)
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6. Insert the new staple cartridge so that it locks into place.

Figure 7-11  Load staples in the multifunction finisher (6 of 8)

7. Slide the stapler unit into the finisher.

Figure 7-12  Load staples in the multifunction finisher (7 of 8)

8. Close the stapler unit door and realign the multifunction finisher against the MFP.

Figure 7-13  Load staples in the multifunction finisher (8 of 8)
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Cancel a print job
You can stop a print request by using the control panel or by using the software program. For instructions
about how to stop a print request from a computer on a network, see the online Help for the specific
network software.

NOTE: It can take some time for all printing to clear after you have canceled a print job.

Stop the current print job from the control panel
1. Press Stop on the control panel.

2. On the touchscreen, on the Device Has Been Paused screen, touch Cancel current job.

NOTE: If the print job is too far into the printing process, you might not have the option to cancel
it.

Stop the current print job from the software program
A dialog box will appear briefly on the screen, giving you the option to cancel the print job.

If several requests have been sent to the device through your software, they might be waiting in a print
queue (for example, in Windows Print Manager). See the software documentation for specific
instructions about canceling a print request from the computer.

If a print job is waiting in a print queue (computer memory) or print spooler (Windows 2000 or XP), delete
the print job there.

Click Start and then click Printers. Double-click the device icon to open the print spooler. Select the
print job that you want to cancel, and then press Delete. If the print job is not cancelled, you might need
to shut down and restart the computer.
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Print on envelopes
Envelopes must be printed from tray 1, which holds up to 10 envelopes. Printing performance depends
on the construction of the envelope. Always test a few sample envelopes before purchasing a large
quantity. For envelope specifications, see Supported paper and print media sizes on page 77 or go to
www.hp.com/support/ljm9059mfp.

CAUTION: Envelopes with clasps, snaps, windows, coated linings, exposed self-stick adhesives, or
other synthetic materials can severely damage the MFP. Do not use envelopes with pressure-sensitive
adhesive.

Use the following basic steps to print on envelopes.

1. Load the envelopes in tray 1.

2. Change the fuser levers.

3. Send the print job.

Load envelopes in tray 1

1. Open tray 1, but do not pull out the extension. (Most envelopes feed best without the extension.
However, oversize envelopes might need the extension.)

Figure 7-14  Load envelopes in tray 1 (1 of 3)

2. Load up to 10 envelopes in the center of tray 1 with the side to be printed on facing up, and the
return-address end toward the MFP. Slide the envelopes into the MFP as far as they will go without
forcing them.

Figure 7-15  Load envelopes in tray 1 (2 of 3)
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3. Adjust the guides to touch the envelope stack without bending the envelopes. Make sure that the
envelopes fit under the tabs on the guides.

Figure 7-16  Load envelopes in tray 1 (3 of 3)

4. Change the fuser levers (see Change the fuser levers on page 107).

Change the fuser levers

1. Move the output device away from the MFP to gain access to the left door.

Figure 7-17  Change the fuser levers (1 of 4)

2. Open the left door.

Figure 7-18  Change the fuser levers (2 of 4)

WARNING! Avoid touching the adjacent fusing area. It can be hot.
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3. Locate and lift up the two blue levers.

NOTE: Return the fuser levers to the down position after printing on envelopes.

CAUTION: Failure to return levers to the down position for standard paper types can result in
poor print quality.

Figure 7-19  Change the fuser levers (3 of 4)

4. Close the left door.

Figure 7-20  Change the fuser levers (4 of 4)

5. Push the output device back into place.

Print on envelopes from a program

1. Load envelopes into tray 1.

2. In your program or in the printer driver, select tray 1 as the source.

3. Set the appropriate envelope size and type. For envelope specifications, see Supported paper and
print media sizes on page 77.

4. If your program does not automatically format for an envelope, specify “Portrait” for page
orientation.

CAUTION: To avoid a jam, do not remove or insert an envelope after you begin printing.

5. Set margins to within 15 mm (0.6 inch) from the edge of the envelope. For best print quality, set
margins for a return and mailing address (typical address margins for a Commercial #10 or DL
envelope are offered). Avoid printing over the area where the three back flaps meet on the back
of an envelope.

6. Select the left bin as the output location.

7. When finished printing on envelopes, return the fuser levers to the down position.

CAUTION: Failure to return levers to the down position for standard paper types can result in poor
print quality.

108 Chapter 7   Print tasks ENWW



Job storage features for print
The following job-storage features are available for print jobs:

● Proof and hold jobs: This feature provides a quick and easy way to print and proof one copy of
a job and then print the additional copies.

● Personal jobs: When you send a private job to the device, the job does not print until you provide
the required personal identification number (PIN) at the control panel.

● Stored jobs: You can store a job such as a personnel form, time sheet, or calendar on the device
and allow other users to print the job at any time. Stored jobs also can be protected by a PIN.

Follow the instructions in this section to gain access to the job storage features at the computer. See
the specific section for the type of job that you want to create.

CAUTION: If you turn off the device, all proof-and-hold and personal jobs are deleted.

Gain access to the job storage features for print
For Windows

1. On the File menu, click Print.

2. Click Properties, and then click the Job Storage tab.

3. Select the job storage mode that you want.

For Macintosh

In newer drivers: Select Job Storage in the pull-down menu in the Print dialog box. In older drivers,
select Printer Specific Options.
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Use the proof and hold feature
The proof and hold feature provides a quick and easy way to print and proof one copy of a job.

To permanently store the job and prevent the device from deleting it when space is needed for something
else, select the Stored Job option in the driver.

Create a proof and hold job
CAUTION: If the device needs additional space to store newer proof and hold jobs, the device deletes
other stored proof and hold jobs, starting with the oldest job. To permanently store a job and prevent
the device from deleting it when space is needed, select the Stored Job option in the driver instead of
the Proof and Hold option.

In the driver, select the Proof and Hold option and type a user name and job name.

The device prints one copy of the job for you to proof.

Print the remaining copies of a proof and hold job
At the device control panel, use the following procedure to print the remaining copies of a job held on
the hard disk.

1. From the Home screen, touch Job Storage.

2. Touch the Retrieve tab.

3. Scroll to and touch the job storage folder that holds the job.

4. Scroll to and touch the job that you want to print.

5. Touch the Copies field to change the number of copies to print. Touch Retrieve Stored Job ( ) to
print the document.

Delete a proof and hold job
When you send a proof and hold job, the device automatically deletes your previous proof and hold job.

1. From the Home screen, touch Job Storage.

2. Touch the Retrieve tab.

3. Scroll to and touch the job storage folder that holds the job.

4. Scroll to and touch the job that you want to delete.

5. Touch Delete.

6. Touch Yes.

Use the personal job feature
Use the personal printing feature to specify that a job is not printed until you release it. First, set a 4-
digit PIN by typing the PIN in the printer driver. The PIN is sent to the device as part of the print job.
After you have sent the print job to the device, you must use the PIN to print the job.
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Create a personal job
To specify that a job is personal, in the driver, select the Personal Job option, type a user name and job
name, and then type a four-digit PIN into the Make Job Private field. The job will not print until you enter
the PIN at the device control panel.

Print a personal job
You can print a personal job at the control panel after the job has been sent to the device.

1. From the Home screen, touch Job Storage.

2. Touch the Retrieve tab.

3. Scroll to and touch the job storage folder that holds the personal job.

4. Scroll to and touch the personal job that you want to print.

NOTE: A personal job will have a  [lock symbol] next to it.

5. Touch the PIN field.

6. Use the numeric keypad to type the PIN, and then touch OK.

7. Touch the Copies field to change the number of copies to print.

8. Touch Retrieve Stored Job ( ) to print the document.

Delete a personal job
A personal job is automatically deleted from the device hard disk after you release it for printing. If you
want to delete the job without printing it, use this procedure.

1. From the Home screen, touch Job Storage.

2. Touch the Retrieve tab.

3. Scroll to and touch the job storage folder that holds the personal job.

4. Scroll to and touch the personal job that you want to delete.

NOTE: A personal job will have a  [lock symbol] next to it.)

5. Touch the PIN field.

6. Use the numeric keypad to type the PIN, and then touch OK.

7. Touch Delete.

Use the QuickCopy feature
The QuickCopy feature prints the requested number of copies of a job and stores a copy on the device
hard disk. Additional copies of the job can be printed later. This feature can be turned off in the printer
driver.

The default number of different QuickCopy jobs that can be stored on the device is 32. At the control
panel, you can set a different default number. See Navigate the Administration menu on page 15.
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Create a QuickCopy job
CAUTION: If the device needs additional space to store newer QuickCopy jobs, the device deletes
other stored QuickCopy jobs, starting with the oldest job. To permanently store a job and prevent the
device from deleting it when space is needed, select the Job Storage option in the driver instead of the
QuickCopy option.

In the driver, select the QuickCopy option, and then type a user name and a job name.

When you send the job to print, the device prints the number of copies that you set in the driver. To print
more quick copies at the device control panel, see Print additional copies of a QuickCopy job
on page 112.

Print additional copies of a QuickCopy job
This section describes how to print additional copies of a job stored on the device hard disk at the control
panel.

1. From the Home screen, touch Job Storage.

2. Touch the Retrieve tab.

3. Scroll to and touch the job storage folder that holds the job.

4. Scroll to and touch the job that you want to print.

5. Touch the Copies field to change the number of copies to print.

6. Touch Retrieve Stored Job ( ) to print the document.

Delete a QuickCopy job
Delete a QuickCopy job at the device control panel when you no longer need it. If the device requires
additional space to store new QuickCopy jobs, the device automatically deletes other stored QuickCopy
jobs, starting with the oldest job.

NOTE: Stored QuickCopy jobs can be deleted at the control panel or in HP Web Jetadmin.

1. From the Home screen, touch Job Storage.

2. Touch the Retrieve tab.

3. Scroll to and touch the job storage folder that holds the job.

4. Scroll to and touch the job that you want to delete.

5. Touch Delete.

6. Touch Yes.

Use the stored job feature
You can save a print job to the device hard disk without printing it. You can then print the job at any time
at the device control panel. For example, you might want to download a personnel form, calendar, time
sheet, or accounting form that other users can print when they need it.
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Create a stored print job
In the driver, select the Stored Job option, and then type a user name and job name. The job does not
print until someone requests it at the device control panel.

Print a stored print job
At the control panel, you can print a job that is stored on the device hard disk.

1. From the Home screen, touch Job Storage.

2. Touch the Retrieve tab.

3. Scroll to and touch the job storage folder that holds the stored job.

4. Scroll to and touch the stored job that you want to print.

5. Touch Retrieve Stored Job ( ) to print the document.

6. Touch the Copies field to change the number of copies to print.

7. Touch Retrieve Stored Job ( ) to print the document.

If the file has  (lock symbol) next to it, the job is a private job and requires a PIN.

Delete a stored print job
Jobs stored on the device hard disk can be deleted at the control panel.

1. From the Home screen, touch Job Storage.

2. Touch the Retrieve tab.

3. Scroll to and touch the job storage folder that holds the stored job.

4. Scroll to and touch the stored job that you want to delete.

5. Touch Delete.

6. Touch Yes.

If the file has  (lock symbol) next to it, the job requires a PIN to delete it.
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8 Copy

This device can function as a standalone, walk-up copier. It is not necessary to install the printing system
software on the computer; you can adjust the copy settings at the control panel. You can also copy
originals by using either the document feeder or the scanner glass.

This chapter provides information about how to make copies and how to change copy settings, including
the following topics:

● Use the Copy screen

● Set the default copy options

● Basic copy instructions

● Adjust the copy settings

● Copy two-sided documents

● Copy mixed-size originals

● Change the copy-collation setting

● Copy photos and books

● Combine copy jobs by using Job Build

● Cancel a copy job

● Job storage features for copy

It is recommended that you review the basic control-panel information before using the device copying
functions. See Use the control panel on page 12 for more information.
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Use the Copy screen
From the Home screen, touch Copy to view the Copy screen. Note that only the first six copy features
are immediately visible. In order to view additional copy features, touch More Options.

Figure 8-1  Copy screen
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Set the default copy options
You can use the administration menu to establish default settings that apply to all copy jobs. If necessary,
you can override most settings for an individual job. After that job is complete, the device returns to the
default settings.

1. From the Home screen, scroll to and touch Administration.

2. Touch Default Job Options, and then touch Default Copy Options.

3. Several options are available. You can configure defaults for all options, or for only some options.

For information about each option, see Adjust the copy settings on page 119. The built-in Help
system also provides an explanation of each option. Touch the Help button ( ) in the upper-right
corner of the screen.

4. To exit the administration menu, touch the Home button ( ) in the upper-left corner of the screen.
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Basic copy instructions
This section provides the basic instructions for copying.

Copy from the scanner glass
Use the scanner glass to make as many as 999 copies of small, lightweight media or heavy media. This
includes media such as receipts, newspaper clippings, photographs, old documents, worn documents,
and books.

Place original documents face-down on the glass. Align the corner of the original with the upper-left
corner of the glass.

To make copies by using the default copy options, use the numeric keypad on the control panel to select
the number of copies, and press Start. To use customized settings, touch Copy. Specify the settings,
and then press Start. For more information about using customized settings, see Adjust the copy settings
on page 119.

Copy from the document feeder
Use the document feeder to make as many as 999 copies of a document that has up to 50 pages
(depending on the thickness of the pages). Place the document into the document feeder with the pages
facing down.

To make copies by using the default copy options, use the numeric keypad on the control panel to select
the number of copies, and press Start. To use customized settings, touch Copy. Specify the settings,
and then press Start. For more information about using customized settings, see Adjust the copy settings
on page 119.
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Adjust the copy settings
The device offers several features so you can optimize copied output. These features are all available
on the Copy screen.

The Copy screen consists of several pages. From the first page, touch More Options to go to the next
page. Then touch the up or down arrow buttons to scroll to other pages.

For details about how to use an option, touch the option, and then touch the help ( ) button in the upper-
right corner of the screen. The following table provides an overview of the copy options.

NOTE: Depending on how the system administrator has configured the device, some of these options
might not appear. The options in the table are listed in the order in which they can appear.

Option name Description

Sides Use this feature to indicate whether the original document is printed on one or both sides, and
whether the copies should be printed on one or both sides.

Reduce/Enlarge Use this feature to reduce or enlarge the copied image on the page.

Staple/Collate or Collate If the optional HP Stapler/Stacker or HP Multifunction Finisher is attached, the Staple/Collate
option is available. Use this feature to set up options for stapling and assembling the pages in
sets of copies.

If the optional HP Stapler/Stacker or HP Multifunction Finisher is not attached, the Collate option
is available. Use this feature to assemble each set of copied pages in the same order as the
original document.

Paper Selection Use this feature to select the tray that holds the size and type of paper that you want to use.

Image Adjustment Use this feature to improve the overall quality of the copy. For example, you can adjust the
darkness and sharpness, and you can use the Background Cleanup setting to remove faint
images from the background or to remove a light background color.

Content Orientation Use this feature to specify the way the content of the original page is placed on the page: portrait
or landscape.

Output Bin Use this feature to select an output bin for the copies.

Optimize Text/Picture Use this feature to optimize the output for a particular type of content. You can optimize the
output for text or printed pictures, or you can manually adjust the values.

Pages per Sheet Use this feature to copy multiple pages onto one sheet of paper.

Original Size Use this feature to describe the page size of the original document.

Booklet Format Use this feature to copy two or more pages onto one sheet of paper so you can fold the sheets
in the center to form a booklet.

Edge-To-Edge Use this feature to avoid shadows that can appear along the edges of copies when the original
document is printed close to the edges. Combine this feature with the Reduce/Enlarge feature
to ensure that the entire page is printed on the copies.

Job Build Use this feature to combine several sets of original documents into one copy job. Also use this
feature to copy an original document that has more pages than the document feeder can
accommodate at one time.
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Copy two-sided documents
Two-sided documents can be copied manually or automatically.

Copying two-sided documents manually
Copies resulting from this procedure are printed on one side, and need to be hand-collated.

1. Load the documents to be copied into the document feeder input tray with the first page facing
down, and with the top of the page leading into the document feeder.

2. Touch Start Copy. The odd-numbered pages are copied and printed.

3. Remove the stack from the document feeder output tray and reload the stack with the last page
facing down, and with the top of the page leading into the document feeder.

4. Touch Start Copy. The even-numbered pages are copied and printed.

5. Collate the odd- and even-numbered printed copies.

Figure 8-2  Collate copies

Copy two-sided documents automatically
The default copy setting is one-sided to one-sided. Use the following procedures to change the setting
so you can copy from or to documents that are two-sided.

Make two-sided copies from one-sided documents

1. Load the documents to be copied into the document feeder with the first page facing down, and
with the top of the page leading.

2. On the control panel, touch Copy.

3. Touch Sides.

4. Touch 1-sided original, 2-sided output.

5. Touch OK.

6. Touch Start Copy.

Make two-sided copies from two-sided documents

1. Load the documents to be copied into the document feeder with the first page facing down, and
with the top of the page leading.

2. On the control panel, touch Copy.

3. Touch Sides.
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4. Touch 2-sided original, 2-sided output.

5. Touch OK.

6. Touch Start Copy.

Make one-sided copies from two-sided documents

1. Load the documents to be copied into the document feeder with the first page facing down, and
with the top of the page leading.

2. On the control panel, touch Copy.

3. Touch Sides.

4. Touch 2-sided original, 1-sided output.

5. Touch OK.

6. Touch Start Copy.
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Copy mixed-size originals
You can copy original documents that are printed on different sizes of paper as long as the sheets of
paper have one common dimension. For example, you could combine letter and legal sizes, or you could
combine A4 and A5 sizes.

1. Arrange the sheets in the original document so they all have the same width.

2. Place the sheets face-down into the document feeder, and adjust both paper guides against the
document.

3. From the Home screen, touch Copy.

4. Touch Original Size.

NOTE: If this option is not on the first screen, touch More Options until the option appears.

5. Select Mixed Ltr/Lgl, and then touch OK.

6. Touch Start Copy.
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Change the copy-collation setting
You can set the device to automatically collate multiple copies into sets. For example, if you are making
two copies of three pages and the automatic collation is on, the pages print in this order: 1,2,3,1,2,3. If
automatic collation is off, the pages print in this order: 1,1,2,2,3,3.

To use the automatic collation, the original document size must fit into the memory. If it does not, the
device makes only one copy and a message appears notifying you of the change. If that happens, use
one of the following methods to finish the job:

● Split the job into smaller jobs that contain fewer pages.

● Make only one copy of the document at a time.

● Turn off the automatic collation.

The collation setting you select is in effect for all copies until you change the setting. The default setting
for automatic copy collation is On.

1. On the control panel, touch Copy.

2. Touch Staple/Collate or Collate.

3. Touch Off.

4. Touch OK.
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Copy photos and books
Copy a photo 

NOTE: Photos should be copied from the flatbed scanner, not from the document feeder.

1. Lift the lid and place the photo on the flatbed scanner with the picture-side down and the upper-
left corner of the photo in the upper-left corner of the glass.

2. Gently close the lid.

3. Touch Start Copy.

Copy a book

1. Place the book face down on the glass with the top edge toward the rear of the glass. Align the
book spine with the book icon  along the top edge of the glass.

2. Touch Copy.

3. Scroll to and touch Book Copy.

4. Touch Book Copy On and then touch OK.

5. Select the number of copies to make and adjust other settings as needed.

6. Touch Start Copy, or press the Start button on the control panel.

7. Select which pages of the book should be copied:

● Copy both pages copies the images on both the left and right side of the spine

● Skip left page copies the image on the right side of the spine only

● Skip right page copies the image on the left side of the spine only

8. Touch Scan.

9. After the last page is scanned, touch Finish.

124 Chapter 8   Copy ENWW



Combine copy jobs by using Job Build
Use the Job Build feature to build a single copy job from multiple scans. You can use either the document
feeder or the scanner glass. The settings for the first scan are used for subsequent scans.

1. Touch Copy.

2. Scroll to and touch Job Build.

3. Touch Job Build On.

4. Touch OK.

5. If necessary, select the desired copy options.

6. Touch Start Copy. After each page is scanned, the control panel prompts you for more pages.

7. If the job contains more pages, load the next page, and then touch Scan.

The product temporarily saves all the scanned images. The product will begin printing copies when
it has enough information to begin. Touch Finished to finish printing the copies.

NOTE: In Job Build, if you scan the first page of a document by using the document feeder, then you
must scan all of the pages in that document by using the document feeder. If you scan the first page of
a document by using the scanner glass, then you must scan all of the pages in that document by using
the scanner glass.
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Cancel a copy job
To cancel the copy job that is currently running, touch Stop on the control panel. This pauses the device.
Then touch Cancel Current Job.

NOTE: If you cancel a copy job, clear the document from the flatbed scanner or from the automatic
document feeder.
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Job storage features for copy
You can create a stored copy job at the device control panel that can be printed at a later time.

Create a stored copy job
1. Place the original document face-down on the glass or face-down in the ADF.

2. From the Home screen, touch Job Storage.

3. Touch the Create tab.

4. Specify the name for the stored job in one of these ways:

● Select an existing folder from the list. Touch New Job and type a job name.

● Touch the box below the existing Folder Name: or Job Name: on the right-hand side of the
screen, and then edit the text.

5. A private stored job has a lock icon next to the name, and it requires that you specify a PIN to
retrieve it. To make the job private, select PIN to Print and then type the PIN for the job. Touch
OK.

6. Touch More Options to view and change other job storage options.

7. After all the options are set, touch Create Stored Job ( ) in the upper-left corner of the screen to
scan the document and store the job. The job is saved on the device until you delete it, so you can
print it as often as necessary.

Print a stored copy job
At the control panel, you can print a job that is stored on the device hard disk.

1. From the Home screen, touch Job Storage.

2. Touch the Retrieve tab.

3. Scroll to and touch the job storage folder that holds the stored job.

4. Scroll to and touch the stored job that you want to print.

5. Touch Retrieve Stored Job ( ) to print the document.

6. Touch the Copies field to change the number of copies to print.

7. Touch Retrieve Stored Job ( ) to print the document.

If the file has  (lock symbol) next to it, the job is a private job and requires a PIN.

Delete a stored copy job
Jobs stored on the device hard disk can be deleted at the control panel.

1. From the Home screen, touch Job Storage.

2. Touch the Retrieve tab.

3. Scroll to and touch the job storage folder that holds the stored job.
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4. Scroll to and touch the stored job that you want to delete.

5. Touch Delete.

6. Touch Yes.

If the file has  (lock symbol) next to it, the job requires a PIN to delete it.
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9 Scan and send to e-mail

The MFP offers color-scanning and digital-sending capabilities. By using the control panel, you can scan
black-and-white or color documents and send them to an e-mail address as an e-mail attachment. To
use digital sending, the device must be connected to a local area network (LAN).

NOTE: The e-mail icon is not shown on the control panel if e-mail is not configured.

● Configure the device to send e-mail

● Use the Send E-mail screen

● Perform basic e-mail functions

● Use the address book

● Change e-mail settings for the current job

● Scan to a folder

● Scan to a workflow destination
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Configure the device to send e-mail
Before you can send a document to e-mail, you must configure the device.

NOTE: The instructions that follow are for configuring the device at the control panel. You can also
perform these procedures by using the embedded Web server. For more information, see
Embedded Web server on page 148.

Supported protocols
The HP LaserJet M9059 MFP supports Simple Mail Transfer Protocol (SMTP) and Lightweight Directory
Access Protocol (LDAP).

SMTP (e-mail gateway)

● SMTP is a set of rules that define the interaction between programs that send and receive e-mail.
In order for the device to send documents to e-mail, it must be connected to a LAN that has access
to an e-mail server that supports SMTP. The SMTP server must also have Internet access.

● If you are using a LAN connection, contact your system administrator to obtain the IP address or
host name for your SMTP server. If you are connecting through a DSL or cable connection, contact
the internet service provider to obtain the SMTP server IP address.

LDAP

● LDAP is used to gain access to a database of information. When the device uses LDAP, it searches
a global list of e-mail addresses. As you begin to type the e-mail address, LDAP uses an auto-
complete feature that supplies a list of e-mail addresses that match the characters you type. As
you type additional characters, the list of matching e-mail addresses becomes smaller.

● The device supports LDAP, but a connection to an LDAP server is not required in order for the
device to be able to send to e-mail.

NOTE: If you need to change the LDAP settings, you must change them by using the embedded
Web server. For more information, see Embedded Web server on page 148, or see the Embedded
Web Server User Guide.

Configure e-mail server settings
Find the IP address for the SMTP server by touching the Network Address button on the control-panel
home screen or by consulting your system administrator. Then use the following procedures to manually
configure and test the IP address.

Configure the SMTP gateway address

1. From the Home screen, touch Administration.

2. Touch Initial Setup.

3. Touch E-mail Setup, and then touch SMTP Gateway.

4. Type the SMTP gateway address, either as an IP address or as a fully qualified domain name. If
you do not know the IP address or domain name, contact the network administrator.

5. Touch OK.

130 Chapter 9   Scan and send to e-mail ENWW



Test the SMTP settings

1. From the Home screen, touch Administration.

2. Touch Initial Setup.

3. Touch E-mail Setup, and then touch Test Send Gateway.

If the configuration is correct, Gateways OK appears on the control-panel display.

If the first test was successful, send an e-mail to yourself by using the digital-send feature. If you receive
the e-mail, you have successfully configured the digital-sending feature.

If you do not receive the e-mail, use these actions to resolve issues with the digital-sending software:

● Check the SMTP and address to make sure that you typed them correctly.

● Print a configuration page. Verify that the SMTP gateway address is correct.

● Make sure that the network is operating correctly. Send an e-mail to yourself from a computer. If
you receive the e-mail, the network is operating correctly. If you do not receive the e-mail, contact
your network administrator or Internet service provider (ISP).

● Run the DISCOVER.EXE file. This program attempts to find the gateway. You can download the
file from the HP Web site at www.hp.com/support/ljm9059mfp.
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Use the Send E-mail screen
Use the touchscreen to navigate through the options on the Send E-mail screen.

1 Send E-mail button Touching this button scans the document and sends an e-mail file to the provided e-mail
addresses.

2 Home button Touching this button opens the Home screen.

3 From: field Touch this field to open the keyboard, and then type your e-mail address. If the system
administrator has configured the device to do so, this field might automatically insert a default
address.

4 To: field Touch this field to open the keyboard, and then type the e-mail addresses of those whom you
want to receive the scanned document.

5 Subject: field Touch this field to open the keyboard, and then type a subject title.

6 More Options button Touch this button to change certain e-mail settings for the current scan job.

7 Scroll bar Use the scroll bar to view and set up the CC:, BCC:, Message, and File Name fields. Touch any
of those fields to open the keyboard and add the necessary information.

8 Address book buttons Touch these buttons to use the address book to populate the To:, CC:, or BCC: fields. For more
information, see Use the address book on page 135.

9 Help button Touch this button for control-panel help. For more information, see Use the control panel
on page 12.

10 Error/warning button This button appears only when there is an error or warning in the status line area. Touch it to open
a pop-up screen that will help you resolve the error or warning.
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Perform basic e-mail functions
The device e-mail feature offers the following benefits:

● Sends documents to multiple e-mail addresses, saving time and delivery costs.

● Delivers files in black-and-white or in color. Files can be sent in different file formats that the
recipient can manipulate.

With e-mail, documents are scanned into the device memory and sent to an e-mail address or multiple
addresses as an e-mail attachment. Digital documents can be sent in several graphics formats, such
as .TFF and .JPG, which allows recipients to manipulate the document file in various programs to meet
their specific needs. Documents arrive in near-original quality, and then can be printed, stored, or
forwarded.

In order to use the e-mail feature, the device needs to be connected to a valid SMTP local area network
that includes Internet access.

Load documents
You can scan a document by using either the glass or the ADF. The glass and ADF can accommodate
Executive / A5 to Ledger (LDR, 11x17) / A3. Smaller originals, receipts, irregular and worn documents,
stapled documents, previously folded documents, and photographs should be scanned by using the
glass. Multiple-page documents can be scanned easily by using the ADF.

Send documents
The device scans both black-and-white and color originals. You can use default settings or change the
scanning preferences and file formats. The following are the default settings:

● Color

● PDF (requires the recipient to have an Adobe Acrobat viewer to view the e-mail attachment)

For information about changing the settings for the current job, see Change e-mail settings for the current
job on page 137.

Send a document
1. Place the document face-down on the scanner glass or face-down in the ADF.

2. From the Home screen, touch E-mail.

3. If prompted, type your user name and password.

4. Complete the From:, To:, and Subject: fields. Scroll down and complete the CC:, BCC:, and
Message fields if appropriate. Your user name or other default information might appear in the
From: field. If so, you might not be able to change it.

5. (Optional) Touch More Options to change the settings for the document that you are sending (for
example, the document’s original size). If you are sending a two-sided document, you should select
Sides and an option with a two-sided original.

6. Press Start to begin sending.

7. When you are finished, remove the original document from the scanner glass, ADF, or output bin.
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Use the auto-complete function
When you type characters into the To:, CC:, or From: fields on the Send E-mail screen, the auto-
complete function is activated. As you type the required address or name by using the keyboard screen,
the device automatically searches the address book list and completes the address or name by using
the first match. You can then select that name by touching Enter, or continue typing the name until auto-
complete finds the correct entry. If you type a character that does not match any entry in the list, the
auto-complete text is removed from the display to indicate that you are typing an address that is not in
the address book.
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Use the address book
You can send e-mail to a list of recipients by using the address book feature of the device. See your
system administrator for information about configuring address lists.

NOTE: You can also use the embedded Web server (EWS) to create and manage the e-mail address
book. The EWS e-mail address book can be used to add, edit, or delete single e-mail addresses or e-
mail distribution lists. For more information, see Embedded Web server on page 148.

Create a recipient list
1. From the Home screen, touch E-mail.

2. Complete one of the following steps:

● Touch To: to open the keyboard screen, and then type the recipients' e-mail addresses.
Separate multiple e-mail addresses with a semicolon or by touching Enter on the touchscreen.

● Use the address book.

a. On the Send E-mail screen, touch the address book button ( ) to open the address
book.

b. Navigate the entries in the address book by using the scroll bar. Hold down the arrow to
scroll quickly through the list.

c. Highlight the name to select a recipient, and then touch the add button ( ).

You can also select a distribution list by touching the drop-down list at the top of the
screen and then touching All, or add a recipient from a local list by touching Local in the
drop-down list. Highlight the appropriate names, and then touch  to add the name to
your list of recipients.

You can remove a recipient from your list by scrolling to highlight the recipient, and then
touching the remove button ( ).

3. The names in the recipient list are placed in the text line of the keyboard screen. If you want, you
can add a recipient that is not found in the address book by typing the e-mail address on the
keyboard. After you are satisfied with your recipient list, touch OK.

4. Touch OK.

5. Finish typing information in the CC: and Subject: fields on the Send E-mail screen, if necessary.
You can check the list of recipients by touching the down arrow in the To: text line.

6. Press Start.

Use the local address book
Use the local address book to store frequently-used e-mail addresses. The local address book can be
shared between devices that use the same server to gain access to the HP Digital Sending software.

You can use the address book when you type e-mail addresses in the From:, To:, CC:, or BCC: fields.
You can also add or delete addresses in the address book.

To open the address book, touch the address book button ( ).
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Add e-mail addresses to the local address book
1. Touch Local.

2. Touch .

3. (Optional) Touch the Name field, and in the keyboard that appears type a name for the new entry.
Touch OK.

The name is the alias for the e-mail address. If you do not type an alias name, the alias will be the
e-mail address itself.

4. Touch the Address field, and in the keyboard that appears type the e-mail address for the new
entry. Touch OK.

Delete e-mail addresses from the local address book
You can delete e-mail addresses that you no longer use.

NOTE: To change an e-mail address, you must first delete the address and then add the corrected
address as a new address in the local address book.

1. Touch Local.

2. Touch the e-mail address that you want to delete.

3. Touch .

The following confirmation message appears: Do you want to delete the selected address(es)?

4. Touch Yes to delete the e-mail address(es) or touch No to return to the Address Book screen.
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Change e-mail settings for the current job
Use the More Options button to change the following e-mail settings for the current print job:

Button Description

Document File Type Touch this button to change the type of file the device creates after scanning the document.

Output Quality Touch this button to increase or decrease the print quality of the file being scanned. A higher quality
setting produces a larger file size.

Resolution Touch this button to change the scan resolution. A higher resolution setting produces a larger file size.

Color/Black Touch this button to determine whether you will scan the document in color or in black-and-white.

Original Sides Touch this button to indicate if the original document is one-sided or two-sided.

Content Orientation Touch this button to select either the portrait or landscape orientation for the original.

Original Size Touch this button to select the size of the document: letter, A4, legal, or mixed letter/legal.

Optimize Text/
Picture

Touch this button to change the scanning procedure based on the type of document that you are
scanning.

Job Build Touch this button to activate or deactivate the Job Build mode, which enables you to scan several small
scan jobs and send them as one file.

Image Adjustment Touch this button to change the darkness and sharpness settings, or to clean up background clutter on
the original.
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Scan to a folder
If the system administrator has made the feature available, the device can scan a file and send it to a
folder on the network. Supported operating systems for folder destinations include Windows 2000,
Windows XP, Windows Server 2003, Windows Server 2008, and Windows Vista.

NOTE: You might be required to supply a user name and password in order to use this option, or to
send to certain folders. See your system administrator for more information.

1. Place the document face-down on the scanner glass or face-down in the ADF.

2. From the Home screen, touch Network Folder.

3. In the Quick Access Folders list, select the folder in which you want to save the document.

4. Touch the File Name field to open the keyboard pop-up screen, and then type the file name.

5. Touch Send to Network Folder.
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Scan to a workflow destination
NOTE: This device feature is provided by the optional Digital Sending Software.

If the system administrator has enabled the workflow functionality, you can scan a document and send
it to a custom workflow destination. A workflow destination gives you the ability to send additional
information, along with the scanned document, to a specified network or file transfer protocol (FTP)
location. Prompts for specific information appear on the control-panel display. The system administrator
can also designate a printer as a workflow destination, which allows you to scan a document and then
send it directly to a network printer for printing.

1. Place the document face-down on the scanner glass or face-down in the ADF.

2. From the Home screen, touch Workflow.

3. Select the destination to which you want to scan.

4. In the Text Field field, type the data that you want to accompany the file, and then touch Send
Workflow.
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10 Fax

● Analog fax

● Digital fax
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Analog fax
Add analog fax capabilities to the MFP by purchasing and installing the Analog Fax Accessory 300.
When the analog fax accessory is installed, the MFP can function as a standalone fax machine. See
Order parts, accessories, and supplies on page 230 for information about ordering the analog fax
accessory. The Analog Fax Accessory 300 Fax Guide and the Analog Fax Accessory 300 Send Fax
Driver Guide are available at www.hp.com/go/mfpfaxaccessory300.

Connect the fax accessory to a phone line
When connecting the fax accessory to a phone line, ensure that the phone line being used for the fax
accessory is a dedicated line that is not used by any other devices. Also, this line should be an analog
line because the fax will not function correctly if it is connected to some digital PBX systems. If you are
not sure whether you have an analog or digital phone line, contact your telecom provider.

NOTE: HP recommends using the phone cord that comes with the fax accessory to ensure that the
accessory functions correctly.

Follow these instructions to connect the fax accessory to a phone jack.

1. Locate the phone cord that is included with the fax accessory kit. Connect one end of the phone
cord into the fax accessory phone jack that is on the formatter. Push the connector until it clicks.

Figure 10-1  Connect the fax accessory to a phone line

CAUTION: Be sure to connect the phone line to the fax accessory port, which is located at the
bottom of the formatter.

2. Connect the other end of the phone cord into the phone jack on the wall. Push the connector until
it clicks or until it is securely seated. Because different types of connectors are used in different
countries/regions, the connector might not make an audible click.

Configure and use the fax features
Before you can use the fax features, you must configure them in the control-panel menus. For complete
information about configuring and using the fax accessory, and for information about troubleshooting
problems with the fax accessory, see the HP LaserJet Analog Fax Accessory 300 User Guide. This
guide is provided with the fax accessory.

Use the Send Fax driver to send a fax from a computer without going to the MFP control panel. See the
HP LaserJet MFP Analog Fax Accessory 300 Send Fax Driver Guide for more information.
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Digital fax
Digital faxing is available when you install the optional HP Digital Sending Software. For information
about ordering this software, go to http://www.hp.com/go/digitalsending.

With digital faxing, the MFP does not need to be connected directly to a phone line. Instead, the MFP
can send a fax in one of three ways:

● LAN fax sends faxes through a third-party fax provider.

● Microsoft Windows 2000 fax is a fax modem and Digital Sender Module on a computer that allows
the computer to operate as a turnkey gateway fax.

● Internet fax uses an Internet fax provider to process faxes, and the fax is delivered on a traditional
fax machine or sent to the user’s e-mail.

For complete information about using digital faxing, see the documentation that is provided with the
HP Digital Sending Software.
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11 Manage and maintain

● Information pages

● Embedded Web server

● Use HP Web Jetadmin software

● HP Printer Utility for Macintosh

● Security features

● Set the real-time clock

● Clean the MFP

● Calibrate the scanner

● Configure alerts

● Manage supplies

● Printer maintenance kit

● Manage memory

● Economy settings
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Information pages
Information pages provide details about the device and its current configuration. The following table
provides the instructions for printing the information pages.

Page description How to print the page from the MFP control panel

Menu map

Shows the control-panel menus and
available settings.

1. From the Home screen, touch Administration.

2. Touch Information.

3. Touch Configuration/Status Pages.

4. Touch Administration Menu Map.

5. Touch Print.

The content of the menu map varies, depending on the options currently installed in
the device.

For a complete list of control panel menus and possible values, see Use the control
panel on page 12.

Configuration page

Shows device settings and installed
accessories.

1. From the Home screen, touch Administration.

2. Touch Information.

3. Touch Configuration/Status Pages.

4. Touch Configuration Page.

5. Touch Print.

NOTE: If the device contains an HP Jetdirect print server or an optional hard disk
drive, additional configuration pages print that provide information about those
devices.

Supplies status page

Shows status of print-cartridge life and
status of maintenance kit.

1. From the Home screen, touch Administration.

2. Touch Information.

3. Touch Configuration/Status Pages.

4. Touch Supplies Status Page.

5. Touch Print.

NOTE: If you are using non-HP supplies, the supplies status page might not show
the remaining life for those supplies.

Usage page

Shows a page count for each size of
paper printed, the number of one-sided
(simplexed) or two-sided (duplexed)
pages, and the average percentage of
coverage.

1. From the Home screen, touch Administration.

2. Touch Information.

3. Touch Configuration/Status Pages.

4. Touch Usage Page.

5. Touch Print.
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Page description How to print the page from the MFP control panel

File directory

Contains information for any mass
storage devices, such as flash drives,
memory cards, or hard disks, that are
installed in the device.

1. From the Home screen, touch Administration.

2. Touch Information.

3. Touch Configuration/Status Pages.

4. Touch File Directory.

5. Touch Print.

Fax reports

Five reports show fax activity, fax calls,
billing codes, blocked fax numbers, and
speed-dial numbers.

NOTE: Fax reports are available only
on models that have the fax accessory
installed.

1. From the Home screen, touch Administration.

2. Touch Information.

3. Touch Fax Reports.

4. Touch one of the following buttons to print the corresponding report:

◦ Fax Activity Log

◦ Fax Call Report

◦ Billing Codes Report

◦ Blocked Fax List

◦ Speed Dial List

5. Touch Print.

For more information, see the fax guide that came with the device.

Font lists

Shows which fonts are currently
installed in the device.

1. From the Home screen, touch Administration.

2. Touch Information.

3. Touch Sample Pages/Fonts.

4. Touch either PCL Font List or PS Font List.

5. Touch Print.

NOTE: The font lists also show which fonts reside on a hard disk accessory or
DIMM.
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Embedded Web server
Use the embedded Web server to view MFP and network status and to manage printing functions from
your computer instead of from the MFP control panel. The following are examples of what you can do
using the embedded Web server:

● View MFP status information.

● Set the type of media that is loaded in each tray.

● Determine the remaining life for all supplies.

● View and change tray configurations.

● View and change the MFP control-panel menu configuration.

● View and print internal pages.

● Receive notification of MFP and supplies events.

● View and change network configuration.

To use the embedded Web server, you must have Microsoft Internet Explorer 5.01 or later or Netscape
6.2 or later for Windows, Mac OS, and Linux (Netscape only). Netscape Navigator 4.7 is required for
HP-UX 10 and HP-UX 11. The embedded Web server works when the MFP is connected to an IP-based
network. The embedded Web server does not support IPX-based MFP connections. You do not have
to have Internet access to open and use the embedded Web server.

When the MFP is connected to the network, the embedded Web server is automatically available.

NOTE: For complete information about using the embedded Web server, see the Embedded Web
Server User Guide.

Open the embedded Web server by using a network connection
1. In a supported Web browser on your computer, type the device IP address or host name in the

address/URL field. To find the IP address or host name, print a configuration page. See Information
pages on page 146.

NOTE: After you open the URL, you can bookmark it so that you can return to it quickly in the
future.

2. The embedded Web server has four tabs that contain settings and information about the device:
the Information tab, the Settings tab, the Networking tab, and the Digital Sending tab. Click the
tab that you want to view.

See Embedded Web server sections on page 149 for more information about each tab.
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Embedded Web server sections

Tab or section Options

Information tab

Provides device, status, and
configuration information

● Device Status: Shows the device status and shows the life remaining of HP supplies,
with 0% indicating that a supply is empty. The page also shows the type and size of
print paper set for each tray. To change the default settings, click Change
Settings.

● Configuration Page: Shows the information found on the configuration page.

● Supplies Status: Shows the life remaining of HP supplies, with 0 percent indicating
that a supply is empty. This page also provides supplies part numbers. To order new
supplies, contact your dealer.

● Event log: Shows a list of all device events and errors.

● Usage page: Shows a summary of the number of pages the device has printed,
grouped by size and type.

● Device Information: Shows the device network name, address, and model
information. To change these entries, click Device Information on the Settings tab.

● Control Panel: Shows messages from the device control panel, such as Ready or
Sleep mode on.

● Print: Allows you to send print jobs to the device.
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Tab or section Options

Settings tab

Provides the ability to configure the
device from your computer

● Configure Device: Allows you to configure device settings. This page contains the
traditional menus found on devices using a control-panel display.

● Tray Sizes/Types: Allows you to assign paper sizes and paper types for each tray
on the product.

● E-mail Server: Network only. Used in conjunction with the Alerts page to set up
incoming and outgoing e-mail, as well as to set e-mail alerts.

● Alerts: Network only. Allows you to set up to receive e-mail alerts for various device
and supplies events.

● AutoSend: Allows you to configure the device to send automated e-mails regarding
device configuration and supplies to specific e-mail addresses.

● Security: Allows you to set a password that must be entered to gain access to the
Settings and Networking tabs. Enable and disable certain features of the
embedded Web server.

● Authentication Manager: Allows you to determine which device functions will
require a user to provide log-in information in order to use those functions.

● LDAP Authentication: Allows you to configure a Lightweight Directory Access
Protocol (LDAP) server to limit device access to certain users. The LDAP server will
require a user to provide log-in information in order to gain access to the device.

● Kerberos Authentication: Use the Kerberos Authentication page to configure the
device to authenticate users to a Kerberos Realm. When Kerberos authentication is
selected as the Log In Method for one or more Device Functions, the user at the
device must enter valid credentials (username, password, and realm) to gain access
to those functions.

● Device PIN: Allows you to limit access to one or more device functions using a
Personal Identification Number (PIN).

● User PIN: Allows you to add user PIN records into the device, and to edit or delete
user PIN records that have already been saved in the device. You can set up the
device to require each user to provide their PIN when they access the device.

● Edit Other Links: Allows you to add or customize a link to another Web site. This
link is displayed in the Other Links area on all embedded Web server pages.

● Device Information: Allows you to name the device and assign an asset number to
it. Enter the name and e-mail address for the primary contact who will receive
information about the device.

● Language: Allows you to determine the language in which to display the embedded
Web server information.

● Date & Time: Allows time synchronization with a network time server.

● Wake Time: Allows you to set or edit a wake time for the device.

NOTE: The Settings tab can be password-protected. If this device is on a network,
always consult with the system administrator before changing settings on this tab.
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Tab or section Options

Digital Sending tab

Provides the ability to change
digital sending settings from your
computer

● General Settings: Allows you to set digital-sending administrator information.

● Send to Folder: Allows you to send scanned documents to shared folders or FTP
sites.

● E-mail Settings: Allows you to configure SMTP settings, set the maximum e-mail
attachment size, and set the default e-mail address for the product. You can also set
a default subject for all e-mail messages that the product sends.

● E-mail Address Book: Allows you to add e-mail addresses into the device, and to
edit e-mail addresses that have already been saved in the device.

● Fax Address Book: Allows you to add fax numbers into the device, and to edit fax
numbers that have already been saved in the device.

● Import/Export: Allows you to import and export address book and user information
to and from the device.

● LDAP Settings: Allows you to configure a Lightweight Directory Access Protocol
(LDAP) server to look up e-mail addresses.

● Log: Allows you to view digital sending job information, including any errors that
occur.

● Preferences: Allows you to configure general settings for the digital-sending
features.

Networking tab

Provides the ability to change
network settings from your
computer

Network administrators can use this tab to control network-related settings for the device
when it is connected to an IP-based network. This tab does not appear if the device is
directly connected to a computer, or if the device is connected to a network using anything
other than an HP Jetdirect print server.

NOTE: The Networking tab can be password-protected.
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Use HP Web Jetadmin software
HP Web Jetadmin is a Web-based software solution for remotely installing, monitoring, and
troubleshooting network-connected peripherals. The intuitive browser interface simplifies cross-platform
management of a wide range of devices, including HP and non-HP devices. Management is proactive,
allowing network administrators the ability to resolve issues before users are affected. Download this
free, enhanced-management software at www.hp.com/go/webjetadmin_software. 

NOTE: HP Web Jetadmin 10.0 or later is required for full support of this product.

To obtain plug-ins to HP Web Jetadmin, click plug-ins, and then click the download link that is next to
the name of the plug-in that you want. The HP Web Jetadmin software can automatically notify you
when new plug-ins are available. On the Product Update page, follow the directions to automatically
connect to the HP Web site.

If installed on a host server, HP Web Jetadmin is available to any client through a supported Web
browser, such as Microsoft Internet Explorer 6.0 for Windows or Netscape Navigator 7.1 for Linux.
Browse to the HP Web Jetadmin host.

NOTE: Browsers must be Java-enabled. Browsing from an Apple PC is not supported.
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HP Printer Utility for Macintosh
Use the optional HP Printer Utility to configure and maintain a printer from a Mac OS X V10.3 or V10.4
computer. This section describes several functions that you can perform through the HP Printer Utility.

Open the HP Printer Utility
The process that you use to start the HP Printer Utility depends on the Macintosh operating system that
you are using.

Open the HP Printer Utility in Mac OS X V10.3 or Mac OS X V10.4

1. In the Dock, click the Printer Setup Utility icon.

NOTE: If the Printer Setup Utility icon does not appear in the Dock, open the Finder, click
Applications, click Utilities, and then double-click Printer Setup Utility.

2. Select the printer that you want to configure, and then click Utilities.

Print a cleaning page
Print a cleaning page if the printer is not printing jobs at the expected quality level.

1. Open the HP Printer Utility.

2. In the Configuration Settings list, select Cleaning.

3. Click Print Cleaning Page to print the cleaning page.

Print a configuration page
Print a configuration page to view the printer settings.

1. Open the HP Printer Utility.

2. In the Configuration Settings list, select Configuration Page.

3. Click Print Configuration Page to print the configuration page.

View supplies status
View the status of the printer supplies (such as print cartridges, imaging drum, or print media) from a
computer.

1. Open the HP Printer Utility.

2. In the Configuration Settings list, select Supplies Status.

3. Click the Supplies tab to view the status of various replaceable supplies, and click the Media tab
to view the status of print media.

● To view a more detailed status list, click Detailed Supplies Information. The Supplies
Information dialog box appears.
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Upload a file to the printer
Send a file from the computer to the printer. The action that the printer takes depends on the type of file
that is being sent to it. For example, when a print-ready file (such as a .PS or .PCL file) is sent, the printer
prints the file.

1. Open the HP Printer Utility.

2. In the Configuration Settings list, select File Upload.

3. Click Choose, navigate to the file that you want to upload, and then click OK.

4. Click Upload to load the file.

Update the firmware
Update the printer firmware by loading the new firmware file from the computer. You can find new
firmware files for your printer at www.hp.com/go/ljm9059mfp_firmware.

1. Open the HP Printer Utility.

2. In the Configuration Settings list, select Firmware Update.

3. Click Choose, navigate to the firmware file that you want to upload, and then click OK.

4. Click Upload to load the firmware file.

Activate the two-sided printing (duplexing) mode
Turn on the two-sided printing feature on printers equipped with automatic duplexers.

1. Open the HP Printer Utility.

2. In the Configuration Settings list, select Duplex mode.

3. Select Enable Duplex Mode to activate the two-sided printing mode, and then click Apply Now.

Lock or unlock printer storage devices
Manage access to printer storage devices from the computer.

1. Open the HP Printer Utility.

2. In the Configuration Settings list, select Lock Resources.

3. On the Control Panel Access Level pop-up menu, select the access level that you want to set
for the printer control panel.

4. Select the devices that you want to lock, and clear any devices that you want to unlock.

5. Click Apply Now.
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Save or print stored jobs
Turn on the printer job-storing function, or print a stored job from the computer. You also can delete a
stored print job.

1. Open the HP Printer Utility.

2. In the Configuration Settings list, select Stored Jobs.

3. Perform any of the following tasks:

● To turn on the job-storing function, select Enable Job Storing, and then click Apply Now.

● To print a stored job, select a stored job in the list, type the necessary personal identification
number (PIN) in the Enter Secure Job PIN box, type the number of copies that you want in
the Copies To Print box, and then click Print.

● To delete a stored job, select a stored job in the list, and then click Delete.

Configure trays
Change the default printer tray settings from the computer.

1. Open the HP Printer Utility.

2. In the Configuration Settings list, select Tray Configuration.

3. In the Trays list, select the tray to be configured.

NOTE: To make the selected tray the default tray for printing, click Make Default.

4. In the Default Media Size pop-up menu, select the default media size for the tray.

5. In the Default Media Type pop-up menu, select the default media type for the tray.

6. Click Apply Now.

Change network settings
Change the network internet protocol (IP) settings from the computer. You also can open the embedded
Web server to change additional settings. For more information, see Embedded Web server
on page 148.

1. Open the HP Printer Utility.

2. In the Configuration Settings list, select IP Settings.

3. Change any of the settings in the following pop-up menus or fields:

● Configuration

● Host Name

● IP Address

● Subnet Mask

● Default Gateway
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If you want to change more settings in the embedded Web server, click Additional Network
Settings. The embedded Web server opens with the Networking tab selected.

4. Click Apply Now.

Open the embedded Web server
1. Open the HP Printer Utility.

2. In the Configuration Settings list, select Additional Settings.

3. Click Open Embedded Web Server.

Set up e-mail alerts
Set up e-mail messages that alert you to certain events that occur with the printer, such as a low toner
level in a print cartridge.

1. Open the HP Printer Utility.

2. In the Configuration Settings list, select E-mail Alerts.

3. Click the Server tab, and, in the SMTP Server box, type the server name.

4. Click the Destination tab, click the add (+) button, and then type the e-mail addresses, mobile
device numbers, or Web site URLs to which you want the e-mail alerts sent.

NOTE: If your printer supports e-mail lists, you can make alerts lists for specific events the same
way that you added e-mail addresses.

5. Click the Events tab, and, in the list, define the events for which an e-mail alert should be sent.

6. To test the alerts setup, click the Server tab, and then click Test. A sample message is sent to the
defined e-mail addresses if the configuration is correct.

7. Click Apply Now.

156 Chapter 11   Manage and maintain ENWW



Security features
This section explains important security features that are available for the MFP:

● Secure the embedded Web server

● Secure Disk Erase

● Security Lock

● Authentication

● Lock the control-panel menus

Secure the embedded Web server
Assign a password for access to the embedded Web server so that unauthorized users cannot change
the MFP settings.

1. Open the embedded Web server. See Embedded Web server on page 148.

2. Click the Settings tab.

3. On the left side of the window, click Security.

4. Type the password next to New Password, and type it again next to Verify Password.

5. Click Apply. Make note of the password and store it in a safe place.

Secure Disk Erase
To protect deleted data from unauthorized access on the MFP hard drive, use the Secure Disk Erase
feature. This feature can securely erase print and copy jobs from the hard drive.

Secure Disk Erase offers the following levels of disk security:

● Non-Secure Fast Erase. This is a simple file-table erase function. Access to the file is removed,
but actual data is retained on the disk until it is overwritten by subsequent data-storage operations.
This is the fastest mode. Non-Secure Fast Erase is the default erase mode.

● Secure Fast Erase. Access to the file is removed, and the data is overwritten with a fixed identical
character pattern. This is slower than Non-Secure Fast Erase, but all data is overwritten. Secure
Fast Erase meets the U.S. Department of Defense 5220-22.M requirements for the clearing of disk
media.

● Secure Sanitizing Erase. This level is similar to the Secure Fast Erase mode. In addition, data is
repetitively overwritten by using an algorithm that prevents any residual data persistence. This
mode will impact performance. Secure Sanitizing Erase meets the U.S. Department of Defense
5220-22.M requirements for the sanitization of disk media.

Data affected
Data affected (covered) by the Secure Disk Erase feature includes temporary files that are created
during the print and copying process, stored jobs, proof and hold jobs, disk-based fonts, disk-based
macros (forms), stored fax files, address books, and HP and third-party applications.

NOTE: Stored jobs will be securely overwritten only when they have been deleted through the
Retrieve Job menu on the MFP after the appropriate erase mode has been set.
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This feature will not impact data that is stored on flash-based product non-volatile RAM (NVRAM) that
is used to store default settings, page counts, and similar data. This feature does not affect data that is
stored on a system RAM disk (if one is used). This feature does not impact data that is stored on the
flash-based system boot RAM.

Changing the Secure Disk Erase mode does not overwrite previous data on the disk, nor does it
immediately perform a full-disk sanitization. Changing the Secure Disk Erase mode changes how the
MFP cleans up temporary data for jobs after the erase mode has been changed.

Gain access to Secure Disk Erase
Use HP Web Jetadmin to gain access to and set the Secure Disk Erase feature.

Additional Information
For additional information about the HP Secure Disk Erase feature, go to http://www.hp.com/go/
webjetadmin/.

Security Lock
The security lock is a mechanical lock that is used to prevent the removal of internal computer
components. Optional EIO accessories are not protected, however. Purchase the security lock
assembly separately, and then install it on the MFP.

Figure 11-1  Security lock

Authentication
This MFP offers several embedded authentication methods. These methods include Kerberos, LDAP,
LDAP over SSL, and PIN.

Optional HP Digital Send Software supports Windows SPNEGO, LDAP, LDAP over SSL, and Novell
authentication.

Lock the control-panel menus
To prevent someone from changing the MFP configuration, you can lock the control-panel menus. This
prevents unauthorized users from changing the configuration settings such as the SMTP server. The
following procedure describes how to restrict access to the control-panel menus by using the HP Web
Jetadmin software. (See Use HP Web Jetadmin software on page 152.)

1. Open the HP Web Jetadmin program.

2. Open the DEVICE MANAGEMENT folder in the drop-down list in the Navigation panel. Navigate
to the DEVICE LISTS folder.

3. Select the MFP.
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4. In the Device Tools drop-down list, select Configure.

5. Select Security from the Configuration Categories list.

6. Type a Device Password.

7. In the Control Panel Access section, select Maximum Lock. This prevents unauthorized users
from gaining access to configuration settings.
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Set the real-time clock
Use the real-time clock feature to set the date and time settings. The date and time information is
attached to stored print, fax, and digital-send jobs, so you can identify the most recent versions of stored
print jobs.

1. On the control panel, scroll to and touch Administration.

2. Touch Time/Scheduling.

3. Touch Date/Time.

4. Choose a date format.

5. Choose a time format.

6. Touch the Date fields to enter the date.

7. Touch the Time fields to enter the time.

8. Touch Save.
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Clean the MFP
Print a cleaning page

1. From the Home screen, touch Administration.

2. Touch Print Quality.

3. Touch Calibration/Cleaning.

4. Touch Create Cleaning Page.

The device prints a cleaning page.

5. Follow the instructions printed on the cleaning page.

Clean the MFP hardware
To maintain print quality, clean the MFP thoroughly:

● every time you change the print cartridge

● whenever print-quality problems occur

Clean the outside of the MFP with a lightly water-dampened cloth. Clean the inside with only a dry, lint-
free cloth. Observe all warnings and cautions regarding the cleaning tasks.

WARNING! Avoid touching the fusing area when cleaning the MFP. It can be hot.

WARNING! Do not touch the transfer roller when cleaning the MFP.

CAUTION: To avoid permanent damage to the print cartridge, do not use ammonia-based cleaners
on or around the MFP.

Clean the paper path

1. Before you begin these steps, turn the MFP off (button out) and disconnect all cables, including
the power cord.

Figure 11-2  Clean the paper path (1 of 6)
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2. Open the front cover of the MFP, rotate the green lever downward to the unlocked position, and
remove the print cartridge.

Figure 11-3  Clean the paper path (2 of 6)

CAUTION: To prevent damage to the print cartridge, use two hands when removing it from the
MFP. Do not expose the print cartridge to light for more than a few minutes. Cover the print cartridge
when it is outside of the MFP.

NOTE: If toner gets on your clothes, wipe it off with a dry cloth, and wash your clothes in cold
water. Hot water sets toner into fabric.

3. With a dry, lint-free cloth, wipe any residue from the paper path area, the registration roller, and
the print cartridge cavity.

Figure 11-4  Clean the paper path (3 of 6)

4. Replace the print cartridge.

Figure 11-5  Clean the paper path (4 of 6)

5. Rotate the green handle into the locked position.

Figure 11-6  Clean the paper path (5 of 6)

162 Chapter 11   Manage and maintain ENWW



6. Close the front cover, reconnect all cables, and turn the MFP on (button in).

Figure 11-7  Clean the paper path (6 of 6)

Clean the outside of the MFP

● Clean the outside of the MFP if it is visibly marked.

● Use a soft, lint-free cloth dampened with water.

Clean the touchscreen

● Clean the touch screen when needed (fingerprints, dust build-up).

● Wipe the touch screen gently with a clean, water-dampened, lint-free cloth.

CAUTION: Use water only. Solvents or cleaners can damage the touch screen. Do not pour or spray
water directly onto the touch screen.

Clean the glass

● Clean the glass only if dirt is visible, or if you are experiencing a decrease in copy quality, such as
streaking.

● Clean the glass surface by wiping it gently with a clean, slightly damp, lint-free cloth.

CAUTION: Do not pour or spray liquids directly onto the glass.Do not press hard on the glass surface.
(You could break the glass).

Clean the ADF delivery system 
Clean the ADF only if it is visibly marked or dirty, or if you are experiencing a decrease in copy quality
(such as streaking).

1. Lift the top cover.

Figure 11-8  Clean the ADF delivery system (1 of 5)
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2. Locate the top and bottom ADF glass strips.

Figure 11-9  Clean the ADF delivery system (2 of 5)

3. Clean the glass strips by wiping them gently with a clean, damp, lint-free cloth.

4. Locate the white, vinyl backing.

Figure 11-10  Clean the ADF delivery system (3 of 5)

5. Locate the white, vinyl calibration strips.

Figure 11-11  Clean the ADF delivery system (4 of 5)

6. Clean the ADF backing and the calibration strips by wiping them with a clean, damp, lint-free cloth.

7. Close the top cover.

Figure 11-12  Clean the ADF delivery system (5 of 5)

Clean the top ADF glass strip

If you are still experiencing poor copy quality, you might need to clean the top ADF glass strip.
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CAUTION: Clean this area only if you see copy defects such as streaks, and you notice dust inside
the glass strip. Cleaning this area frequently could introduce dust into the MFP.

1. Open the ADF cover.

Figure 11-13  Clean the top ADF glass strip (1 of 4)

2. Locate the latch that releases the top ADF glass strip. Push the latch to the left, and pull down to
expose the inside of the glass strip.

Figure 11-14  Clean the top ADF glass strip (2 of 4)

3. Gently wipe the glass with a dry, lint-free cloth.

CAUTION: Use dry cloth only in this area. Do not use solvents, cleaners, water, or compressed
air. Doing so could severely damage the MFP.

4. Pull the latch to the left and return the glass strip to its normal position.

Figure 11-15  Clean the top ADF glass strip (3 of 4)

5. Close the ADF cover.

Figure 11-16  Clean the top ADF glass strip (4 of 4)
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Clean the ADF rollers

You should clean the rollers in the ADF if you are experiencing misfeeds or if your originals show marks
as they exit the ADF.

1. Open the top cover.

CAUTION: Clean the rollers only if you experience misfeeds or marks on the originals, and you
notice dust on the rollers. Cleaning the rollers frequently could introduce dust into the MFP.

Figure 11-17  Clean the ADF rollers (1 of 6)

2. Locate the rollers near the glass strips.

Figure 11-18  Clean the ADF rollers (2 of 6)

3. Wipe the rollers gently with a clean, water-dampened, lint-free cloth.

CAUTION: Do not pour water directly onto the rollers. Doing so might damage the MFP.

4. Close the top cover.

Figure 11-19  Clean the ADF rollers (3 of 6)
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5. Open the ADF cover.

Figure 11-20  Clean the ADF rollers (4 of 6)

6. Locate the rollers.

Figure 11-21  Clean the ADF rollers (5 of 6)

7. Wipe the rollers with a clean, water-dampened, lint-free cloth.

CAUTION: Do not pour water directly onto the rollers. Doing so might damage the MFP.

8. Close the ADF cover.

Figure 11-22  Clean the ADF rollers (6 of 6)

9. Close the delivery guide and wipe its outside surface with the cloth.
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Calibrate the scanner
Calibrate the scanner to compensate for offsets in the scanner imaging system (carriage head) for ADF
and flatbed scans. Because of mechanical tolerances, the scanner's carriage head might not read the
position of the image accurately. During the calibration procedure, scanner offset values are calculated
and stored. The offset values are then used when producing scans so that the correct portion of the
document is captured.

Scanner calibration should be carried out only if you notice offset problems with the scanned images.
The scanner is calibrated before it leaves the factory. It needs to be calibrated again only rarely.

1. From the Home screen, scroll to and touch Administration.

2. Touch Troubleshooting.

3. Touch Calibrate Scanner.

4. Touch Calibrate and then follow the on-screen instructions.
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Configure alerts
You can use HP Web Jetadmin or the MFP’s embedded Web server to configure the system to alert
you of problems with the MFP. The alerts take the form of e-mail messages to the e-mail account or
accounts that you specify.

You can configure the following:

● The printer(s) you want to monitor

● What alerts are to be received (for example, alerts for paper jams, paper out, supplies status, and
cover open)

● The e-mail account to which the alerts should be forwarded

Software Information location

HP Web Jetadmin See the HP Web Jetadmin Help system for details on alerts
and how to set them up.

Embedded Web server See Embedded Web server on page 54 for general information
about the embedded Web server.

See the embedded Web server Help system for details on
alerts and how to set them up.
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Manage supplies
Use genuine HP print cartridges for the best printing results.

HP print cartridges
When you use a genuine new HP print cartridge, you can obtain the following supplies information:

● Percentage of supplies remaining

● Estimated number of pages remaining

● Number of pages printed

NOTE: See Supplies and accessories on page 229 for cartridge ordering information.

Non-HP print cartridges
Hewlett-Packard Company cannot recommend the use of non-HP print cartridges, either new or
remanufactured. Service or repair required as a result of using a non-HP print cartridge will not be
covered under the MFP warranty.

If the non-HP print cartridge was sold to you as a genuine HP product, see HP fraud hotline
on page 170.

Print cartridge authentication
The HP LaserJet M9059 MFP automatically authenticates the print cartridges when the cartridges are
inserted into the MFP. During authentication, the MFP will let you know if a cartridge is a genuine HP print
cartridge.

If the MFP control panel message states that this is not a genuine HP print cartridge and you believe
you purchased an HP print cartridge, call the HP fraud hotline.

To override a non-HP print cartridge error message, touch OK.

HP fraud hotline
Contact the HP fraud hotline if you install an HP print cartridge and a message on the control panel
states that the cartridge is non-HP. HP will help determine if the product is genuine and take steps to
resolve the problem.

The following issues are signs that your print cartridge might not be a genuine HP print cartridge:

● A high number of problems occur with the print cartridge.

● The cartridge does not look like it usually does (for example, the packaging differs from HP
packaging).

Go to www.hp.com/sbso/product/supplies/whybuy_fraud.html for more information.

Print cartridge storage
Do not remove the print cartridge from its package until you are ready to use it.

CAUTION: To prevent damage to the print cartridge, do not expose it to light for more than a few
minutes.
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Table 11-1  Print cartridge temperature specifications

Environmental condition Recommended Allowed Storage/standby

Temperature (print cartridge) 17° to 25°C (62.6° to 77°F) 15° to 30°C (59° to 86°F) -20° to 40°C (-4° to 104°F)

Print cartridge life expectancy
Average cartridge yield is 38,000 pages in accordance with ISO/IEC 19752. Actual yield depends on
specific use.

Check the print cartridge life
You can check the print cartridge life on the MFP control panel, in the embedded Web server, MFP
software, or through the HP Web Jetadmin software.

On the MFP control panel
1. From the Home screen, touch Administration.

2. Touch Information.

3. Touch Configuration Page.

4. Touch Supplies Status Page.

5. Touch Print.

NOTE: If you are using non-HP supplies, the supplies status page might not show the remaining life
for those supplies.

In the embedded Web server
1. In your browser, type the IP address or host name for the printer home page. This takes you to the

printer status page.

2. On the left side of the screen, click Supplies Status. This takes you to the supplies status page,
which provides print cartridge information.

Through HP Web Jetadmin
In HP Web Jetadmin, select the printer device. The device status page shows print cartridge information.
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Printer maintenance kit
NOTE: The printer maintenance kit is a consumable and is not covered under warranty.

To ensure optimum print quality, HP recommends that a new printer maintenance kit be installed
approximately every 350,000 pages. Depending on how you use the MFP, you might need to replace
the kit more often.

When the Replace maintenance kit message appears on the control panel, a printer maintenance kit is
needed to install the new parts. The part number for the 110V kit is C9152A. The part number for the
220V kit is C9153A. The printer maintenance kit contains two Type 1 rollers, seven Type 2 rollers, one
transfer roller assembly, and one fuser assembly. Complete instructions for installing the kit components
are included in the printer maintenance kit box.
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Manage memory
The MFP has two double data rate (DDR) DIMM slots to provide more MFP memory. DDR DIMMs are
available in 64, 128, and 256 MB, for a maximum of 512 MB.

The MFP has two compact flash slots to provide the following features:

● To add flash-based memory accessory fonts, macros, and patterns, use the appropriate DDR
DIMM.

● To add other flash-based printer languages and MFP options, use the appropriate DDR DIMM.

NOTE: Single in line memory modules (SIMMs) used on previous HP LaserJet products are not
compatible with this MFP.

For ordering information, go to www.hp.com/support/ljm9059mfp.

Determine memory requirements
The amount of memory you need depends on the types of documents you print. Your MFP can print
most text and graphics at 1200 dpi FastRes without additional memory.

You might want to add more memory to the MFP if you often print complex graphics or PS documents,
print two-sided documents (duplex printing), use many downloaded fonts, or print large paper sizes
(such as A3, B4, or 11 x 17). 

Install memory
Use this procedure to install additional DDR memory DIMMs. Before you begin, print a configuration
page to find out how much memory is installed in the MFP. The following table lists the maximum amount
of memory allowed for each DIMM slot.

Slot label on the Configuration page Slot label on the Formatter board Description

Slot 1 J1 256 MB

Slot 2 J2 128 MB

Total  384 MB

CAUTION: Static electricity can damage DDR DIMMs. When handling DDR DIMMs, either wear an
antistatic wrist strap or frequently touch the surface of the DIMM antistatic package, and then touch bare
metal on the MFP.

1. If you have not already done so, print a configuration page to find out how much memory is installed
in the MFP.

2. Slide the optional output device away from the print engine.

Figure 11-23  Install DDR memory DIMMs (1 of 8)

ENWW Manage memory 173

http://www.hp.com/support/ljm9059mfp


3. Turn the MFP off. Disconnect the power cord and any cables.

Figure 11-24  Install DDR memory DIMMs (2 of 8)

4. Loosen the two captive thumb screws on the back of the MFP.

Figure 11-25  Install DDR memory DIMMs (3 of 8)

5. Grasp the screws and pull the formatter board out of the MFP. Place it on a flat, non-conductive
surface.

Figure 11-26  Install DDR memory DIMMs (4 of 8)

6. Remove the DIMM from the antistatic package. Hold the DIMM with fingers against the side edges
and thumbs against the back edge. Align the notches on the DIMM with the DIMM slot. (Check that
the locks on each side of the DIMM slot are open, or outward.)

Figure 11-27  Install DDR memory DIMMs (5 of 8)
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7. Press the DIMM straight into the slot (press firmly). Make sure the locks on each side of the DIMM
snap inward into place. (To remove a DIMM, the locks must be released.)

Figure 11-28  Install DDR memory DIMMs (6 of 8)

8. Slide the formatter board back into the MFP and tighten the two screws.

Figure 11-29  Install DDR memory DIMMs (7 of 8)

9. Plug in the power cord and connect all cables. Turn the MFP on.

Figure 11-30  Install DDR memory DIMMs (8 of 8)

10. Reconnect the optional output device to the MFP.
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Verify memory installation
Follow this procedure to verify that DDR DIMMs are installed correctly:

1. Check that the MFP control panel displays Ready when the MFP is turned on. If an error message
appears, a DIMM might have been incorrectly installed.

2. Print the configuration page.

3. Check the memory section on the configuration page and compare it to the configuration before
the DIMM installation. If the amount of memory has not increased, one of the following situations
might have occurred:

● The DIMM might not be installed correctly. Repeat the installation procedure.

● The DIMM might be defective. Try a new DIMM, or try installing the DIMM in a different slot.

NOTE: If you installed a printer language (personality), check the Installed Personalities and Options
section on the configuration page. This area should list the new printer language.

176 Chapter 11   Manage and maintain ENWW



Economy settings
Sleep and wake

Set the sleep delay

Use the sleep-delay feature to set the period of time that the MFP must be idle before it enters the sleep
mode. The default setting is 45 minutes.

1. Scroll to and touch Administration.

2. Touch Time/Scheduling.

3. Touch Sleep Delay.

4. Touch the sleep-delay setting that you want.

Set the sleep time

Use the sleep time feature to put the MFP in sleep mode at a set time each day.

1. Scroll to and touch Administration.

2. Touch Time/Scheduling.

3. Touch Sleep Time.

4. Touch the day of the week for the sleep time.

5. Touch Custom.

6. Touch Save.

7. Touch the appropriate options to set the correct hour, minute, and AM/PM setting.

8. If you want to put the MFP in sleep mode at the same time every day (including weekends), on the
Apply to All Days screen, touch Yes. If you want to set the time for individual days, touch No, and
repeat the procedure for each day.

Set the wake time

Use the wake time feature to wake the MFP at a set time each day.

1. Scroll to and touch Administration.

2. Touch Time/Scheduling.

3. Touch Wake Time.

4. Touch the day of the week for the wake time.

5. Touch Custom.

6. Touch Save.
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7. Touch the appropriate options to set the correct hour, minute, and AM/PM setting.

8. If you want to wake the MFP at the same time every day (including weekends), on the Apply to
All Days screen, touch Yes. If you want to set the time for individual days, touch No, and repeat
the procedure for each day.
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12 Problem solve

● Solve problems

● Determining Solve MFP problems

● Control-panel message types

● Control-panel messages

● Clear jams

● Media-handling problems

● Solve print-quality problems

● Solve fax problems

● Solve copy problems

● Solve e-mail problems

● Solve network connectivity problems

● Solve common Macintosh problems

ENWW 179



Solve problems
If the MFP is not responding correctly, complete the steps in the following checklist, in order. If the MFP
does not pass a step, follow the corresponding troubleshooting suggestions. If a step resolves the
problem, you can stop without performing the other steps on the checklist.

Troubleshooting checklist
1. Make sure that the MFP Ready light is on. If no lights are on, complete these steps:

a. Check the power-cable connections.

b. Check that the power switch is on.

c. Check the power source by plugging the MFP directly into the wall or into a different outlet.

d. If none of these measures restores power, contact your dealer for support.

2. Check the cabling.

a. Check the cable connection between the MFP and the computer or network port. Make sure
that the connection is secure.

b. Make sure that the cable itself is not faulty by using a different cable, if possible.

c. Check the network connection. See Solve network connectivity problems on page 224.

3. Ensure that the print media that you are using meets specifications.

4. Print a configuration page (see Information pages on page 146). If the MFP is connected to a
network, an HP Jetdirect page also prints.

a. If the pages do not print, check that at least one tray contains print media.

b. If the page jams in the MFP, see Clear jams on page 184.

5. If the configuration page prints, check the following items.

a. If the page prints correctly, then the MFP hardware is working. The problem is with the
computer you are using, with the printer driver, or with the program.

b. If the page does not print correctly, the problem is with the MFP hardware. Contact your dealer
for support.

6. Verify that you have installed the HP LaserJet M9059 MFP printer driver.

7. Print a short document from a different program that has worked in the past. If this solution works,
then the problem is with the program you are using. If this solution does not work, try printing the
job from another computer that has the MFP software installed.

8. If the problem is still not resolved, see Determining Solve MFP problems on page 181.
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Determining Solve MFP problems
Situation/Message Solution

The control-panel display is blank, and internal fans are not
running.

Make sure that the MFP power is on. Press all the keys to see
if one is stuck. Contact your HP-authorized service
representative if these steps do not work.

The MFP is turned on, but the internal fans are not running. Make sure that the line voltage is correct for the MFP power
configuration. (See the label on the back of the device for
voltage requirements.) If you are using a power strip and its
voltage is not within specification, plug the MFP directly into
the power receptacle.

The MFP voltage is not correct. Make sure that the line voltage is in the correct range. (See the
label on the back of the device for voltage requirements.)

Messages appear on the control-panel display. See Control-panel messages on page 183.

Print media is jammed in the MFP. Check for jams. For more information, see Clear jams
on page 184.

The control-panel display shows the wrong language or
unfamiliar characters.

Reconfigure the control-panel display language.

Turn the MFP off and then on.

Administration > Device Behavior >  Language

An error occurs during a Digital Send job. Job failed. The MFP experienced an error during the digital sending job.
The administrator should check on the status of the SMTP
server. See Solve e-mail problems on page 223.

The e-mail gateway could not accept the job because the
attachment is too large.

Reduce the size of the e-mail attachment by setting the
maximum attachment size. Set the maximum attachment size
on the Digital Sending tab of the embedded Web server. See
Embedded Web server on page 148.

Try using a different file format or sending the document a few
pages at a time.

A network connection is required for digital sending The MFP cannot find a network connection. The administrator
should check to see if the MFP is connected to the network.
See Solve network connectivity problems on page 224.
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Control-panel message types
Four types of control-panel messages can indicate the status of or problems with the device.

Message type Description

Status messages Status messages reflect the current state of the device. They inform you of normal device operation
and require no interaction to clear them. They change as the state of the device changes. Whenever
the device is ready, not busy, and has no pending warning messages, the status message Ready
appears if the device is online.

Warning messages Warning messages inform you of data and print errors. These messages typically alternate with the
Ready or status messages and remain until you touch OK. Some warning messages are clearable.
If Clearable Warnings is set to Job on the device Device Behavior menu, the next print job clears
these messages.

Error messages Error messages communicate that some action must be performed, such as adding paper or clearing
a jam.

Some error messages are auto-continuable. If Auto Continue is set on the menus, the device will
continue normal operation after an auto-continuable error message appears for 10 seconds.

NOTE: Pressing any button during the 10-second auto-continuable error message overrides the
auto-continue feature, and the button function takes precedence. For example, pressing the Stop
button pauses printing and offers the option to cancel the print job.

Critical-error messages Critical error messages inform you of a device failure. Some of these messages can be cleared by
turning the device off and then on. These messages are not affected by the Auto Continue setting.
If a critical error persists, service is required.
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Control-panel messages
The product provides robust control panel messaging. When a message appears on the control panel,
follow the on-screen instructions to resolve the issue. If the product displays an “Error” or “Attention”
message, and no steps are shown to resolve the issue, turn the product off then on. Contact your dealer
for support if you continue to experience issues with the product.

To get additional information for warnings that appear in the status line, touch the Warning button .

For additional information on a variety of topics, touch the Help button  in the upper-right corner of the
home screen.
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Clear jams
If a jam message appears on the control panel, look for media in the locations indicated in the following
illustration. You might need to look for jammed media in locations other than those that are indicated in
the jam message. If the location of the jam is not obvious, look first in the front door area.

After looking at the illustration, you can go to the procedure for clearing the jam. When clearing jams,
be very careful not to tear the media. If a small piece of media remains in the MFP, it could cause
additional jams. If jams are a recurring problem, see Solve repeated jams on page 202.

NOTE: Loose toner might remain in the MFP after a jam and cause output quality problems. These
should clear up within a few pages.

WARNING! Surfaces in and around the MFP can be hot to the touch. Turn off the MFP and allow it to
cool before attempting to clear jams.

Jam locations   

Figure 12-1  HP LaserJet M9059 MFP with the 3000-sheet stapler/stacker

1 ADF

2 Tray 1

3 Right door

4 Vertical transfer door

5 Tray 4

6 Trays 2 and 3

7 Left door (behind the output device)

8 Duplexer (inside the MFP)

9 Output device

10 Lower bin

11 Front door and print-cartridge area

12 Upper bin
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Clear jams from the duplexer
1. Move the output device away from the MFP to gain access to the left door.

Figure 12-2  Clear jams in the duplex printing accessory (1 of 6)

2. Open the left door and carefully pull out any paper from area.

WARNING! Avoid touching the adjacent fusing area. It can be hot.

Figure 12-3  Clear jams in the duplex printing accessory (2 of 6)

3. Remove the duplex printing accessory by pressing the green lever and pulling the unit out until it
stops.

Figure 12-4  Clear jams in the duplex printing accessory (3 of 6)

4. Remove any paper by lifting the two green levers in the duplex printing accessory.

5. Open the front door.

Figure 12-5  Clear jams in the duplex printing accessory (4 of 6)
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6. Check for paper in the duplex printing accessory area, and remove any paper by pulling it out of
the MFP. Be careful not to tear the paper.

Figure 12-6  Clear jams in the duplex printing accessory (5 of 6)

7. Reinstall the duplex printing accessory by sliding it back into the slot until it locks into place.

Figure 12-7  Clear jams in the duplex printing accessory (6 of 6)

8. Close all open doors. Push the output device back into place.

Clear jams from the input-tray areas

Clear jams in tray 1

1. Check for media in the tray 1 area, and remove any media from this area. Carefully check to be
sure you have removed all pieces of torn media.

Figure 12-8  Clear jams in tray 1 (1 of 2)

2. Open and close the right door to reset the MFP.

Figure 12-9  Clear jams in tray 1 (2 of 2)
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Clear jams inside the right door

1. Open the right door.

Figure 12-10  Clear jams inside the right door (1 of 3)

2. Check for media in the right door area, and remove any media from this area. Carefully check to
be sure you have removed all pieces of torn media.

3. Open the jam access cover. Pull out and lift the green tab.

Figure 12-11  Clear jams inside the right door (2 of 3)

4. Remove any media from this area by pulling it out of the MFP.

5. Push the green lever down to the original position.

Figure 12-12  Clear jams inside the right door (3 of 3)

6. Close the right door.
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Clear jams in trays 2 and 3

1. Open the tray until it stops.

Figure 12-13  Clear jams in trays 2 and 3 (1 of 3)

2. Check for media in the tray area, and remove any media from this area. Carefully check to be sure
you have removed all pieces of torn media.

3. Close the tray.

Figure 12-14  Clear jams in trays 2 and 3 (2 of 3)

4. Open the right door, remove any visible media, and close the right door. This resets the MFP.

Figure 12-15  Clear jams in trays 2 and 3 (3 of 3)

Clear jams in tray 4

1. Open the vertical transfer door on tray 4.

Figure 12-16  Clear jams in tray 4 (1 of 4)

2. Check for paper in this area, and remove any paper from this area. Carefully check to be sure that
you have removed all pieces of torn paper.
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3. If you did not see any paper in the vertical transfer door, open tray 4.

Figure 12-17  Clear jams in tray 4 (2 of 4)

4. Check for paper in the tray area, and remove any paper from this area. Carefully check to be sure
you have removed all pieces of torn paper.

5. Close tray 4.

Figure 12-18  Clear jams in tray 4 (3 of 4)

6. Close the vertical transfer door.

Figure 12-19  Clear jams in tray 4 (4 of 4)

Clear jams from the output areas

Clear jams in the stacker or stapler/stacker 

1. If the jam extends into the output bins, slowly and carefully pull the media straight out of the MFP
so that it does not tear.

Figure 12-20  Clear jams in the stacker or stapler/stacker (1 of 7)
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2. Move the output device away from the MFP.

Figure 12-21  Clear jams in the stacker or stapler/stacker (2 of 7)

3. On the stacker, lift the wire on the lower bin of the device, and carefully pull out any media from
this area. On the stapler/stacker, carefully pull out any media that might be protruding from the
accumulator area.

NOTE: Only the stacker has the wire on the lower bin.

Figure 12-22  Clear jams in the stacker or stapler/stacker (3 of 7)

4. Locate the green handle in the flipper area and lift the handle.

Figure 12-23  Clear jams in the stacker or stapler/stacker (4 of 7)

5. Carefully pull out any media from the flipper area.

Figure 12-24  Clear jams in the stacker or stapler/stacker (5 of 7)

WARNING! Avoid touching the flipper area. It can be hot.
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6. Locate the green handle in the paper path module, and then pull down on the handle.

Figure 12-25  Clear jams in the stacker or stapler/stacker (6 of 7)

7. Carefully pull out any media from the paper path module.

8. Close all open doors. Push the output device back into place.

Figure 12-26  Clear jams in the stacker or stapler/stacker (7 of 7)

Clear jams in the paper-path area of the multifunction finisher

1. Open the top cover.

Figure 12-27  Clear jams in the paper-path area of the multifunction finisher (1 of 3)

2. Slowly and carefully pull the paper straight out of the finisher so that it does not tear.

Figure 12-28  Clear jams in the paper-path area of the multifunction finisher (2 of 3)
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3. Close the finisher cover.

Figure 12-29  Clear jams in the paper-path area of the multifunction finisher (3 of 3)

Clear jams in between the multifunction finisher and the MFP

1. Move the finisher away from the MFP.

Figure 12-30  Clear jams in between the multifunction finisher and the MFP (1 of 4)

2. Carefully remove any paper from the MFP output area.

Figure 12-31  Clear jams in between the multifunction finisher and the MFP (2 of 4)

3. Carefully remove any paper from the finisher input area.

Figure 12-32  Clear jams in between the multifunction finisher and the MFP (3 of 4)
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4. Push the multifunction finisher back into place.

Figure 12-33  Clear jams in between the multifunction finisher and the MFP (4 of 4)

Clear booklet jams in the multifunction finisher

1. Move the finisher away from the MFP.

Figure 12-34  Clear booklet jams in the multifunction finisher (1 of 7)

2. If paper is jammed in the finisher input area but has not entered the folding rollers, carefully remove
the paper from the input area and then skip to step 7.

Figure 12-35  Clear booklet jams in the multifunction finisher (2 of 7)

3. Open the back door on the finisher. If jammed paper inside the finisher has not entered the folding
rollers, remove the paper and then skip to step 7. If the paper has entered the folding rollers,
proceed to step 4.

Figure 12-36  Clear booklet jams in the multifunction finisher (3 of 7)
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4. Open the stapler-unit door.

Figure 12-37  Clear booklet jams in the multifunction finisher (4 of 7)

5. Turn the bottom green knob clockwise to advance the jammed paper through the folding rollers
and into the booklet bin.

Figure 12-38  Clear booklet jams in the multifunction finisher (5 of 7)

6. Close the stapler-unit door.

Figure 12-39  Clear booklet jams in the multifunction finisher (6 of 7)

7. Push the multifunction finisher back into place.

Figure 12-40  Clear booklet jams in the multifunction finisher (7 of 7)
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Clear a staple jam from the multifunction finisher

1. Open the stapler-unit door.

Figure 12-41  Clear a staple jam from the multifunction finisher (1 of 11)

2. Slide the stapler unit toward you.

Figure 12-42  Clear a staple jam from the multifunction finisher (2 of 11)

3. Turn the large green knob until you see the blue dot (this indicates that the stapler is fully open).

Figure 12-43  Clear a staple jam from the multifunction finisher (3 of 11)

4. Turn the small green knob at the top of the stapler unit clockwise until the staple cartridge moves
to the left of the stapler unit.

Figure 12-44  Clear a staple jam from the multifunction finisher (4 of 11)

CAUTION: The blue dot must appear in the window of the stapler unit before you remove the
staple cartridge. If you try to remove the staple cartridge before the blue dot appears in the window,
you could damage the device.
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5. Remove the staple cartridge.

Figure 12-45  Clear a staple jam from the multifunction finisher (5 of 11)

6. Pull up on the lever labeled with a green dot.

Figure 12-46  Clear a staple jam from the multifunction finisher (6 of 11)

7. Remove the damaged staple.

Figure 12-47  Clear a staple jam from the multifunction finisher (7 of 11)

8. Press down on the lever labeled with a green dot.

Figure 12-48  Clear a staple jam from the multifunction finisher (8 of 11)
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9. Reinstall the staple cartridge.

Figure 12-49  Clear a staple jam from the multifunction finisher (9 of 11)

10. Slide the stapler unit into the device.

Figure 12-50  Clear a staple jam from the multifunction finisher (10 of 11)

11. Close the stapler-unit door.

Figure 12-51  Clear a staple jam from the multifunction finisher (11 of 11)

Clear a jam in the upper half of the stapler head in the multifunction finisher

1. Follow steps 1 through 4 of the procedure to clear a staple jam from the multifunction finisher.

2. Locate the damaged staple at the back of the stapler head, and remove the staple.

Figure 12-52  Clear a jam in the upper half of the stapler head in the multifunction finisher

3. Follow steps 10 through 11 from the procedure to clear a staple jam from the multifunction finisher.
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Clear a staple jam from the stapler/stacker  

1. Move the stapler/stacker away from the MFP.

Figure 12-53  Clear a staple jam from the stapler/stacker (1 of 9)

2. Open the stapler unit door.

Figure 12-54  Clear a staple jam from the stapler/stacker (2 of 9)

3. Pull the cartridge out.

Figure 12-55  Clear a staple jam from the stapler/stacker (3 of 9)

4. Pull up on the lever labeled with a green dot.

Figure 12-56  Clear a staple jam from the stapler/stacker (4 of 9)
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5. Remove the damaged staple.

Figure 12-57  Clear a staple jam from the stapler/stacker (5 of 9)

6. Press down on the lever labeled with a green dot.

Figure 12-58  Clear a staple jam from the stapler/stacker (6 of 9)

7. Reinstall the staple cartridge.

Figure 12-59  Clear a staple jam from the stapler/stacker (7 of 9)

8. Close the stapler unit door.

Figure 12-60  Clear a staple jam from the stapler/stacker (8 of 9)

ENWW Clear jams 199



9. Push the stapler/stacker back into place.

Figure 12-61  Clear a staple jam from the stapler/stacker (9 of 9)

NOTE: The stapler needs to reload after clearing a staple jam, so the first few documents (no more
than five) might not be stapled. If a print job is sent and the stapler is jammed or is out of staples, the
job will still print as long as the path to the output bin is not blocked.

Clear jams in the left door (fuser area)

1. Move the output device away from the MFP to gain access to the left door.

Figure 12-62  Clear jams in the left door (1 of 4)

2. Open the left door.

WARNING! Avoid touching the adjacent fusing area. It can be hot.

Figure 12-63  Clear jams in the left door (2 of 4)

3. Remove any jammed or damaged media from this area by pulling it out of the MFP.
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4. Press down on the green tab and carefully check for media. Be sure to remove all pieces of torn
media.

Figure 12-64  Clear jams in the left door (3 of 4)

5. Close the left door. Push the output device back into place.

Figure 12-65  Clear jams in the left door (4 of 4)

Clear jams in the 8-bin mailbox

1. Move the 8-bin mailbox away from the MFP. To do this, stand on the left side of the MFP and pull
the 8-bin mailbox straight toward you.

Figure 12-66  Clear jams in the 8-bin mailbox (1 of 3)

2. Carefully remove the upper (face-up) bin.

3. Pull down the handle on the output paper module and remove any jammed paper from this area.

Figure 12-67  Clear jams in the 8-bin mailbox (2 of 3)

ENWW Clear jams 201



4. Push the 8-bin mailbox back into place, and then reattach the upper bin.

Figure 12-68  Clear jams in the 8-bin mailbox (3 of 3)

NOTE: Check that the paper used is not thicker than the 8-bin mailbox supports. See Supported paper
and print media sizes on page 77.

Solve repeated jams

Situation Solution

General repeated jam problems 1. Verify that the media is correctly loaded in the trays and that
all width guides are correctly set (see Print tasks on page 93).

2. Verify that the paper tray is set for the size of media installed
and that the tray is not overloaded.

3. Try turning over the stack of media in the tray. If you are
using prepunched or letterhead paper, try printing from tray 1.

4. Do not use previously printed media or torn, worn, or
irregular media. For recommended media for your MFP, see
Supported paper and print media sizes on page 77.

5. Check the media specifications. (See Supported paper and
print media sizes on page 77.) If media is outside of the
recommended specifications, problems can occur.

6. MFP might be dirty. Clean the MFP as described in Clean
the MFP on page 161.

7. Check that all damaged or jammed media is removed from
MFP.

Repeated jams in the ADF 1. The ADF might be dirty. Clean the ADF as described in
Clean the ADF delivery system on page 163.

NOTE: If jams continue, contact your dealer for support, or go to www.hp.com/support/ljm9059mfp.
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Media-handling problems
Use only media that meets the specifications outlined in the HP LaserJet Printer Family Print Media
Guide. This guide is available at www.hp.com/support/ljpaperguide.

Printer feeds multiple sheets
Printer feeds multiple sheets

Cause Solution

The input tray is overfilled. Remove excess media from the input tray.

Print media is sticking together. Remove media, flex it, rotate it 180° or flip it over, and then
reload it into the tray.

NOTE: Do not fan media. Fanning can cause static
electricity, which can cause media to stick together.

Media does not meet the specifications for this MFP. Use only media that meets HP media specifications for this
MFP.

Trays are not properly adjusted. Make sure that the rear media-length guide indicates the
length of media being used.

Printer feeds incorrect page size
Printer feeds incorrect page size

Cause Solution

The correct size media is not loaded in the input tray. Load the correct size media in the input tray.

The correct size media is not selected in the software program
or printer driver.

Confirm that the settings in the software program and printer
driver are correct, because the software-program settings
override the printer-driver and control-panel settings, and the
printer-driver settings override the control-panel settings. For
more information, see Change printer-driver settings for
Windows on page 53.

The correct size media for tray 1 is not selected in the MFP
control panel.

From the control panel, select the correct size media for tray
1.

The media size is not configured correctly for the input tray. Print a configuration page or use the control panel to determine
the media size for which the tray is configured.

The guides in the tray are not against the paper. Verify that the rear and width media guides are touching the
paper.

Printer pulls from incorrect tray
Printer pulls from incorrect tray

Cause Solution

You are using a driver for a different printer. For more
information.

Use a driver for this printer.

The specified tray is empty. Load media in the specified tray.
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Printer pulls from incorrect tray

Cause Solution

The Use Requested Tray option is set to First in the Tray
Behavior sub-menu of the Device Behavior menu.

Change the setting to Exclusively.

The media size is not configured correctly for the input tray. Print a configuration page or use the control panel to determine
the media size for which the tray is configured.

The guides in the tray are not against the paper. Verify that the guides are touching the paper.

Media does not feed automatically
Media does not feed automatically

Cause Solution

Manual feed is selected in the software program. Load tray 1 with media, or, if the media is loaded, touch OK.

The correct size media is not loaded. Load the correct size media.

The input tray is empty. Load media into the input tray.

Media from a previous jam has not been completely removed. Open the MFP and remove any media in the paper path.
Closely inspect the fuser area for jams.

The media size is not configured correctly for the input tray. Print a configuration page or use the control panel to determine
the media size for which the tray is configured.

The guides in the tray are not against the paper. Verify that the rear and width media guides are touching the
paper.

Media does not feed from tray 2, 3, or 4
Media does not feed from tray 2, 3, or 4

Cause Solution

The correct size media is not loaded. Load the correct size media and verify that the custom-media
switch is in the correct position.

The input tray is empty. Load media in the input tray.

The correct media type for the input tray is not selected in the
MFP control panel.

From the MFP control panel, select the correct media type for
the input tray.

Media from a previous jam has not been completely removed. Open the MFP and remove any media in the paper path.
Closely inspect the fuser area for jams.

None of the optional trays appear as input tray options. The optional trays only display as available if they are installed.
Verify that any optional trays are correctly installed. Verify that
the printer driver has been configured to recognize the optional
trays.

An optional tray is incorrectly installed. Print a configuration page to confirm that the optional tray is
installed. If not, verify that the tray is correctly attached to the
MFP.
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Media does not feed from tray 2, 3, or 4

Cause Solution

The media size is not configured correctly for the input tray. Print a configuration page or use the control panel to determine
the media size for which the tray is configured.

The guides in the tray are not against the paper. Verify that the guides are touching the paper.

Transparencies will not feed
Transparencies will not feed

Cause Solution

The correct media type is not specified in the software or printer
driver.

Verify that the correct media type is selected in the software or
printer driver.

Tray 1 is overfilled. Remove excess transparencies from tray 1. Do not exceed the
maximum stack height for tray 1.

Media in another input tray is the same size as the
transparencies, and the MFP is defaulting to the other tray.

Make sure that tray 1 is selected in the software program or
printer driver. Use the MFP control panel to configure the tray
to the media type loaded.

Tray 1 is not configured correctly for type. Make sure that tray 1 is selected in the software program or
printer driver. Use the MFP control panel to configure the tray
to the media type loaded.

Transparencies might not meet supported media
specifications.

Use only media that meets the HP media specifications for this
MFP.

Envelopes jam or will not feed in the MFP
NOTE: Return the fuser levers to the down position after printing on envelopes. Failure to return levers
to the down position for standard paper types can result in poor print quality.

Envelopes jam or will not feed in the MFP

Cause Solution

Envelopes are loaded in an unsupported tray. Only tray 1 can
feed envelopes.

Load envelopes into tray 1.

Envelopes are curled or damaged. Verify that the fuser levers are in the correct position. Try using
different envelopes. Store envelopes in a controlled
environment.

Envelopes are sealing because the moisture content is too
high.

Try using different envelopes. Store envelopes in a controlled
environment.

Envelope orientation is incorrect. Verify that the envelope is loaded correctly.

This MFP does not support the envelopes being used. Refer to the HP LaserJet Printer Family Print Media Guide.

Tray 1 is configured for a size other than envelopes. Configure tray 1 size for envelopes.
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Output is curled or wrinkled
Output is curled or wrinkled

Cause Solution

Media does not meet the specifications for this MFP. Use only media that meets the HP media specifications for this
MFP.

Media is damaged or in poor condition. Remove media from the input tray and load media that is in
good condition.

Printer is operating in an excessively humid environment. Verify that the printing environment is within humidity
specifications.

You are printing large, solid-filled areas. Large, solid-filled areas can cause excessive curl. Try using a
different pattern.

Media used was not stored correctly and might have absorbed
moisture.

Remove media and replace it with media from a fresh,
unopened package.

Media has poorly cut edges. Remove media, flex it, rotate it 180 degrees or turn it over, and
then reload it into the input tray. Do not fan media. If the
problem persists, replace the media.

The specific media type was not configured for the tray or
selected in the software.

Configure the software for the media (see the software
documentation). To configure the tray for the media, see
Configure trays on page 88.

Printer will not duplex or duplexes incorrectly
Printer will not duplex or duplexes incorrectly

Cause Solution

You are trying to duplex on unsupported media. Verify that the media is supported for duplex printing.

The printer driver is not set up for duplex printing. Set up the printer driver to enable duplex printing.

The first page is printing on the back of preprinted forms or
letterhead.

Load preprinted forms and letterhead in tray 1 with the
letterhead or printed side up and the bottom of the page
feeding into the MFP. For tray 2, 3, and 4, load these media
printed side down with the top of the page toward the back of
the MFP.
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Solve print-quality problems
This section helps you define print-quality problems and what to do to correct them. Often print- quality
problems can be handled easily by making sure that the device is correctly maintained, using print media
that meets HP specifications, or running a cleaning page.

Print-quality problems associated with media
Some print-quality problems arise from the use of inappropriate media.

● Use media that meets HP specifications. See Supported paper and print media sizes
on page 77, or see the HP LaserJet Printer Family Print Media Guide, which is available at
www.hp.com/support/ljpaperguide.

● The surface of the media is too smooth. Use media that meets HP specifications. See Supported
paper and print media sizes on page 77.

● The moisture content is uneven, too high, or too low. Use media from a different source or from an
unopened ream.

● Some areas of the media reject toner. Use media from a different source or from an unopened
ream.

● The letterhead you are using is printed on rough media. Use a smoother, xerographic media. If this
solves your problem, ask the supplier of your letterhead to use media that meets the specifications
for this device. See Supported paper and print media sizes on page 77.

● The media is excessively rough. Use a smoother, xerographic media.

● The driver setting is incorrect. To change the media type setting, see Change printer-driver settings
for Windows on page 53.

● The media that you are using is too heavy for the media type setting that you selected, and the
toner is not fusing to the media. See Default Options for Originals on page 17.

Print-quality problems associated with the environment
If the device is operating in excessively humid or dry conditions, verify that the printing environment is
within specifications. See Operating environment on page 236.

Print-quality problems associated with jams
Make sure that all sheets are cleared from the paper path. See Clear jams on page 184.

● If the device recently jammed, print two to three pages to clean the device.

● If the sheets do not pass through the fuser and cause image defects on subsequent documents,
print three pages to clean the device. If the problem persists, print and process a cleaning page.
See Clean the MFP on page 161.
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Light print (partial page)
Figure 12-69  Light print (partial page)

1. Make sure that the print cartridge is fully installed.

2. The print cartridge might be defective. Replace the print cartridge.

3. The media might not meet HP specifications (for example, the media is too moist or too rough).
See Supported paper and print media sizes on page 77.

Light print (entire page)
Figure 12-70  Light print (entire page)

1. Make sure that the print cartridge is fully installed.

2. Make sure that the Economode setting is turned off at the control panel and in the printer driver.

3. Open the Administration menu at the device control panel. Open the Print Quality menu and
increase the Toner Density setting. See Print Quality menu on page 42.

4. Try using a different type of media.

5. The print cartridge might be defective. Replace the print cartridge.
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Specks
Figure 12-71  Specks

Specks might appear on a page after a jam has been cleared.

1. Print a few more pages to see if the problem corrects itself.

2. Clean the inside of the device and run a cleaning page. See Clean the MFP on page 161.

3. Try using a different type of media.

4. Check the print cartridge for leaks. If the print cartridge is leaking, replace it.

Dropouts 
Figure 12-72  Dropouts

1. Make sure that the environmental specifications for the device are being met. See Operating
environment on page 236.

2. If the media is rough, and the toner easily rubs off, open the Administration menu at the device
control panel. Open the Print Quality menu, select Fuser Modes, and then select the media type
you are using. See Print Quality menu on page 42.

3. Try using a smoother media.
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Lines  
Figure 12-73  Lines
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1. Print a few more pages to see if the problem corrects itself.

2. Clean the inside of the device and run a cleaning page. See Clean the MFP on page 161.

3. Replace the print cartridge.

Gray background  
Figure 12-74  Gray background

1. Do not use media that has already been run through the device.

2. Try using a different type of media.

3. Print a few more pages to see if the problem corrects itself.

4. Turn over the stack in the tray. Also, try rotating the stack 180°.

5. Open the Administration menu at the device control panel. On the Print Quality menu, increase the
Toner Density setting. See Print Quality menu on page 42.

6. Make sure that the environmental specifications for the device are being met. See Operating
environment on page 236.

7. Replace the print cartridge.
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Toner smear 
Figure 12-75  Toner smear

1. Print a few more pages to see if the problem corrects itself.

2. Verify that the fuser levers are in the down position (unless printing on envelopes).

3. Try using a different type of media.

4. Make sure that the environmental specifications for the device are being met. See Operating
environment on page 236.

5. Clean the inside of the device and run a cleaning page. See Clean the MFP on page 161.

6. Replace the print cartridge.

Also see Loose toner on page 211.

Loose toner 
Figure 12-76  Loose toner

Loose toner, in this context, is defined as toner that can be rubbed off the page.

1. Verify that the fuser levers are in the down position (unless printing on envelopes).

2. If media is heavy or rough, open the Administration menu at the device control panel. On the Print
Quality submenu, select Fuser Modes, and then select the media type you are using.

3. If you have observed a rougher texture on one side of your media, try printing on the smoother
side.

4. Make sure that the environmental specifications for the device are being met. See Operating
environment on page 236.

5. Make sure that type and quality of the media you are using meet HP specifications. See Supported
paper and print media sizes on page 77.
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Repeating defects 
Figure 12-77  Repeating defects

1. Print a few more pages to see if the problem corrects itself.

2. If the distance between defects is 44 mm (1.73 in.), 53 mm (2.1 in.), 63 mm (2.5 in.), or 94 mm (3.7
in.), the print cartridge might need to be replaced.

3. Clean the inside of the device and run a cleaning page. See Clean the MFP on page 161.

Also see Repeating image on page 212.

Repeating image
Figure 12-78  Repeating image

Dear Mr. Abhjerhjk,

The dhjhfiuhu if teint hhkjhjnf j us a weue jd, fnk

ksneh vnk kjdfkaak d ss hsjhnckkajhdhf kashfhnduujdn.

Pkshkkhklhlkhkhyufwe4yrh9jjflklndjd skshkshdcnksnjcnal

aksnclnslskjlncsl nas lnslna, ncnsljsjscljckn nsnclknsllj

hwlsdknls nwljs nlnscl nijhsn clsnci j hn. Iosi fsjs jlkh andjna this

is a h n. jns fir stie a d jakjd a jjssk. Thsi ius vnvlu tyeh lch afted,

and when hghj hgjhk jdj a dt sonnleh .

Suolklv jsdj hvjkrt ten sutc of jthjkfjkn vjdj hwjd, an olk d

.a t fhjdjht ajshef . Sewlfl nv atug ahgjfjknvr kdkjdh sj hvjk

sjskrplo book . C amegaj d sand their djnln as orged tyehha

as as hf hv of the tinhgh in the cescmda l vlala tojk. Ho sn shj

shjkh a sjca kvkjn? No ahdkj ahhtuah ahavjn v hv vh a efve r

Tehreh ahkj vaknihidh was skjsaa a dhkjfn an j

cjkhapsldnlj llhfoihrfhthej ahjkkjna oa h j a kah w asj kskjnkas

sa fjkank cak ajhjkn eanjsd n qa e jhc p jtpvjlnv4purlaxnwl. Ana

l, and the a skeina of ahthvnasm . Sayhvjan tjhhjhrajn ve fh k

v nja vkfkahjd a . Smakkljl a s ehiah adheuf h if you do klakc k

w vka ah call lthe c jakha a a d a s d fijs.

Sincerel y,

Mr. Scmehnjcj

Dear Mr. Abhjerhjk,

The dhjhfiuhu if teint hhkjhjnf j us a weue jd, fnk

ksneh vnk kjdfkaak d ss hsjhnckkajhdhf kashfhnduujdn.

Pkshkkhklhlkhkhyufwe4yrh9jjflklndjd skshkshdcnksnjcnal

aksnclnslskjlncsl nas lnslna, ncnsljsjscljckn nsnclknsllj

hwlsdknls nwljs nlnscl nijhsn clsnci j hn. Iosi fsjs jlkh andjna this

is a h n. jns fir stie a d jakjd a jjssk. Thsi ius vnvlu tyeh lch afted,

and when hghj hgjhk jdj a dt sonnleh .

Suolklv jsdj hvjkrt ten sutc of jthjkfjkn vjdj hwjd, an olk d

.a t fhjdjht ajshef . Sewlfl nv atug ahgjfjknvr kdkjdh sj hvjk

sjskrplo book . C amegaj d sand their djnln as orged tyehha

as as hf hv of the tinhgh in the cescmda l vlala tojk. Ho sn shj

shjkh a sjca kvkjn? No ahdkj ahhtuah ahavjn v hv vh a efve r

Tehreh ahkj vaknihidh was skjsaa a dhkjfn an j

cjkhapsldnlj llhfoihrfhthej ahjkkjna oa h j a kah w asj kskjnkas

sa fjkank cak ajhjkn eanjsd n qa e jhc p jtpvjlnv4purlaxnwl. Ana

l, and the a skeina of ahthvnasm . Sayhvjan tjhhjhrajn ve fh k

v nja vkfkahjd a . Smakkljl a s ehiah adheuf h if you do klakc k

w vka ah call lthe c jakha a a d a s d fijs.

Sincerel y,

Mr. Scmehnjcj

This type of defect might occur when using preprinted forms or a large quantity of narrow media.

1. Print a few more pages to see if the problem corrects itself.

2. Make sure that type and quality of the media you are using meet HP specifications. See Supported
paper and print media sizes on page 77.

3. If the distance between defects is 44 mm (1.73 in.), 53 mm (2.1 in.), 63 mm (2.5 in.), or 94 mm (3.7
in.), the print cartridge might need to be replaced.
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Misformed characters
Figure 12-79  Misformed characters
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1. Print a few more pages to see if the problem corrects itself.

2. Make sure that the environmental specifications for the device are being met. See Operating
environment on page 236.

Page skew
Figure 12-80  Page skew

1. Print a few more pages to see if the problem corrects itself.

2. Verify that no torn pieces of media are inside the device.

3. Make sure that media is loaded correctly and that all adjustments have been made. See Load
paper and print media on page 81. Make sure that the guides in the tray are not too tight or too
loose against the media.

4. Turn over the stack in the tray. Also, try rotating the stack 180°.

5. Make sure that the type and quality of the media you are using meet HP specifications. See
Supported paper and print media sizes on page 77.

6. Make sure that the environmental specifications for the device are being met. (See Operating
environment on page 236.)

7. Perform a tray alignment by opening the Administration menu at the device control panel. On the
Print Quality submenu, touch Set Registration. Choose a tray under Source and then run a test
page. For more information, see Print Quality menu on page 42.
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Curl or wave 
Figure 12-81  Curl or wave

1. Turn over the stack in the tray. Also, try rotating the stack 180°.

2. Make sure that the type and quality of the media you are using meet HP specifications. (See
Supported paper and print media sizes on page 77.)

3. Make sure that the environmental specifications for the device are being met. (See Operating
environment on page 236.)

4. Try printing to a different output bin.

5. If media is lightweight and smooth, open the Administration menu at the device control panel. On
the Print Quality submenu, touch Fuser Modes, and then select the media type you are using.
Change the setting to Low, which helps reduce the heat in the fusing process.

Wrinkles or creases 
Figure 12-82  Wrinkles or creases

1. Print a few more pages to see if the problem corrects itself.

2. Make sure that the environmental specifications for the device are being met. See Operating
environment on page 236.

3. Turn over the stack in the tray. Also, try rotating the stack 180°.

4. Make sure that media is loaded correctly and all adjustments have been made. See Load paper
and print media on page 81.

5. Make sure that the type and quality of the media you are using meet HP specifications. See
Supported paper and print media sizes on page 77.

6. If envelopes are creasing, try storing envelopes so that they lie flat.

If the above actions do not improve wrinkles or creases, open the Administration menu at the device
control panel. On the Print Quality submenu, select Fuser Modes, and then select the media type you
are using. Change the setting to Low, which helps reduce the heat in the fusing process.
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Vertical white lines  
Figure 12-83  Vertical white lines

1. Print a few more pages to see if the problem corrects itself.

2. Make sure that the type and quality of the media you are using meet HP specifications. See
Supported paper and print media sizes on page 77.

3. Replace the print cartridge.

Tire tracks
Figure 12-84  Tire tracks
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This defect typically occurs when the print cartridge has far exceeded its rated life. For example, if you
are printing a very large quantity of pages with very little toner coverage.

1. Replace the print cartridge.

2. Reduce the number of pages that you print with very low toner coverage.

White spots on black 
Figure 12-85  White spots on black

1. Print a few more pages to see if the problem corrects itself.

2. Make sure that the type and quality of the media you are using meet HP specifications. See
Supported paper and print media sizes on page 77.

3. Make sure that the environmental specifications for the device are being met. See Operating
environment on page 236.

4. Replace the print cartridge.
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Scattered lines
Figure 12-86  Scattered lines

1. Make sure that the type and quality of the media you are using meet HP specifications. See
Supported paper and print media sizes on page 77.

2. Make sure that the environmental specifications for the device are being met. See Operating
environment on page 236.

3. Turn over the stack in the tray. Also, try rotating the stack 180°.

4. Open the Administration menu at the device control panel. Open the Print Quality submenu and
change the Toner Density setting. See Print Quality menu on page 42.

Blurred print 
Figure 12-87  Blurred print

1. Make sure that the type and quality of the media you are using meet HP specifications. See
Supported paper and print media sizes on page 77.

2. Make sure that the environmental specifications for the device are being met. See Operating
environment on page 236.

3. Turn over the stack in the tray. Also, try rotating the stack 180°.

4. Do not use media that already has been run through the device.

5. Decrease the toner density. Open the Administration menu at the device control panel. Open the
Print Quality submenu and change the Toner Density setting. See Print Quality menu
on page 42.
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Random image repetition
Figure 12-88  Random image repetition (1 of 2)

Figure 12-89  Random image repetition (2 of 2)

If an image that appears at the top of the page (in solid black) repeats further down the page (in a gray
field), the toner might not have been completely erased from the last job. (The repeated image might
be lighter or darker than the field it appears in.)

● Change the tone (darkness) of the field that the repeated image appears in.

● Change the order in which the images are printed. For example, have the lighter image at the top
of the page, and the darker image farther down the page.

● From your software program, rotate the whole page 180° to print the lighter image first.

● If the defect occurs later in a print job, turn the device off for 10 minutes, and then turn it on to
restart the print job.
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Solve fax problems
For help solving fax problems, see the Analog Fax Accessory 300 Fax Guide and the Analog Fax
Accessory 300 Send Fax Driver Guide.

You can also go to http://www.hp.com/go/mfpfaxaccessory300.
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Solve copy problems
Prevent copy problems

The following are a few simple steps you can take to improve copy quality:

● Copy from the flatbed scanner. This will produce a higher quality copy than copying from the
automatic document feeder (ADF).

● Use quality originals.

● Load the media correctly. If the media is loaded incorrectly, it might skew, causing unclear images
and problems with the OCR program. See Load paper and print media on page 81 for instructions.

● Use or make a carrier sheet to protect your originals.

Image problems

Problem Cause Solution

Images are missing or faded. The print cartridge might be defective. Replace the print cartridge. See Manage
supplies on page 170.

The original might be of poor quality. If your original is too light or damaged,
the copy might not be able to
compensate, even if you adjust the
darkness. If possible, find an original
document in better condition.

The original might have a colored
background.

Touch Copy, and then touch Image
Adjustment. Adjust the Background
Cleanup slider to the right to decrease
the background.

Vertical white or faded stripes appear on
the copy.

The media might not meet
HP specifications.

Use media that meets HP specifications.
See Supported paper and print media
sizes on page 77.

The print cartridge might be defective. Replace the print cartridge. See Manage
supplies on page 170.

Unwanted lines appear on the copy. The flatbed scanner or the ADF glass
might be dirty.

Clean the flatbed scanner or the ADF
glass. See Clean the MFP on page 161.

The photosensitive drum inside the print
cartridge might have been scratched.

Install a new HP print cartridge. See
Manage supplies on page 170.

Black dots or streaks appear on the
copy.

Ink, glue, correction fluid, or an unwanted
substance might be on the automatic
document feeder (ADF) or flatbed
scanner.

Clean the device. See Clean the MFP
on page 161.
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Problem Cause Solution

Copies are too light or dark. The darkness setting needs to be
adjusted.

Touch Copy, and then touch Image
Adjustment. Adjust the Darkness slider
to lighten or darken the image.

Text is unclear. The sharpness setting needs to be
adjusted.

The image should be optimized for text.

To adjust the sharpness, touch Copy,
and then touch Image Adjustment.
Adjust the Sharpness slider to the right to
increase the sharpness.

To optimize the image for text, touch
Copy and then touch Optimize Text/
Picture. Select Text.

Media-handling problems

Problem Cause Solution

Poor print quality or toner adhesion The paper is too moist, too rough, too
heavy or too smooth, or it is embossed
or from a faulty paper lot.

The fuser levers are not in the correct
position.

Try another kind of paper, between 100
and 250 Sheffield, 4 to 6% moisture
content. Use only media that meets the
specifications outlined in the
HP LaserJet Printer Family Print Media
Guide. This guide is available at
www.hp.com/support/ljpaperguide.

Verify that the fuser levers are in the
down position (unless printing on
envelopes).

Dropouts, jamming, or curl The paper has been stored incorrectly. Store paper flat in its moisture-proof
wrapping.

The paper has variability from one side
to the other.

Turn the paper over.

Excessive curl The paper is too moist, has the wrong
grain direction, or is of short-grain
construction

Try changing the fuser mode (see Print
Quality menu on page 42) or use long-
grain paper.

The paper varies from side-to-side. Turn the paper over.

Jamming, damage to device The paper has cutouts or perforations. Use paper that is free of cutouts or
perforations.

Problems with feeding The paper has ragged edges. Use high-quality paper that is made for
laser printers.

The paper varies from side-to-side. Turn the paper over.

The paper is too moist, too rough, too
heavy or too smooth, has the wrong grain
direction, or is of short-grain construction
or it is embossed or from a faulty paper
lot.

● Try another kind of paper, between
100 and 250 Sheffield, 4 to 6%
moisture content.

● Use long-grain paper.
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Problem Cause Solution

Print is crooked or misaligned on the
page.

The media guides might be incorrectly
adjusted.

Remove all media from the input tray,
straighten the stack, and then load the
media in the input tray again. Adjust the
media guides to the width and length of
the media that you are using and try
printing again.

The scanner might require a calibration. Perform a tray alignment and then
calibrate the scanner.

● Perform a tray alignment by
opening the Administration menu at
the device control panel. On the
Print Qualitysubmenu, touch Set
Registration. Choose a tray under
Source and then run a test page.
For more information, see Print
Quality menu on page 42.

● See Calibrate the scanner
on page 168 for information about
calibrating the scanner.

More than one sheet feeds at one time. The media tray might be overloaded. Remove some of the media from the tray.
See Load paper and print media
on page 81.

The media might be wrinkled, folded, or
damaged.

Verify that the media is not wrinkled,
folded, or damaged. Try printing on
media from a new or different package.

The device does not pull media from a
media tray.

The device might be in manual feed
mode.

● If Manual Feed appears on the
control-panel display, press OK to
print the job.

● Verify that the device is not in
manual feed mode, and then print
your job again.

The pickup roller might be dirty or
damaged.

Contact your dealer for support.

The paper-length adjustment control in
the tray is set at a length that is greater
than the media size.

Adjust the paper-length adjustment
control to the correct length.
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Performance problems

Problem Cause Solution

No copy came out. The input tray might be empty. Load media in the device.

The original might have been loaded
incorrectly.

Load the original face down in the ADF
or flatbed scanner.

Copies are blank. The sealing tape might not have been
properly removed from the cartridge.

Replace the print cartridge and return the
defective cartridge.

The original might have been loaded
incorrectly.

Load the original face down in the ADF
or flatbed scanner.

The media might not meet
HP specifications.

Use media that meets HP specifications.

The print cartridge is defective. Replace the print cartridge.

The wrong original was copied. The ADF might be loaded. Make sure that the ADF is empty.

Copies are reduced in size. The device software settings might be
set to reduce the scanned image.

See the device software Help for more
information about changing the settings.
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Solve e-mail problems
If you are unable to send e-mails by using the digital-send feature, you might need to reconfigure the
SMTP gateway address or the LDAP gateway address. Print a configuration page to find the current
SMTP and LDAP gateway addresses. See Information pages on page 146. Use the following
procedures to check if the SMTP and LDAP gateway addresses are valid.

Validate the SMTP gateway address
NOTE: This procedure is for Windows operating systems.

1. Open an MS-DOS command prompt: click Start, click Run, and then type cmd.

2. Type telnet followed by the SMTP gateway address and then the number 25, which is the port
over which the MFP is communicating. For example, type telnet 123.123.123.123 25 where
"123.123.123.123" represents the SMTP gateway address.

3. Press Enter. If the SMTP gateway address is not valid, the response contains the message Could 
not open connection to the host on port 25: Connect Failed.

4. If the SMTP gateway address is not valid, contact the network administrator.

Validate the LDAP gateway address
NOTE: This procedure is for Windows operating systems.

1. Open Windows Explorer. In the address bar, type LDAP:// immediately followed by the LDAP
gateway address. For example, type LDAP://12.12.12.12 where "12.12.12.12" represents the
LDAP gateway address.

2. Press Enter. If the LDAP gateway address is valid, the Find People dialog box opens.

3. If the LDAP gateway address is not valid, contact the network administrator.
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Solve network connectivity problems
If the MFP is having problems communicating with the network, use the information in this section to
resolve the problem.

Solve network printing problems
● Make sure that the network cable is securely seated into the formatter RJ45 connector.

● Make sure that the Link LED on the formatter RJ45 connector is lit and is flashing.

● Make sure that the I/O card is ready. Print a configuration page (see Information pages
on page 146). If an HP Jetdirect print server is installed, printing a configuration page also prints
a second page that shows the network settings and status.

NOTE: The HP Jetdirect print server supports various network protocols (TCP/IP, IPX/SPX,
Novell NetWare, AppleTalk, and DCL/LLC). Make sure that the correct protocols and network
parameters are set correctly.

On the HP Jetdirect configuration page, verify the following items for your protocol:

◦ Under HP Jetdirect Configuration, the status is "I/O Card Ready".

◦ Protocol status is "Ready".

◦ An IP address is listed.

◦ The configuration method (Config by:) is listed correctly. See the network administrator if you
are not sure which method is correct.

● Try printing the job from another computer.

● To verify that a MFP works with a computer, use a parallel cable to connect it directly to a computer.
You will have to reinstall the printing software. Print a document from a program that has printed
correctly in the past. If this works, a problem with the network might exist.

● Contact your network administrator for assistance.

Verify communication over the network
If the HP Jetdirect configuration page shows an IP address for the MFP, use this procedure to verify
that you can communicate with the MFP over the network.

1. Windows: Click Start, click Run, and then type cmd. An MS-DOS command prompt opens.

-or-

Mac: Click Applications, click Utilities, and then open the Terminal application. The terminal
window opens.

2. Type ping followed by the IP address. For example, type ping XXX.XXX.XXX.XXX where
"XXX.XXX.XXX.XXX" is the IPv4 address that is shown on the HP Jetdirect configuration page. If
the MFP is communicating over the network, the response is a list of replies from the MFP.

3. Verify that the IP address is not a duplicate address on the network by using the address resolution
protocol (arp -a) command. At the prompt, type arp -a. Find the IP address in the list and compare
its physical address to the hardware address that is listed on the HP Jetdirect configuration page
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in the section called HP Jetdirect Configuration. If the addresses match, all network
communications are valid.

4. If you cannot verify that the MFP is communicating over the network, contact the network
administrator.
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Solve common Macintosh problems
This section lists problems that can occur when using Mac OS X.

Table 12-1  Problems with Mac OS X

The printer driver is not listed in the Print Center or Printer Setup Utility.

Cause Solution

The printer software might not have been installed or was installed
incorrectly.

Make sure that the printer PPD is in the following hard-drive folder:
Library/Printers/PPDs/Contents/Resources/
<lang>.lproj, where <lang> is the two-letter language code for
the language that you are using. If necessary, reinstall the software.
See the getting started guide for instructions.

The Postscript Printer Description (PPD) file is corrupt. Delete the PPD file from the following hard-drive folder: Library/
Printers/PPDs/Contents/Resources/<lang>.lproj,
where <lang> is the two-letter language code for the language that
you are using. Reinstall the software. See the getting started guide
for instructions.

The printer name, IP address, or Rendezvous/Bonjour host name does not appear in the printer list in the Print Center or Printer
Setup Utility.

Cause Solution

The printer might not be ready. Make sure that the cables are connected correctly, the printer is on,
and the ready light is on. If you are connecting through a USB or
Ethernet hub, try connecting directly to the computer or use a different
port.

The wrong connection type might be selected. Make sure that USB, IP Printing, or Rendezvous is selected,
depending on the type of connection that exists between the printer
and the computer.

The wrong printer name, IP address, or Rendezvous/Bonjour host
name is being used.

Print a configuration page in order to check the printer name, IP
address, or Rendezvous host name. Verify that the name, IP address,
or Rendezvous host name on the configuration page matches the
printer name, IP address, or Rendezvous host name in the Print
Center or Printer Setup Utility.

The interface cable might be defective or of poor quality. Replace the interface cable. Make sure to use a high-quality cable.

The printer driver does not automatically set up your selected printer in the Print Center or Printer Setup Utility.

Cause Solution

The printer might not be ready. Make sure that the cables are connected correctly, the printer is on,
and the ready light is on. If you are connecting through a USB or
Ethernet hub, try connecting directly to the computer or use a different
port.

The printer software might not have been installed or was installed
incorrectly.

Make sure that the printer PPD is in the following hard-drive folder:
Library/Printers/PPDs/Contents/Resources/
<lang>.lproj, where <lang> is the two-letter language code for
the language that you are using. If necessary, reinstall the software.
See the getting started guide for instructions.
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The printer driver does not automatically set up your selected printer in the Print Center or Printer Setup Utility.

Cause Solution

The Postscript Printer Description (PPD) file is corrupt. Delete the PPD file from the following hard-drive folder: Library/
Printers/PPDs/Contents/Resources/<lang>.lproj,
where <lang> is the two-letter language code for the language that
you are using. Reinstall the software. See the getting started guide
for instructions.

The interface cable might be defective or of poor quality. Replace the interface cable. Make sure to use a high-quality cable.

A print job was not sent to the printer that you wanted.

Cause Solution

The print queue might be stopped. Restart the print queue. Open print monitor and select Start Jobs.

The wrong printer name or IP address is being used. Another printer
with the same or similar name, IP address, or Rendezvous host name
might have received your print job.

Print a configuration page in order to check the printer name, IP
address, or Rendezvous host name. Verify that the name, IP address,
or Rendezvous host name on the configuration page matches the
printer name, IP address, or Rendezvous host name in the Print
Center or Printer Setup Utility.

An encapsulated postscript (EPS) file does not print with the correct fonts.

Cause Solution

This problem occurs with some programs. ● Try downloading the fonts that are contained in the EPS file to
the printer before printing.

● Send the file in ASCII format instead of binary encoding.

You are unable to print from a third-party USB card.

Cause Solution

This error occurs when the software for USB printers is not
installed.

When adding a third-party USB card, you might need the Apple USB
Adapter Card Support software. The most current version of this
software is available from the Apple Web site.

Table 12-1  Problems with Mac OS X (continued)
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When connected with a USB cable, the printer does not appear in the Print Center or Printer Setup Utility after the driver is selected.

Cause Solution

This problem is caused by either a software or a hardware
component.

Software troubleshooting

● Check that your Macintosh supports USB.

● Verify that your Macintosh operating system is Mac OS X v10.3
or later.

● Ensure that your Macintosh has the appropriate USB software
from Apple.

Hardware troubleshooting

● Check that the printer is turned on.

● Verify that the USB cable is connected correctly.

● Check that you are using the appropriate high-speed USB cable.

● Ensure that you do not have too many USB devices drawing
power from the chain. Disconnect all of the devices from the
chain, and connect the cable directly to the USB port on the host
computer.

● Check to see if more than two nonpowered USB hubs are
connected in a row on the chain. Disconnect all of the devices
from the chain and connect the cable directly to the USB port on
the host computer.

NOTE: The iMac keyboard is a nonpowered USB hub.

Table 12-1  Problems with Mac OS X (continued)
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A Supplies and accessories

This section provides information about ordering parts, supplies, and accessories. Use only parts and
accessories that are specifically designed for this device.

● Order parts, accessories, and supplies

● Part numbers
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Order parts, accessories, and supplies
To order parts, accessories, and supplies, contact your dealer.
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Part numbers
Type of item Item Description or use Order number

Paper handling 3,000-sheet stacker One 3,000-sheet stacking
device. The device also offers
job offset capabilities.

C8084A

3,000-sheet stapler/stacker One 3,000-sheet stacking
device provides stapling for as
many as 50 sheets of paper
per document. The device
also offers job offset
capabilities.

C8085A

Multifunction finisher Finishing device that provides
1,000 sheets of stacker
capacity, stapling, for up to 50
sheets of paper, and folding
saddle-stitching for booklets
up to 10 sheets of paper.

C8088B

8-bin mailbox A device that provides a face-
up bin (upper bin) and eight
face-down bins that can be
assigned to individual users or
workgroups. The device also
functions as a job separator,
stacker, and sorter/collator.

Q5693A

Printing supplies Print cartridge (average of
38,000 pages in accordance
with ISO/IEC 19752) 

Replacement HP maximum
capacity, smart print
cartridge.

CE266C

Staple cartridge Replacement HP 5,000 staple
cartridge for the 3,000-sheet
stapler/stacker.

C8091A

Staple cartridge Replacement HP 5,000 staple
cartridge for the multifunction
finisher.

C8092A

Memory SDRAM Double Data Rate
(DDR) memory DIMMs (100-
pin)

The MFP has two memory
DIMM slots. One is used by
factory-installed memory.

Improves the ability of the
MFP to handle large and
stored jobs (maximum 512
MB with HP brand DDR
DIMMs).

Q7715A (64 MB)

Q7718A (128 MB)

Q7719A (256 MB)

Q7720A (512 MB)
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Type of item Item Description or use Order number

Cable and interface
accessories

Enhanced EIO Cards HP Jetdirect Connectivity
Card for USB, serial, and
LocalTalk connectivity

J4135A

HP Jetdirect 615N Print
Server for Fast Ethernet
(10/100Base-TX) networks
(RJ-45 only)

J6057A

HP 680N Wireless 802.11b
connectivity

J6058A

HP Jetdirect 625N Print
Server for Fast Ethernet
(10/100/1000Base-TX
networks)

J7960A

Analog fax A customer-installable
accessory that enables the
MFP to function as a stand-
alone analog fax machine.

Q3701A

Additional software features HP Digital Sending Software A software accessory with
enhanced digital sending
features including network
authentication.

T196AA

Maintenance kit Printer maintenance kit The kit contains two Type 1
rollers, seven Type 2 rollers,
one transfer roller assembly,
and one fuser assembly.

C9152A (110 volt)

C9153A (220 volt)
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B Specifications

● Physical specifications

● Electrical specifications

● Acoustic emissions

● Operating environment
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Physical specifications
Table B-1  Dimensions

Model Height Depth Width Weight1

HP LaserJet M9059 MFP 1219 mm (48 in.) 1085 mm (43 in.) 1334 mm (53 in.) 143 kg (317 lb)

1 Without print cartridge

Table B-2  Dimensions with all doors and trays fully opened

Model Height Depth Width

HP LaserJet M9059 MFP 1664 mm (66 in.) 1296 mm (52 in.) 2501 mm (98.5 in.)
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Electrical specifications
WARNING! Power requirements are based on the country/region where the device is sold. Do not
convert operating voltages. This can damage the device and void the product warranty.

Table B-3  Power requirements

Specification 110-volt models 220-volt models

Power requirements 100 to 127 Vac

50/60 Hz

220 to 240 Vac

50/60 Hz

Rated current 12 Amps 5.3 Amps

Table B-4  Power consumption (average, in watts)1

Model Printing2 Copying2 Ready or
standby,4

Sleep 13, 5 Sleep 2 Off

HP LaserJet M9059 MFP 1130 W 1160 W 305 W 221 W 59 W 0.9 W

1 Values are based on preliminary data. See www.hp.com/go/ljm9059mfp/regulatory for current information.
2 Power numbers are the highest values measured using all standard voltages.
3 Default time from Ready mode to Sleep 1 = 15 minutes, and to Sleep 2 = 90 minutes.
4 Heat dissipation in Ready mode = 1045 BTU/hour.
5 Recovery time from Sleep to start of printing = 20 seconds, and from Sleep 2 to start of printing = 145 seconds.
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Acoustic emissions
Table B-5  Sound power level1, 2

Sound power level Declared per ISO 9296

Printing3 LWAd= 7.4 Bels (A) [74 dB(A)]

Ready Essentially Inaudible

1 Values are based on preliminary data. See www.hp.com/go/ljm9059mfp/regulatory for current information.
2 Configuration tested: Base unit printing and scanning continuous with ADF on A4 paper with no output device.
3 Print speed is 50 ipm.

Table B-6  Sound pressure level1, 2

Sound pressure level Declared per ISO 9296

Printing/Copying3 LpAm=58 dB (A)

Ready Essentially Inaudible

1 Values subject to change. See www.hp.com/support/ljm9059mfp for current information.
2 Configuration tested: Base unit printing and scanning continuous with ADF on A4 paper with no output device.
3 Print speed is 50 ipm.

Operating environment
Table B-7  Necessary conditions

Environmental condition Recommended Allowed

Temperature (device and print cartridge) 17.5° to 25.0°C (63° to 77°F) 0° to 40°C (32° to 104°F)

Relative humidity 30% to 70% 0% to 95%

NOTE: Optimum performance of the device is assured under the recommended temperature and
humidity specifications. Print quality might deteriorate and occurrences of paper jams might increase
when the device is operated withing the allowed temperature and humidity specifications.
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C Regulatory information
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FCC regulations
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant
to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy. If this equipment is not installed and used in accordance with the instructions, it may
cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following measures:

● Reorient or relocate the receiving antenna.

● Increase separation between equipment and receiver.

● Connect equipment to an outlet on a circuit different from that to which the receiver is located.

● Consult your dealer or an experienced radio/TV technician.

NOTE: Any changes or modifications to the printer that are not expressly approved by HP could void
the user’s authority to operate this equipment.

Use of a shielded interface cable is required to comply with the Class A limits of Part 15 of FCC rules.
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Environmental product stewardship program
Protecting the environment

Hewlett-Packard Company is committed to providing quality products in an environmentally sound
manner. This product has been designed with several attributes to minimize impacts on our environment.

Ozone production
This product generates no appreciable ozone gas (O3).

Power consumption
Power usage drops significantly while in Ready/Sleep mode, which saves natural resources and saves
money without affecting the high performance of this product. To determine the ENERGY STAR®
qualification status for this product see the Product Data Sheet or Specifications Sheet. Qualified
products are also listed at:

http://www.hp.com/hpinfo/globalcitizenship/environment/productdesign/ecolabels.html

Toner consumption
Economode uses significantly less toner, which might extend the life of the print cartridge.

Paper use
This product’s manual/optional automatic duplex feature (two-sided printing) and N-up printing (multiple
pages printed on one page) capability can reduce paper usage and the resulting demands on natural
resources.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability to
identify plastics for recycling purposes at the end of the product’s life.
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HP LaserJet print supplies
It’s easy to return and recycle your empty HP LaserJet print cartridges—free of charge—with HP Planet
Partners. Multilingual program information and instructions are included in every new HP LaserJet print
cartridge and supplies package. You help reduce the toll on the environment further when you return
multiple cartridges together rather than separately.

HP is committed to providing inventive, high-quality products and services that are environmentally
sound, from product design and manufacturing to distribution, customer use and recycling. When you
participate in the HP Planet Partners program, we ensure your HP LaserJet print cartridges are recycled
properly, processing them to recover plastics and metals for new products and diverting millions of tons
of waste from landfills. Since this cartridge is being recycled and used in new materials, it will not be
returned to you. Thank you for being environmentally responsible!

NOTE: Use the return label to return original HP LaserJet print cartridges only. Please do not use this
label for HP inkjet cartridges, non-HP cartridges, refilled or remanufactured cartridges or warranty
returns. For information about recycling your HP inkjet cartridges please go to http://www.hp.com/
recycle.

Return and recycling instructions

United States and Puerto Rico
The enclosed label in the HP LaserJet toner cartridge box is for the return and recycling of one or more
HP LaserJet print cartridges after use. Please follow the applicable instructions below.

Multiple returns (two to eight cartridges)

1. Package each HP LaserJet print cartridge in its original box and bag.

2. Tape up to eight single boxes together using strapping or packaging tape (up to 70 lbs).

3. Use a single pre-paid shipping label.

OR

1. Use your own suitable box, or request a free bulk collection box from the http://www.hp.com/
recycle or 1-800-340-2445 (holds up to eight HP LaserJet print cartridges).

2. Use a single pre-paid shipping label.

Single returns

1. Package the HP LaserJet print cartridge in its original bag and box.

2. Place the shipping label on the front of the box.

Shipping

For all HP LaserJet print cartridge recycling returns, give the package to UPS during your next delivery
or pickup, or take it to an authorized UPS drop-off center. For the location of your local UPS drop-off
center, call 1-800-PICKUPS or visit http://www.ups.com. If you are returning via USPS label, give the
package to a U.S. Postal Service carrier or drop off at a U.S.Postal Service Office. For more information,
or to order additional labels or boxes for bulk returns, visit http://www.hp.com/recycle or call
1-800-340-2445. Requested UPS pickup will be charged normal pickup rates. Information subject to
change without notice.
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Non-US returns
To participate in HP Planet Partners return and recycling program, just follow the simple directions in
the recycling guide (found inside the packaging of your new printer supply item) or visit
http://www.hp.com/recycle. Select your country/region for information on how to return your HP LaserJet
printing supplies.

Paper
This product is capable of using recycled papers when the paper meets the guidelines outlined in the
HP LaserJet Printer Family Print Media Guide. This product is suitable for the use of recycled paper
according to EN12281:2002.
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Material restrictions
This HP product contains mercury in the fluorescent lamp of the scanner and/or control panel liquid
crystal display that may require special handling at end-of-life.

This HP product contains a battery that might require special handling at end-of-life. The batteries
contained in or supplied by Hewlett-Packard for this product include the following:

HP LaserJet M9059 device

Type Carbon monofluoride lithium battery BR1632

Weight 1.5 g

Location On formatter board

User-removable No

For recycling information, you can go to www.hp.com/recycle, or contact your local authorities or the
Electronics Industries Alliance: www.eiae.org.

Disposal of waste equipment by users in private households in the
European Union

This symbol on the product or on its packaging indicates that this product must not be disposed of with
your other household waste. Instead, it is your responsibility to dispose of your waste equipment by
handing it over to a designated collection point for the recycling of waste electrical and electronic
equipment. The separate collection and recycling of your waste equipment at the time of disposal will
help to conserve natural resources and ensure that it is recycled in a manner that protects human health
and the environment. For more information about where you can drop off your waste equipment for
recycling, please contact your local city office, your household waste disposal service or the shop where
you purchased the product.
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Material Safety Data Sheet (MSDS)
Material Safety Data Sheets (MSDS) for supplies containing chemical substances (for example, toner)
can be obtained by contacting the HP Web site at www.hp.com/go/msds or www.hp.com/hpinfo/
globalcitizenship/environment.

For more information
To obtain information about these environmental topics:

● Product environmental profile sheet for this and many related HP products

● HP’s commitment to the environment

● HP’s environmental management system

● HP’s end-of-life product return and recycling program

● Material Safety Data Sheets

Visit www.hp.com/go/environment or www.hp.com/hpinfo/globalcitizenship/environment.
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Country/region specific statements
Declaration of Conformity

 Declaration of Conformity

according to ISO/IEC 17050-1 and EN 17050-1
Manufacturer's Name: Hewlett-Packard Company

DoC#: BOISB-0403-01-rel.3.0
Manufacturer's Address: 11311 Chinden Boulevard,

Boise, Idaho 83714-1021, USA
declares, that the product

Product Name: HP LaserJet 9040MFP / 9050MFP / 9059MFP series
Accessories4): 2000 sheet input feed unit (C8531A); Multifunction finisher (C8088A); 3000 sheet stacker

(C8084A); 3000 sheet stacker/stapler (C8085A)
8-bin mailbox (Q5693A)(GUADA-0401-00)
BOISB-0308-00 – Fax Module

Regulatory Model2): BOISB-0403-01
Product Options: All
Toner Cartridge C8543X, CE266C
conforms to the following Product Specifications:

Safety: IEC 60950-1:2001 / EN60950-1: 2001 + A11
IEC 60825-1:1993 +A1 +A2 / EN 60825-1:1994 +A1 +A2 (Class 1 Laser/LED Product)
GB4943-2001

EMC: CISPR22:2005 / EN 55022:2006 - Class A1, 3)

EN 61000-3-2:2006
EN 61000-3-3:1995 +A1
EN 55024:1998 +A1 +A2
FCC Title 47 CFR, Part 15 Class A / ICES-003, Issue 4
GB9254-1998, GB17625.1-2003

Telecom: TBR-21:1998, EG 201 121:1998

Supplementary Information:

The product herewith complies with the requirements of the R&TTE Directive 1999/5/EC Annex II, EMC Directive 2004/108/EEC and the Low
Voltage Directive 2006/95/EEC, and carries the CE-Marking  accordingly.

This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may cause undesirable operation.

1) The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.

2) For regulatory purposes, this product is assigned a Regulatory model number. This number should not be confused with the product name
or the product number(s).

3) The product meets the requirements of EN55022 & CNS13438 Class A in which case the following applies: “Warning – This is a class A
product. In a domestic environment this product may cause radio interference in which case the user may be required to take adequate
measures”.

4) All worldwide module approvals for analog fax accessory obtained by Hewlett-Packard under the regulatory model number BOISB-0308-00
incorporate the Multi-Tech Systems MT5634SMI Socket Modem Module.

Boise, Idaho , USA

March 2009

For regulatory topics only,

European Contact: Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-TRE / Standards
Europe, Herrenberger Straße 140, D-71034 Böblingen, Germany, (FAX: +49-7031-14-3143), www.hp.com/go/
certificates

USA Contact: Product Regulations Manager, Hewlett-Packard Company,, PO Box 15, Mail Stop 160,, Boise, Idaho 83707-0015, USA,
(Phone: 208-396-6000)
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Laser safety
The Center for Devices and Radiological Health (CDRH) of the U.S. Food and Drug Administration has
implemented regulations for laser products manufactured since August 1, 1976. Compliance is
mandatory for products marketed in the United States. The device is certified as a “Class 1” laser product
under the U.S. Department of Health and Human Services (DHHS) Radiation Performance Standard
according to the Radiation Control for Health and Safety Act of 1968. Since radiation emitted inside the
device is completely confined within protective housings and external covers, the laser beam cannot
escape during any phase of normal user operation.

WARNING! Using controls, making adjustments, or performing procedures other than those specified
in this user guide may result in exposure to hazardous radiation.

Canadian DOC regulations
Complies with Canadian EMC Class A requirements.

« Conforme à la classe A des normes canadiennes de compatibilité électromagnétiques. « CEM ». »

VCCI statement (Japan)

Power cord statement (Japan)

EMC statement (Korea)

EMI statement (Taiwan)

Laser statement for Finland
Luokan 1 laserlaite
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Klass 1 Laser Apparat

HP LaserJet M9059, laserkirjoitin on käyttäjän kannalta turvallinen luokan 1 laserlaite. Normaalissa
käytössä kirjoittimen suojakotelointi estää lasersäteen pääsyn laitteen ulkopuolelle. Laitteen
turvallisuusluokka on määritetty standardin EN 60825-1 (1994) mukaisesti.

VAROITUS !

Laitteen käyttäminen muulla kuin käyttöohjeessa mainitulla tavalla saattaa altistaa käyttäjän
turvallisuusluokan 1 ylittävälle näkymättömälle lasersäteilylle.

VARNING !

Om apparaten används på annat sätt än i bruksanvisning specificerats, kan användaren utsättas för
osynlig laserstrålning, som överskrider gränsen för laserklass 1.

HUOLTO

HP LaserJet M9059 - kirjoittimen sisällä ei ole käyttäjän huollettavissa olevia kohteita. Laitteen saa avata
ja huoltaa ainoastaan sen huoltamiseen koulutettu henkilö. Tällaiseksi huoltotoimenpiteeksi ei katsota
väriainekasetin vaihtamista, paperiradan puhdistusta tai muita käyttäjän käsikirjassa lueteltuja,
käyttäjän tehtäväksi tarkoitettuja ylläpitotoimia, jotka voidaan suorittaa ilman erikoistyökaluja.

VARO !

Mikäli kirjoittimen suojakotelo avataan, olet alttiina näkymättömällelasersäteilylle laitteen ollessa
toiminnassa. Älä katso säteeseen.

VARNING !

Om laserprinterns skyddshölje öppnas då apparaten är i funktion, utsättas användaren för osynlig
laserstrålning. Betrakta ej strålen. Tiedot laitteessa käytettävän laserdiodin säteilyominaisuuksista:
Aallonpituus 775-795 nm Teho 5 m W Luokan 3B laser.
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Index

Symbols/Numerics
3000-sheet stacker

capacity 5
features 8
ordering 231

3000-sheet stapler/stacker
bins 90
capacity 5
jams, clearing 189
ordering 231
selecting output location 91
staple cartridge, ordering 231
staple jams, clearing 198
stapling documents 8

500-sheet input tray
models including 2

8-bin mailbox
bins 90
capacity 5
features 10
jams, clearing 201
ordering 231

A
A4 paper settings 40
accessories

locating 7
ordering 230,  231

acoustic specifications 236
activity log, fax 147
address book, e-mail

deleting addresses 136
address books, e-mail

adding addresses 135
clearing 46
recipient lists 135
recipient lists, creating 135

address books, e-mail
auto-complete function 134
LDAP support 130

address, printer
Macintosh,

troubleshooting 226
ADF

sizes supported 133
ADF (automatic document feeder)

capacity 4
cleaning the delivery

system 163
cleaning the rollers 166
cleaning the top glass

strip 164
locating 7

adhesive labels
printing 81

Administration menu, control
panel 15

advanced printing options
Windows 98

alerts, e-mail 60
alignment settings, trays 42
alternative letterhead mode 98
AppleTalk setting 73
AppleTalk settings 29
Attention light

locating 12
automatic document feeder (ADF)

cleaning the rollers 166
misfeeds 166

automatic two-sided printing path
copying documents 120

auxiliary connection
configuration 69

B
batteries included 242
billing codes report, fax 147
bins

capacities 4
default settings 22

locating 90
multifunction finisher 90
selecting 91

blank copies, problem-
solving 222

blocked fax list, printing 147
blurred print, problem-

solving 216
Bonjour Settings 60
booklet bin, multifunction

finisher 90
booklets, creating 9
books

copying 124
both sides, copying

default settings 17
both sides, printing on

blank pages default
settings 38

default settings 22
Macintosh settings 60

browser requirements
embedded Web server 148

buttons, control panel
locating 12
sounds, settings 38
touchscreen 14

C
calibrating scanner 168
call report, fax 147
Canadian DOC regulations 245
canceling

copy jobs 126
printing 105

canceling a print request 105
capacity

bins 4
cards, EIO

ordering 232
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cartridges
management menu 25
recycling 240

cartridges, print
Macintosh status 65
ordering 231

cartridges, staple
empty, stop or continue

settings 101
jams, clearing from stapler/

stacker 198
loading 101

characters, misformed 213
cleaning

ADF delivery system 163
glass 163
MFP 161,  163
paper path 161
touch-screen 163

clearing jams
stapler head 197

clock
setting 160

clothing, washing toner off 162
collating copies 123
colored text

print as black 98
configuration page

Information menu 16
Macintosh 60
printing 146

configurations, models 2
connectivity

auxiliary 69
USB 68

control panel
Administration menu 15
buttons 12
cleaning page, printing 161
copy-screen 116
Default Job Options menu 17
default settings 38
Device Behavior menu 38
E-mail Setup menu 37
e-mail screen 132
Fax Setup menu 34
help 14
Home screen 13
Information menu 16
Initial Setup menu 26

key press sounds, default
settings 38

lights 12
locating 7
locking menus 158
maintenance messages,

resetting 172
Management menu 25
messages, numerical list 183
messages, types of 182
Print Quality menu 42
Resets menu 46
Send Setup menu 37
Service menu 46
settings 52,  60
Time/Scheduling menu 23
touchscreen buttons 14
troubleshooting 181

controlling print jobs 88
copies, number of

Windows 98
copying

books 124
canceling 126
collating 123
control-panel navigation 116
default settings 17,  18
features 4,  115
interrupting jobs 39
Job Mode 125
media, problem-solving 220
multiple originals 125
photos 124
problem-solving 222
problems, preventing 219
quality, problem-solving 219
size, problem-solving 222
two-sided documents 120

Courier font settings 40
cover pages 62,  96
creased paper, problem-

solving 214
crooked pages 213
curled paper, problem-

solving 214,  220
custom paper sizes 79
custom-size paper

default settings 22
custom-size paper settings

Macintosh 62

D
dark copying 220
Data light

locating 12
date, setting 23,  160
Default Job Options menu 17
default settings

copy 18
Device Behavior menu 38
e-mail 20
originals 17
print 22
Resets menu 46
Send to Folder 21

delay, sleep 177
density

problem-solving 208
settings 42,  60

Device Behavior menu 38
device status

Macintosh Services tab 65
diagnostics

networks 30
digital faxing 143
digital sending

about 129,  133
address books 135
configuring e-mail 130
control-panel settings 132
default settings 21
folders 138
job settings 137
LDAP support 130
loading documents 133
recipient lists 135
sending documents 133
Setup menu 37
SMTP support 130
troubleshooting 181
validating gateway

addresses 223
workflow 139

Digital Sending tab, embedded
Web server 151

DIMMs
expansion options 3
installing 173
ordering 231
slots 173
verifying installation 176
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Disk Erase feature 157
disposal, end-of-life 242
DLC/LLC settings 29
document feeder

copying two-sided
documents 120

doors
jam locations 184
left, clearing jams 200
locating 7
right, clearing jams 187

dots per inch (dpi) 3
dots, problem-solving 209,  215,

219
double-sided copying

default settings 17
double-sided printing

blank pages, default
settings 38

default settings 22
Macintosh settings 60

dpi, settings 42,  60
drivers

Macintosh settings 62
Macintosh,

troubleshooting 226
presets (Macintosh) 62
settings 52,  53,  60,  61
shortcuts (Windows) 96
supported 49
universal 50
Windows, opening 96

dropouts, problem-solving 209
duplex printing

Windows 97
duplex printing accessory

locating 7
duplexer

Macintosh settings 60
duplexing

blank pages, default
settings 38

copying documents 120
default settings 22

duty cycle 3

E
e-mail

about 129,  133
address books 135

configuring 130
default settings 20
sending documents 133
troubleshooting 181
validating gateway

addresses 223
e-mail alerts 60
E-mail Setup menu 37
Economode 42
economy settings 177
EIO cards

included 5
ordering 232
slots, locating 7

EIO disk
features 6
locking 158

electrical specifications 235
embedded Web server

assigning a password 157
checking toner level 171
features 148

end-of-life disposal 242
energy specifications 235
envelopes

jams 205
printing 106
wrinkled, problem-solving 214

environment for device
problem-solving 207

environment for printer
specifications 236

environment, specifications 171
environmental stewardship

program 239
EPS files, troubleshooting 227
erasing hard disk 157
Error button, control panel

touchscreen 14
error messages

default settings 38
e-mail alerts 60
maintenance, resetting 172
numerical list 183
types of 182

Ethernet support 5
European Union, waste

disposal 242
Explorer, versions supported

embedded Web server 148

e-mail
address books 135
auto-complete function 134
control-panel settings 132
job settings 137
LDAP support 130
loading documents 133
recipient lists 135
sending documents 133
SMTP support 130

F
fans, troubleshooting 181
FastRes 3
fax accessory

connecting phone line 142
printing schedule 24

Fax Activity Log
clearing 46

fax card, ordering 232
fax reports, printing 16,  147
Fax Setup menu 34
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feeding problems, media 220
file directory, printing 147
File Upload, Macintosh 60
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firmware

updates 6
Firmware Update, Macintosh 60
first page
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use different paper 62
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default settings 21
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Courier settings 40
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Upload Macintosh 60

front door
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modes 42

G
gateways

configuring 130
testing 131
validating addresses 223
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graphical display, control
panel 12

gray background, problem-
solving 210

H
hard disk

erasing 157
held jobs 110
Help button, control panel

touchscreen 14
help, control panel 14
Home button, control panel

touchscreen 14
Home screen, control panel 13
HP Digital Sending software,

ordering 232
HP fraud hotline 170
HP Jetdirect print server

configuring 73
models including 2
settings 26

HP Printer Utility 59,  60
HP Universal Print Driver 50
HP Web Jetadmin

checking toner level 171
HP-UX software 55
humidity

problem-solving 207
specifications 236

humidity requirements 171
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settings 26

image quality
copy, improving 219
copy, problem-solving 219
settings 42

image reptition, problem-
solving 217

images per minute 3
inactivity timeout 38
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information pages 146
Information tab, embedded Web

server 149
Initial Setup menu 26
installing

Macintosh software for direct
connections 58

Macintosh software on
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memory 173
printer maintenance kit 172

Internet Explorer, versions
supported

embedded Web server 148
Internet fax 143
IP address

changing 70
Macintosh,

troubleshooting 226
IPX/SPX setting 29,  72

J
jams

envelopes 205
frequent 202
locations 184
print quality after 207
recovery settings 38
trays, clearing 186

jams, paper
multifunction finisher 191,

192,  193
preventing 81
stacker or stapler/stacker 189

jams, staple
stapler/stacker 198

Japanese VCCI statement 245
Jetadmin, HP Web 54,  152
Jetdirect print server

configuring 73
models including 2
settings 26

Job Mode, copying 125
job storage

accessing 109

features 109
Macintosh settings 65
personal 110
proof and hold 110
QuickCopy 111
settings 25
stored 112

jobs
Macintosh settings 60

K
keys, control panel

locating 12
sounds, settings 38
touchscreen 14

Korean EMC statement 245

L
LAN connector 5
LAN fax 143
landscape orientation

setting, Windows 97
language

default, setting 38
language, control panel 181
language, printer

default settings 40
laser safety statements 245
LDAP servers

connecting to 130
validating gateway
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letterhead paper, loading 98
light copying 220
light print

problem-solving 208
lights

control panel 12
lines, problem-solving

copies 219
link speed settings 33
Linux software 55
loading

documents, sizes
supported 133

scanner glass 133
sizes supported 133
staples 101

LocalTalk connection 5
Lock Resources, Macintosh 60
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locking
control panel menus 158

loose toner, problem-solving 211

M
Macintosh

AppleTalk settings 29
driver settings 61,  62
drivers, troubleshooting 226
HP Printer Utility 59
installing printing system for

direct connections 58
installing printing system for

networks 59
problems,

troubleshooting 226
removing software 61
resize documents 62
software 58
staple options 64
supported operating

systems 58
USB card,

troubleshooting 227
Macintosh driver settings

custom-size paper 62
Job Storage 65
Services tab 65
watermarks 63

maintenance kit
ordering 232

Management menu 25
margins

registration, setting 42
material restrictions 242
Material Safety Data Sheet

(MSDS) 243
media
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curled 214,  220
custom, loading 85
custom-size, Macintosh

settings 62
default size, selecting 22
first page 62
fuser modes 42
loading 81
pages per sheet 63
problem-solving 207,  220
skewed 213

supported sizes 77
wrinkled 214

memory
adding 173
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managing 173
upgrading 173

Memory Enhancement technology
(MEt) 3

Menu button 12
menu map

Information menu 16
printing 146

menus, control panel
Administration 15
Default Job Options 17
Device Behavior 38
E-mail Setup 37
Fax Setup 34
Information 16
Initial Setup 26
locking 158
Management 25
Print Quality 42
Resets 46
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Service 46
Time/Scheduling 23

mercury-free product 242
messages
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e-mail alerts 60
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types of 182

microprocessor speed 3
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misformed characters, problem-

solving 213
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multifeeds 221
multifunction finisher

capacity 5
ordering 231
staple cartridge, ordering 231
using 8

multiple pages per sheet
Windows 97

N
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Windows 97
Netscape Navigator, versions
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embedded Web server 148

Network Folder, scan to 138
Networking tab, embedded Web

server 151
networks
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configuring 70
configuring gateway
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default gateway 71
diagnostics 30
disabling DLC/LLC 73
disabling protocols 72
DLC/LLC settings 29
HP Web Jetadmin 152
IP address 70
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Macintosh settings 60
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protocol configuration page,
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security 30
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subnet mask 71
TCP/IP parameters 70
TCP/IP settings 26
testing SMTP settings 131
validating gateway
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noise specifications 236
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O
online help, control panel 14
operating environment

specifications 171,  236
operating systems supported 48,

58
ordering

supplies and accessories 230
orientation

setting, Windows 97
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output bin
selecting, Windows 97

output quality
copy, improving 219
copy, problem-solving 219
settings 42

P
page order, changing 98
pages per sheet

Windows 97
paper

A4 settings 40
covers, using different

paper 96
curled 214,  220
custom size, selecting 96
custom sizes 79
custom-size, Macintosh

settings 62
default size, selecting 22
first and last pages, using

different paper 96
first page 62
fuser modes 42
pages per sheet 63
problem-solving 207,  220
size, selecting 96
skewed 213
supported sizes 77
type, selecting 96
wrinkled 214

paper path
cleaning 161

pausing a print request 105
PCL drivers

default settings 40
universal 50

PDF error pages 40
Perform Printer Maintenance

message 172
personal jobs 110
personality

default settings 40
phone line, connecting fax

accessory 142
photos

copying 124
loading 133

physical specifications 234

PINs, personal jobs 110
portrait orientation

setting, Windows 97
ports

troubleshooting
Macintosh 227

power
troubleshooting 180

power specifications 235
presets (Macintosh) 62
print cartridge

authentication 170
checking toner levels 171
genuine HP 170
life expectancy 171
managing 170
non-HP 170
storing 170

print cartridges
Macintosh status 65
management menu 25
recycling 240

print jobs
default settings 22

print media
supported 77

print on both sides
Windows 97

print quality
blurred 216
dropouts 209
environment 207
gray background 210
jams, after 207
light print 208
lines 210
loose toner 211
media 207
misformed characters 213
repeating defects 212
repetitive images 217
scattered lines 216
smeared toner 211
specks 209
tire tracks 215
troubleshooting 207
white lines 215
white spots 215

Print Quality menu, control
panel 42

print server 5
priority, settings 52,  60
private jobs

Windows 98
problem-solving

blurred print 216
copy quality 219
copy size 222
copying 219,  222
curled paper 214
dropouts 209
e-mail alerts 60
environment 207
Error button, control panel

touchscreen 14
gray background 210
light print 208
lines 210,  215
lines, copies 219
media 207,  220
messages, types of 182
networks 30
repeating defects 212
repetitive images 217
scattered lines 216
skewed pages 213
smeared toner 211
specks 209
text quality 213,  216
tire tracks 215
white spots 215
wrinkled paper 214

proof and hold
Windows 98

proof and hold jobs 110
protocol configuration page,

printing 33
PS emulation driver

default settings 40
PS Emulation drivers 49
PS error pages

default settings 40

Q
quality

copy, improving 219
copy, problem-solving 219
settings 42

Quick Sets 96
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R
Ready light

locating 12
real-time clock 160
recipient lists 135
recycling

HP printing supplies returns and
environmental program 240

registration, tray alignment 42
removing Macintosh software 61
repeating defects, problem-

solving 212,  217
replacing

staple cartridges 101
reset button 12
Resets menu, control panel 46
resize documents

Macintosh 62
Windows 97

resolution
settings 42,  60
troubleshooting quality 207

Resolution Enhancement
technology (REt) 42,  60

REt (Resolution Enhancement
technology 42

REt (Resolution Enhancement
technology) 60

retention, job
accessing 109
features 109
personal 110
proof and hold 110
QuickCopy 111
stored 112

right door
locating 7

S
saddle stitching 9
safety statements 245
scale documents

Macintosh 62
Windows 97

scanner calibration 168
scanning

default settings 17
no-wait 39

scanning e-mail
validating gateway

addresses 223
scanning to e-mail

about 129,  133
address books 135
configuring 130
default settings 20
sending documents 133
troubleshooting 181

scanning to e-mail
address books 135
control-panel settings 132
job settings 137
LDAP support 130
loading documents 133
recipient lists 135
sending documents 133
SMTP support 130

scanning to folder 138
scanning to workflow 139
Secure Disk Erase 157
security

disk erase 157
locking control panel

menus 158
settings 30

Send Setup menu 37
Send to Folder 138
Send to Workflow 139
sending to e-mail

about 129,  130,  133
address books 135
default settings 20
sending documents 133
troubleshooting 181
validating gateway

addresses 223
sending to e-mail

address books 135
job settings 137
LDAP support 130
loading documents 133
recipient lists 135
sending documents 133
settings 132
SMTP support 130

separator page
Windows 97

Service menu, control panel 46

Services tab
Macintosh 65

settings
Default Job Options menu 17
driver presets (Macintosh) 62
drivers 53,  61
priority 52,  60

Settings tab, embedded Web
server 150

shortcuts 96
size, copy

problem-solving 222
size, media

A4 settings 40
default, selecting 22

skewed pages 213
Sleep button 12
Sleep mode

power specifications 235
settings 23,  25

sleep settings
delay 177
sleep time 177
wake time 177

sleep time, setting 24,  177
smeared toner, problem-

solving 211
SMTP servers

configuring gateway
address 130

connecting to 130
testing 131
validating gateway

addresses 223
software

direct connection installation,
Macintosh 58

embedded Web server 54,
61

HP Printer Utility 59
HP Web Jetadmin 54
Macintosh 58
network installation,

Macintosh 59
settings 52,  60
supported operating

systems 48,  58
uninstalling Macintosh 61
Windows 47

Solaris software 55
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special media
guidelines 80

special paper
guidelines 80

specifications
acoustic 236
electrical 235
media 75
operating environment 171,

236
physical 234

specks, problem-solving 209,
215

speed dial list, printing 147
spots, problem-solving 209,  215
staple cartridges

empty, stop or continue
settings 101

loading 101
staple options

Macintosh 64
Windows 97

stapler
default settings 18

stapler/stacker
empty, stop or continue

settings 101
loading staples 101
selecting output location 91
staple jams, clearing 198
stapling 100

stapling 100
Start button 12
Start button, control panel

touchscreen 14
status

embedded Web server 149
Home screen, control

panel 13
HP Printer Utility,

Macintosh 60
Macintosh services tab 65
messages, types of 182

Status button 12
Stop button 12
stopping a print request 105
storage, job

accessing 109
features 109
Macintosh settings 60,  65

personal 110
proof and hold 110
QuickCopy 111
settings 25
stored 112

store jobs
Windows 98

stored jobs 112
streaks, problem-solving 219
subnet mask 71
supplies

management menu 25
ordering 230,  231
recycling 240
Resets menu 46
status page, printing 146
status, viewing with embedded

Web server 149
status, viewing with HP Printer

Utility 60
supply-status, Services tab

Macintosh 65
Windows 98

support
online 98

supported media 77
system requirements

embedded Web server 148

T
Taiwan EMI statement 245
TCP/IP settings 26
temperature

requirements 171
temperature specifications 236
tests

networks 30
text, problem-solving

blurred 216
blurry 220
dropouts 209
misformed characters 213

time zone 23
time, setting 23,  160
Time/Scheduling menu, control

panel 23
timeout settings 26,  38
tire tracks, problem-solving 215

toner
adhesion problems,

solving 220
density setting 60
Economode 42
loose, problem-solving 211
smeared, problem-

solving 211
tray 1

capacity 4
fuser levers 107,  108
jam locations 184
jams, clearing 186
loading envelopes 106
loading paper 81
locating 7

tray 2
jams, clearing 186

tray 2 or 3
capacity 4
custom media, loading 85
jam locations 184
jams, clearing 188
loading detectable standard-

size paper 82
loading undetectable standard-

size paper 84
locating 7

tray 3
jams, clearing 186

tray 4
capacity 4
jams, clearing 188
locating 7

trays
capacities 4
configure 88
default settings 38
double-sided printing 64
feeding problems, solving 221
included 2
jams, clearing 186
Macintosh settings 60
registration, setting 42

troubleshooting
checklist 180
control panel 181
control panel messages,

numerical 183
digital sending 181
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duplexing 206
EPS files 227
gateway addresses 223
jams 184,  202
Macintosh problems 226
media handling problems 203
output quality 207
transparencies 205

TrueType fonts included 4
two-sided copying

default settings 17
two-sided printing

blank pages, default
settings 38

default settings 22
Macintosh settings 60
Windows 97

U
uninstalling Macintosh

software 61
universal print driver 50
UNIX software 55
usage page, printing 146
USB configuration 68
USB port

Macintosh installation 58
troubleshooting

Macintosh 227

V
validating gateway

addresses 223
vertical transfer door

locating 7
vertical white or faded

stripes 219
voltage specifications 235
voltage, troubleshooting 181

W
wake time, setting 24,  177
Warning button, control panel

touchscreen 14
watermarks

Windows 97
wavy paper, problem-solving 214
Web browser requirements

embedded Web server 148
Web sites

firmware updates 6

HP Web Jetadmin,
downloading 152

Material Safety Data Sheet
(MSDS) 243

universal print driver 50
white lines or spots, problem-

solving 215
white or faded stripes 219
Windows

driver settings 53
drivers supported 49
supported operating

systems 48
universal print driver 50

Windows 2000 fax 143
workflow, send to 139
wrinkled paper, problem-

solving 214
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